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Chapter 1
Matrox Axio

本章介绍 Matrox Axio 的主要功能、
包装盒内包含的物品、Axio 系统配置
要求及相关的 Matrox Axio 文件。
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第 1 章
欢迎使用 Matrox Axio
Matrox Axio 实时高清和标清编辑平台为您带来最高的质量、最丰富的实
时功能和最先进的编解码器技术。

Matrox Axio 主要功能
以下为所有 Matrox Axio 系统的主要功能：

·将 Adobe Premiere Pro 变成用于广播和后期制作的功能最强大的高清
和标清编辑系统。

·最高 1080i@29.97 fps 的高质量、全帧率、高分辨率编辑。

·至少 2 层无压缩高清视频加 2层图文层，加特技仍保持实时。

·至少 4 层无压缩标清视频加 6层图文层，加特技仍保持实时。

·实时基本和局部色彩校正，可逐个镜头颜色匹配。

·实时多机位镜头编辑、3D DVE、色 /亮度键特技、变速特技、模糊 / 闪
烁 /软聚焦特技等。

·无压缩高清和标清编辑。

·原始 HDV 和 DVCPRO HD 编辑

·压缩高清编辑 （脱机和联机完成质量的 MPEG-2 I- 帧编辑）。

·DV/DVCAM、DVCPRO、DVCPRO50 和 MPEG-2 I- 帧标清编辑。

·在高清项目中实时混合高清格式，在标清项目中实时混合标清格式。

·在 1080i 项目中实时播放标清素材。

·高清和标清 24-fps 编辑，带下拉和反下拉。

·从高清到标清高质量实时下转换。

·用于流行合成和动画软件的所见即所得功能
，Matrox Axio
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Matrox Axio HD 功能
·8-bit 或 10-bit 无压缩高清和标清编辑。

·专用内置 GPU，用于支持 Matrox Axio 硬件加速特技。

·DV-1394 和 SD/HD SDI 视频输入和输出。

·RGB 和模拟分量输出。

·2- 入 /4- 出平衡 AES/EBU 立体声音频，4- 入 /4- 出 SDI 嵌入立体声音
频。

·2路平衡模拟 XLR 音频输出，用于监听。

Matrox Axio SD 功能
·8-bit 或 10-bit 无压缩标清和 8-bit 无压缩高清编辑。

·专用内置 GPU，用于支持 Matrox Axio 硬件加速特技。

·DV-1394、复合、S-Video、模拟分量和 SD/HD SDI 视频输入和输出。

·2- 入 /2- 出不平衡模拟 RCA 音频，2 进 /2 出平衡模拟 XLR 音频和 4-
入 /4- 出 SDI 嵌入立体声音频。

·只要添加高清接口盒就可以升级为 Matrox Axio HD。

Matrox Axio LE 功能
·8-bit 无压缩高清和标清编辑。

·依靠您的系统 GPU 的来处理 Matrox Axio 硬件加速特技。

·DV-1394、复合、S-Video、标清 / 高清模拟分量和 SD/HD SDI 视频输入
和输出。

·同时输出高清和标清数据。

·2- 入 /6- 出平衡模拟 XLR 音频，1- 入 /3- 出不平衡 AES/EBU 立体声音
频和 1- 入 /1- 出 SDI 嵌入立体声音频。

·1路不平衡模拟 RCA 立体声输出，用于监听。
欢迎使用 Matrox Axio
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第 1 章
Matrox Axio HD 和 SD 所配硬件
·X.io 卡 -- 输入 /输出卡。

·X.effects 卡 -- 实时特技卡。

·X.linkHD 接口盒，用于 Matrox Axio HD ；或 X.linkSD 接口盒，用于
Matrox Axio SD。

·X.link 电缆，配屏蔽夹。

·4-6 针 IEEE-1394 电缆。

·用于 X.io 卡的内部电源线。

·用于 X.effects 卡的内部电源线或是 12V 外部电源。

注：Matrox Axio 不提供外部交流电源线。

Matrox Axio LE 所配硬件
·Axio LE 卡。

·Axio LE 内部平衡模拟音频电缆，配音频电缆托架。

·X.linkLE 接口盒。

·X.linkLE 平衡模拟音频电缆。

·6-6 针 IEEE-1394 电缆，连接 X.linkLE 和计算机的 1394 端口。

·两个 S-Video 转接电缆，用于连接 S-Video 设备和 X.linkLE。

Matrox Axio HD 和 SD 系统配置要求
Matrox Axio HD 和 SD 系统需要配置的计算机符合以下要求：

·Intel Xeon （双 CPU），3.4 GHz 及以上，或是 AMD Opteron 250 （双
CPU）及以上。

·至少 530W 的内部电源，有一个插座接 X.io 卡，如果您需要使用计算
机的内部电源为 X.effects 卡供电，还需要多一个插座。

·2 GB 及以上内存 （RAM）。

·2条空的 PCI-X 扩展槽，运行在 100 MHz 上。

·通风装置，如第 10 页 “提供足够的通风”所述。

·显示卡至少有 128 MB 内存。

·DVD-ROM 驱动器，用于安装软件。

·Microsoft Windows XP，配 Service Pack 2。

·Adobe Premiere Pro 2.0。
，Matrox Axio
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重要： 如果您需要使用计算机的内部电源为 X.effects 卡供电，在您需要
升级系统，安装耗很多电的设备时，有可能造成 Axio 工作不稳定。耗电
多的设备包括：速度快的 CPU、高级显示卡 （如支持 NVIDIA SLI 技术的
卡）及添加硬盘驱动器。在升级系统之前，请与您的 Matrox 经销商联系
了解详情。

视您系统升级后的功耗而定，您有可能需要把 X.effects 卡的电源转为外
部电源。

Matrox Axio LE 系统配置要求
Matrox Axio LE 系统需要配置的计算机符合以下要求：

·Intel Xeon （双 CPU），3.4 GHz 及以上，或是 AMD Opteron 250 （双
CPU）及以上。

·2 GB 及以上内存 （RAM）。

·1条空的 PCI-X 扩展槽，在 Axio LE 卡旁边有一条空 PCI 扩展槽，以安
装 Axio LE 平衡模拟音频电缆固定装置。

·通风装置，如第 32 页 “提供足够的通风”所述。

·显示卡支持 Microsoft DirectX 9，还要至少有 256 MB 内存 （推荐使
用 512MB 内存）。

·DVD-ROM 驱动器，用于安装软件。

·Microsoft Windows XP，配 Service Pack 2。

·Adobe Premiere Pro 2.0。

要了解关于 Matrox Axio LE 最新的系统配置要求，请浏览 Matrox 技术支
持网站 :www.matrox.com/video/support/cs。
Matrox Axio LE 系统配置要求
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第 1 章
关于本手册
本手册提供关于安装和使用 Matrox Axio 硬件和软件所需的相关信息，并
包括如何在 Matrox Axio 系统上使用 Adobe Premiere Pro。

手册文字表示方式
本手册使用以下表达方式：

·使用斜体表示文件路径名和手册名。比如：

- 数据存储在 sample.wav 文件中。

- 文件存储在 C:\Windows\System 目录下。

- 请参考 《Adobe Premiere Pro 用户手册》。

·您要选择的菜单和命令以 Menu > Command 方式显示。比如：File > 

Save 表示在菜单下点击 File，再在出现的菜单中点击 Save。

·键的名称以小的大写黑体显示，如 CTRL 键。

·加号 （+）表示几个键和 /或键与鼠标一同使用。比如：

- CTRL+C 表示按住 CTRL 键的同时按 C 。

- SHIFT+ 点击 表示按住 SHIFT 键的同时点击鼠标。

视频格式表示方法
除了 NTSC 和 PAL 之外，Matrox Axio 文件和对话框中的所有标准清晰度和
高清晰度视频格式都表示为：

VLp 或 i @ n fps

其中：

·VL为垂直扫描线数。

·p 或 i表示逐行扫描或是隔行扫描视频。

·@ n fps 表示每秒多少帧的帧率。

举例如下：

·1080i @ 29.97 fps 表示 1920 × 1080 隔行扫描视频，帧率为每秒
29.97 帧。

·720p @ 59.94 fps 表示 1280 × 720 逐行扫描视频，帧率为每秒
59.94 帧。

·486p @ 23.98 fps 表示 720 × 486 逐行扫描视频，帧率为每秒 23.98
帧。
，Matrox Axio
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最新更新信息
在本手册印刷时还没来得及收录进手册的重要信息放在以下两种文件中：

·自述文件：Axio Readme.htm，放在 Matrox Axio 安装 DVD 中。

·随手册发送的 《Matrox Axio 版本注释》。 
关于本手册
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第 1 章
笔记
，Matrox Axio



Chapter 2
安装 Matrox Axio HD 或 SD 硬件

本章介绍如何在 Matrox Axio HD 或
SD 系统中安装 Matrox Axio 板卡。
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第 2 章
安装 Matrox Axio 套卡的准备工作
请先仔细阅读本手册所有章节再进行 Matrox Axio 板卡安装。

使用正确的操作系统
在试图安装 Matrox Axio 板卡之前，您需要确保您使用的操作系统是
Windows XP 专业版，操作系统安装正确而且工作正常。这样可以避免日后
出现问题。

避免造成重大损失注意事项
人体所带的静电可以损坏 Matrox Axio 板卡或计算机。也许您没注意到，
每次人体移动的时候都会产生静电。虽然这些静电比较小，不至于产生火
花，但仍有可能损坏敏感的电子元件或是至少缩短它们的使用寿命。

要避免损失，请注意以下事项：

• 如果您未准备好安装Matrox Axio板卡，不要将它从防静电袋子里拿出
来。您可以将袋子放在需要安装的计算机附近，只在要安装时才将板
卡取出来。

• 勿触摸板卡上的元件和芯片，只拿板卡的边缘。

• 环境相对湿度至少保持在 50%。

• 不要穿羊毛或是合成纤维衣服，这类纺织品比棉质衣物产生更多静
电，棉质衣物为工作服装的最佳选择。

• 关掉计算机电源及与计算机所连接的设备。

打开计算机机箱后，在安装或是拆除任何系统元件之前，通过触摸计算机
的机箱上的一块金属的表面来放电。如果您手腕上有一条接地的金属线，
在拿放和安装计算机元件时，使用这条金属线放电。

提供足够的通风
在使用配备了 Matrox Axio 的系统之前，您需要确保计算机系统有足够的
通风。因为 Matrox Axio 的所有部件在计算机里的摆放位置很近，会产生
很多热量。强制排风系统非常重要。如果散热不足的话，有可能导致系统
操作故障。

注：Matrox Axio 系统配有多个温度感应器，您可以监控多种 Matrox Axio
硬件部件。这些温度显示在 Matrox X.info 程序里 （见 179 页 “监控
Matrox Axio 系统”了解更多信息）。
，安装 Matrox Axio HD 或 SD 硬件
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要在板卡之间最大限度提供空气流通，您需要按下图所述安装一个风扇：

• 将风扇安装在直接面对 Matrox Axio 板卡末端的位置，与 PCI 托架在一
起。您需要确保风扇将风吹进多个板卡之间。安装好后，这个风扇将
与 PC 机原有的排风扇 （在机箱后部）一起工作，将 Axio 卡带来的热
空气吹走。

• 选择至少 40 CFM （CFM 为风扇技术参数，衡量每分钟被吹动的空气体
积）。我们知道有一种风扇是 Sunon 牌，型号为 KD1208PTB1，这是一
台 12 VDC 风扇，42.5 CFM。

• 请确保将风扇安装得尽量离板卡近一些。在大多数系统中，您应该可
以直接把风扇放在板卡插槽后面。

• 安装完硬件后确保盖上计算机的后盖。这样确保风扇吹出的风可以通
过板卡而不是从机箱顶流走。

注意：应由合资格人士安装风扇。如果风扇安装得不正确，有可能损害
Axio 板卡部件或是计算机。Matrox Electronic Systems Ltd. 不负责任何
由于不正确安装造成的损失。

Airflow
安装 Matrox Axio 套卡的准备工作
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第 2 章
使用 NTFS 格式化 A/V 驱动器
音视频驱动器必须用 NTFS 格式化，以使用 Matrox Axio。因为 NTFS 突破
了 FAT32 文件大小限制。如果硬盘驱动器使用 FAT32 格式化，存储在这个
驱动器上的文件不可以超过 4G，相当于大约 20 分钟 DV/DVCAM 视频，对
Matrox Axio 系统这样的非线性编辑平台是一个严重的限制。

使用 NTFS 格式化，您可以选择创建系列卷标，将多个硬盘格式化成一个
分区。这令您可以将多个硬盘驱动器当作一个大驱动器使用，提供更多磁
盘空间，增强硬盘驱动器性能。NTFS 在播放素材时，音频与视频同步性能
也比 FAT32 更好。

如果您的计算机上早已安装了 Windows，您可以看查驱动器格式。在
Windows Explorer 中，右击驱动器符号如 （D:），选择 Properties （属
性）。在 General （常规）菜单下，查看在 File system （文件系统）旁边
的驱动器格式。

如果您需要使用 NTFS 格式化一个驱动器，右击 My Computer （我的电
脑），选择 Manage（管理）。在 Computer Management （计算机管理）> 
Storage （存储）下，选择 Disk Management （磁盘管理）。在 Disk 

Management （磁盘管理）中，右击相应驱动器，选择 Format （格式化）。
在弹出对话框中，给要创建的分区定一个卷标。从 File System （文件系
统）清单中，选择 NTFS。Allocation unit size （分配单元大小）为
Default （默认配置大小）。不要选择 Enable file and folder 

compression 选项。如果是首次格式化驱动器，不要选择 Perform a quick 

format （快速格式化）选项。

重要： 指定驱动器里的所有信息均将丢失。

要了解如何使用 NTFS 格式化存储设备，请参考 Windows 文件。

磁盘碎片整理
确保存储器碎片不要过多很重要。磁盘碎片太多会令系统性能下降，严重
影响 Matrox Axio 正常工作。

重要：要确保您的存储器工作在最佳状态请定期整理磁盘碎片 （每天整理
一次或是一星期整理几次）。

要了解如何整理存储器磁盘碎片请参考 Windows 文件。
，安装 Matrox Axio HD 或 SD 硬件



13
使用 PCI 托架
很多计算机在机箱的前端都有板卡插槽，以令插稳板卡。由于 PCI-X 卡既
不够长，又不能插在这些插槽的中心位置，Axio 专门配备了 PCI 托架，下
图介绍如何使用这个托架：

去掉 PCI 托架
对于某些型号的计算机，您可能需要去掉 PCI 托架。在这种情况下，您放
掉身体带的静电并将 Axio 板卡从防静电包里取出来后 （见第 10 页 “安
装 Matrox Axio 套卡的准备工作”），卸下固定托架的螺钉，再卸下托架
就可以了。

Axio card

Card guide
PCI retainer

bracket
安装 Matrox Axio 套卡的准备工作



14

第 2 章
连接内部电源线与 X.io 卡
您的 X.io 卡需要来自计算机的内部电源。Matrox Axio 有一条内部电源
线，将 X.io 卡连接到计算机的内部电源。 

注：X.link 接口盒和 X.io 卡上的 LED 显示之间的接头并未使用。

在安装完 Axio 套卡并打开计算机后，在 X.io 卡信号板上的 LED 指示灯将
会亮，表明内部电源连接正确。

LED 显示

将电源线小的一端与 X.io 卡
后面的 8脚公头连接。

X.link 接口盒

内部

电源线

X.io 卡
，安装 Matrox Axio HD 或 SD 硬件
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设置 X.effects 卡的电源选择开关
X.effects 也需要电源，要么由计算机内部电源供电，要么使用外部电
源。板卡上的电源选择开关必须设置在正确位置。电源选择开关在
X.effects 板卡的前端，板卡托架附近。

要正确设置 X.effects 板卡，以使用内部电源供电：

 

如下图所示，将电源选择开关拨向
X.effects 板卡后端。

电源设置为使用
内部电源

X.effects
板卡
安装 Matrox Axio 套卡的准备工作



16

第 2 章
要正确设置 X.effects 板卡，以使用外部电源供电：

连接内部电源线与 X.effects 卡
如果 X.effects 板卡如上一节所述，设置为使用计算机的内部电源供电，
您需要按下图所示将电源线接到 X.effects 板卡上：

外部电源插孔

如下图所示，将电源选择开关拨向
X.effects 板卡前端。

电源设置为使用
外部电源。

X.effects
板卡

将内部电源线的母头接到
X.effects 板卡中部的 4 脚公
头插孔上。

内部电源线

X.effects 板卡

内部电源插孔
，安装 Matrox Axio HD 或 SD 硬件
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安装 Matrox Axio 套卡
Matrox Axio 套卡设计用于安装在计算机的 PCI-X 插槽上。如果您打算安
装的 Axio 板卡的插槽已安装了其它卡，您需要将它们移动到其它插槽去，
或是把卡完全取出来。如果您想使用 133-MHz 插槽，您需要在计算机的
BIOS 中将此插槽设置为运行在 100 MHz 上，或是使用计算机主板的跳线开
关设置。要了解如何设置计算机的 PCI-X 插槽，参考计算机所配文件。

重要：您在计算机的 PCI-X 插槽上安装的任何部件都必须运行在 100 MHz
及以上频率上。否则，这些部件将影响 Axio 套卡的性能。

安装 X.io 卡
1 确保已按照第14页“连接内部电源线与X.io卡”所述连接了X.io卡的

内部电源。

2 去掉您将要使用的插槽后面的金属片，请保留螺钉，以用于安装板
卡。

3 将 X.io 卡放在选好的插槽里，用力均匀地将卡推进插槽。

4 使用螺钉将 X.io 卡的托架固定在计算机机箱上。

5 将内部电源线的公头一端接到计算机内部的电源插座上。 

重要：请确保没有其它设备在共用这个电源。

在安装完 Axio 硬件并打开计算机后，在 X.io 卡信号板上的 LED 指示灯将
会亮，表明内部电源连接正确。
安装 Matrox Axio 套卡
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第 2 章
安装 X.effects 卡
1 确保X.effects板卡上的电源选择开关按第15页“设置X.effects卡的

电源选择开关”所述设置正确。

2 如果您将X.effects板卡设置为使用计算机的内部电源，确保已按第16
页 “连接内部电源线与 X.effects 卡”所述连接了电源线。

3 去掉您将要使用的插槽后面的金属片，请保留螺钉，以用于安装板
卡。

4 将 X.effects 卡放在选好的插槽里，用力均匀地将卡推进插槽。

5 使用螺钉将 X.effect 的托架固定在计算机机箱上。

6 如果您使用计算机的内部电源作为X.effects板卡的另一个电源，将内
部电源线的公头一端接到计算机内部的电源插座上。

注：在安装完 Axio 硬件并打开计算机后，在 X.effects 卡信号板上的
LED 指示灯将会亮，表明内部电源连接正确。

7 放回计算机盖。
，安装 Matrox Axio HD 或 SD 硬件
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连接外部电源线与 X.effects 卡
如果您的 X.effects 使用外部电源，Matrox Axio 套卡包装盒里配了一个
12V DC 外部电源。

1 将外部电源的公头连接到 X.effects 卡电源插头的母头上。 

2 使用一条电源线将外部电源插到一个交流电插座上 （Matrox Axio 不
含这条电源线）。 

重要：外部电源必须连接到一个 AC 插座上，如果您的计算机电源有一
个外部电源插头，您必须不使用这个外部电源作为 X.effect 板卡的电
源。

在安装完 Axio 硬件并打开计算机后，在 X.effects 卡信号板上的 LED 指
示灯将会亮，表明外部电源连接正确。

重新启动计算机之前注意事项
您必须在连接好如 X.link 接口盒、录像机、DV 摄录一体机等的外部设备
之后再重新启动计算机。要了解如何使用这些设备，见第 3 章 《连接
Matrox Axio HD 及 SD 和外部设备》。

X.effects 板卡

外部电源公头
连接外部电源线与 X.effects 卡
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第 2 章
笔记
，安装 Matrox Axio HD 或 SD 硬件



Chapter 3
连接 Matrox Axio HD 及 SD 和外部设备

本章介绍如何将外部设备连接到
Matrox Axio HD 和 SD。
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第 3 章
连接 X.linkHD 和 X.linkSD 接口盒
X.linkHD 和 X.linkSD 接口盒为您最大限度提供 Matrox Axio 系统与外部
视频设备连接的灵活性。包装盒所附的 X.link 电缆用于连接 X.link 接口
盒和 X.io 卡。

连接 X.linkHD 视频

·1路 10-bit 4:2:2 SDI 输入输出，带嵌入音频支持。

·IEEE-1394 接口。

·模拟黑场基准输入。

·模拟分量或是 RGB 预览输出。

连接 X.linkHD 音频

·2路平衡 AES/EBU 立体声输入。

·4路平衡 AES/EBU 立体声输出。

·2路平衡模拟 XLR 输出用于监听。

连接 X.linkSD 视频

·1路模拟分量输入 / 输出。

·1路复合视频输入 / 输出。

·1路 S-Video 输入 / 输出。

·1路 10-bit 4:2:2 SDI 输入输出，带嵌入音频支持。

·IEEE-1394 接口。

·模拟黑场基准输入。

连接 X.linkSD 音频

·2路平衡模拟 XLR 输入 / 输出。

·2路不平衡模拟 RCA 输入 / 输出。

准备安装
有三种安装 X.link 接口盒的方式。您可以把它平放或是竖放在桌面上，
还可以使用机架安装方式安装在 19 英寸机架上。
，连接 Matrox Axio HD 及 SD 和外部设备
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平放在桌面上

您可以使用桌面支脚将 X.link 接口盒架起来，令有音频 / 视频接头的一
面向上，要使用这个支脚，将下面的脚拉出来，将接口盒平放在桌面上就
可以了。

竖放在桌面上

1 取出底座。

2 将底座的固定片对齐 X.link 接口盒底部的槽。

3 将螺钉对准 X.link 接口盒的孔，拧紧螺钉。不要拧太紧！

注：要拆除底座，拧松螺钉，再抬起接口盒。

桌面支脚

底座
连接 X.linkHD 和 X.linkSD 接口盒
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第 3 章
机架安装 

1 取出机架安装支架及螺钉。

注意：请只使用 Matrox Axio 包装盒内的螺钉，如果您使用的螺钉比
原配螺钉大或长，有可能损坏您的设备。 

2 对齐支架与相应的螺钉孔。

注：请注意，左边和右边的支架是不同的，左边的支架比右边的要宽
一些，因为接口盒的左边和右边宽度不一样。

3 请使用普通改椎 （不要用电动的），小心地拧紧螺丝。不要拧太紧！ 

连接屏蔽夹到 X.link 电缆
屏蔽夹可以防止其它设备的电磁场干扰。

1 将一个打开的屏蔽夹放在距 X.link 电缆一端不到 1 英寸（2.54 厘米）
的部位。 

2 合上屏蔽夹，将电缆夹在中间。

3 重复第 1步和第 2步，把屏蔽夹夹在 X.link 电缆的另一端。

左边机架安装支架 右边机架安装支架
，连接 Matrox Axio HD 及 SD 和外部设备
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连接 X.link 接口盒到计算机
1 将 X.link 电缆的一端接到 X.link 接口盒后面的 X.link 插头。拧紧螺

丝。 

2 将 X.link 电缆的另一端与 X.io 板卡后面的插孔连接。 

注意：在接插 X.link 电缆时需要格外小心 （如果针脚弯折的话有可
能令 Matrox Axio 系统无法正常工作）。另外，不要用力弯折电缆，
否则有可能损坏电缆内部或是屏蔽层。

X.link 电缆 

X.link 卡

插孔

X.link 电缆 X.io 卡
连接 X.link 接口盒到计算机
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第 3 章
典型 Matrox Axio HD 和 SD 连接
以下章节介绍一些典型的视频连接方法。在这些图中，我们连接了一些
Program 监示器 （NTSC、PAL 或数字监示器）以观看将被录制的信号，还
连接了独立的视频信号源和录像机。您可以将输入和输出信号都连到同一
台设备上，使用同一录像机作为信号源和录制设备。

X.linkHD 数字视频连接

SERIAL
75

ON

OFF

Ω

Source
(Deck 1)

SYNC

IN

OUT

DV-1394

OUT

AUDIO R

AUDIO L

VIDEO

S-VIDEO

DV-1394 device

SERIAL
75

ON

OFF

Ω

Recorder
(Deck 2)

SYNC

IN

OUT

Di gi tal Video Sol ut i ons SDI

1394

REF IN

GENLOCK

OUT

Y/G B-Y/B R-Y/R

AES/EBU ANALOG

HDTV SDTV

Y B-Y R-Y RGB
IN

OUT

IN1/2

IN3/4

OUT1

OUT2

OUT1/2

OUT3/4

OUT5/6

OUT7/8

Program
monitor
Input

Y/G B-Y/B R-Y/R

VIDEO
IN

AES/EBU

IN1/2 OUT1/2

AES/EBU
IN1/2 OUT1/2
，连接 Matrox Axio HD 及 SD 和外部设备
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X.linkSD 模拟分量连接
典型 Matrox Axio HD 和 SD 连接
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第 3 章
X.linkSD S-Video 连接
，连接 Matrox Axio HD 及 SD 和外部设备
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X.linkSD 数字视频连接
典型 Matrox Axio HD 和 SD 连接
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第 3 章
笔记
，连接 Matrox Axio HD 及 SD 和外部设备



Chapter 4
安装 Matrox Axio LE 硬件

本章介绍如何安装 Matrox Axio LE
板卡。
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第 4 章
安装 Matrox Axio LE 的准备工作
请先仔细阅读本手册所有章节再进行 Matrox Axio LE 板卡安装。

使用正确的操作系统
在试图安装 Matrox Axio 板卡之前，您需要确保您使用的操作系统是
Windows XP 专业版，操作系统安装正确而且工作正常。这样可以避免日后
出现问题。

避免造成重大损失注意事项
人体所带的静电可以损坏 Matrox Axio LE 板卡或计算机。也许您没注意
到，每次人体移动的时候都会产生静电。虽然这些静电比较小，不至于产
生火花，但仍有可能损坏敏感的电子元件或是至少缩短它们的使用寿命。

要避免损失，请注意以下事项：

·如果您未准备好安装 Matrox Axio LE 板卡，不要将它从防静电袋子里
拿出来。您可以将袋子放在需要安装的计算机附近，只在要安装时才
将板卡取出来。

·勿触摸板卡上的元件和芯片，只拿板卡的边缘。

·环境相对湿度至少保持在 50%。

·不要穿羊毛或是合成纤维衣服，这类纺织品比棉质衣物产生更多静电，
棉质衣物为工作服装的最佳选择。

·关掉计算机电源及与计算机所连接的设备。

打开计算机机箱后，在安装或是拆除任何系统元件之前，通过触摸计算机
的机箱上的一块金属的表面来放电。如果您手腕上有一条接地的金属线，
在拿放和安装计算机元件时，使用这条金属线放电。

提供足够的通风
在使用 Matrox Axio 的系统之前，您需要确保计算机系统有足够的通风。
因为 Matrox Axio LE 会产生很多热量，强制排风系统非常重要。如果散热
不足的话，有可能导致系统操作故障。

注：Matrox Axio 系统配有多个温度感应器，您可以监控多种 Matrox Axio
硬件部件。这些温度显示在 Matrox X.info 程序里 （见 179 页 “监控
Matrox Axio 系统”了解更多信息）。
，安装 Matrox Axio LE 硬件
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要为板卡最大限度提供空气流通，您需要按下图所述安装一个风扇：

·将风扇安装在直接面对 Matrox Axio LE 板卡末端的位置，与 PCI 托架
在一起。您需要确保风扇将风吹到板卡是。安装好后，这个风扇将与
PC 机原有的排风扇 （在机箱后部）一起工作，将 Axio LE 卡带来的热
空气吹走。

·选择至少 40 CFM （CFM 为风扇技术参数，衡量每分钟被吹动的空气体
积）。我们知道有一种风扇是 Sunon 牌，型号为 KD1208PTB1，这是一
台 12 VDC 风扇，42.5 CFM。

·请确保将风扇安装得尽量离板卡近一些。在大多数系统中，您应该可
以直接把风扇放在板卡插槽后面。

·安装完硬件后确保盖上计算机的后盖。这样确保风扇吹出的风可以通
过板卡而不是从机箱顶流走。

注意：应由合资格人士安装风扇。如果风扇安装得不正确，有可能损害
Axio LE 板卡部件或是计算机。Matrox Electronic Systems Ltd. 不负责
任何由于不正确安装造成的损失。

Airflow
安装 Matrox Axio LE 的准备工作
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第 4 章
使用 NTFS 格式化 A/V 驱动器
音视频驱动器必须用 NTFS 格式化，以使用 Matrox Axio。因为 NTFS 突破
了 FAT32 文件大小限制。如果硬盘驱动器使用 FAT32 格式化，存储在这个
驱动器上的文件不可以超过 4G，相当于大约 20 分钟 DV/DVCAM 视频，对
Matrox Axio 系统这样的非线性编辑平台是一个严重的限制。

使用 NTFS 格式化，您可以选择创建系列卷标，将多个硬盘格式化成一个
分区。这令您可以将多个硬盘驱动器当作一个大驱动器使用，提供更多磁
盘空间，增强硬盘驱动器性能。NTFS 在播放素材时，音频与视频同步性能
也比 FAT32 更好。

如果您的计算机上早已安装了 Windows，您可以看查驱动器格式。在
Windows Explorer 中，右击驱动器符号如 （D:），选择 Properties （属
性）。在 General （常规）菜单下，查看在 File system （文件系统）旁边
的驱动器格式。

如果您需要使用 NTFS 格式化一个驱动器，右击 My Computer （我的电
脑），选择 Manage（管理）。在 Computer Management （计算机管理）> 
Storage （存储）下，选择 Disk Management （磁盘管理）。在 Disk 

Management （磁盘管理）中，右击相应驱动器，选择 Format （格式化）。
在弹出对话框中，给要创建的分区定一个卷标。从 File System （文件系
统）清单中，选择 NTFS。Allocation unit size （分配单元大小）为
Default （默认配置大小）。不要选择 Enable file and folder 

compression 选项。如果是首次格式化驱动器，不要选择 Perform a quick 

format （快速格式化）选项。

重要：指定驱动器里的所有信息均将丢失。

要了解如何使用 NTFS 格式化存储设备，请参考 Windows 文件。

磁盘碎片整理
确保存储器碎片不要过多很重要。磁盘碎片太多会令系统性能下降，严重
影响 Matrox Axio 正常工作。

重要：要确保您的存储器工作在最佳状态请定期整理磁盘碎片 （每天整理
一次或是一星期整理几次）。

要了解如何整理存储器磁盘碎片请参考 Windows 文件。
，安装 Matrox Axio LE 硬件
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使用 PCI 托架
很多计算机在机箱的前端都有板卡插槽，以令插稳板卡。由于 PCI-X 卡既
不够长，又不能插在这些插槽的中心位置，Axio 专门配备了 PCI 托架，下
图介绍如何使用这个托架：

去掉 PCI 托架
对于某些型号的计算机，您可能需要去掉 PCI 托架。在这种情况下，您放
掉身体带的静电并将 Axio LE 板卡从防静电包里取出来后 （见第 32 页
“安装 Matrox Axio LE 卡的准备工作”），卸下固定托架的螺钉，再卸下
托架就可以了。

Axio LE card

Card guide
PCI retainer

bracket
安装 Matrox Axio LE 的准备工作
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第 4 章
连接内置模拟音频线与 Axio LE 卡
Axio LE 卡包括了一个内置的模拟音频电缆和一个音频电缆托架，可以使
用平衡的模拟音频电缆 (XLR) 从 X.linkLE 接口盒连接到 AxioLE 卡上。

注意：内置音频插头和 Axio LE 卡上对应的插头的设计是吻合的，即一边
伸出的垫片需要对齐另一边的凹槽。如果插得不对，不要硬插，否则有可
能导致 Axio LE 的针脚弯折。

将内置音频电缆从托架上接
到 Axio LE 卡中部相应的插
头上。

音频线托架

内置音频电缆

Axio LE 卡

音频电缆上的垫片与 Axio LE
卡上的凹槽对齐
，安装 Matrox Axio LE 硬件
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安装 Matrox Axio LE 卡
Matrox Axio LE 卡设计用于安装在计算机的 PCI-X 插槽上，同时需要在
Axio LE 卡附近有一条 PCI 槽用于安装模拟音频电缆托架。

要安装 Axio LE 卡

1 确保已按照第 36 页“连接内置模拟音频线与 Axio LE 卡”所述使用模
拟音频电缆连接了音频电缆托架与 Axio LE 卡。

2 去掉您将要用于安装Axio LE卡和音频电缆托架的两条插槽后面的金属
片，请保留螺钉，以用于安装板卡。

3 将Axio LE卡和音频电缆托架放在选好的插槽里，用力均匀地将卡推进
插槽。

4 使用螺钉将Axio LE卡和音频电缆托架卡的托架固定在计算机机箱上。

5 使用Axio LE音频电缆托架配的4个小螺钉将托架固定到计算机的机箱
上。

6 放回计算机盖。 

重新启动计算机之前注意事项
您必须在连接好如 X.link 接口盒、录像机、DV 摄录一体机等的外部设备
之后再重新启动计算机。要了解如何使用这些设备，见第 5 章 “连接
Matrox Axio LE 和外部设备”。
安装 Matrox Axio LE 卡
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第 4 章
笔记
，安装 Matrox Axio LE 硬件



Chapter 5
连接 Matrox Axio LE 和外部设备

本章介绍如何将外部设备连接到
Matrox Axio LE。
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第 5 章
连接 X.linkLE 接口盒
X.linkLE 接口盒为您最大限度提供 Matrox Axio LE 系统与外部视频设备
连接的灵活性。包装盒所附的电缆用于连接 X.linkLE 接口盒和 Axio LE
卡，Axio LE 配有平衡模拟音频电缆托架和一条 1394 电缆，用于将
X.linkLE 连接到计算机上。还配有 S-Video 转接电缆，用于连接 S-Video
设备。

连接 X.linkLE 视频

·1路 4：2：2 SDI 输入输出，带嵌入音频支持。

·第 2路 4：2：2 SDI 输出，带嵌入音频支持 (仅为 SD-SDI)。

·1路模拟分量输入，或 1 路 S-Video 输入，或 1 路复合输入。

·1路模拟分量输出和 1路复合输出，或 1 路 S-Video 输出和 2 路复合输
出。

注：在输出高清模拟分量视频时，不能使用复合输出。

·IEEE-1394 接口。

·模拟黑场基准输入。

连接 X.linkLE 音频

·2路平衡模拟 XLR 输入。

·6路平衡模拟 XLR 输出。

·1路不平衡 AES/EBU 立体声输入。

·3路不平衡 AES/EBU 立体声输出。

·1路不平衡模拟 RCA 立体声输出，用于预听。

安装机架托架
您可以使用机架托架将 X.linkLE 接口盒安装在 19 英寸机架上。

1 取出 2 个机架安装托架及 8 个螺钉。

注意：请只使用 Matrox Axio LE 包装盒内的螺钉安装 X.linkLE 接口
盒，如果您使用的螺钉比原配螺钉大或长，有可能损坏您的设备。 
，连接 Matrox Axio LE 和外部设备
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2 托架有两个螺钉孔的一面与 X.linkLE 接口盒的前面板对齐，将托架侧
面的螺钉孔与接口盒侧面螺钉孔对齐，固定在机架上。

3 请使用普通改椎 （不要用电动的），小心地拧紧螺丝。不要拧太紧！ 

ANALOG
VIDEO

SDI

CVBS IN

Y/CVBS OUT Pb/Y OUT Pr/C OUT

Pb/Y IN
Pr/C IN

CVBS OUT

IN

OUT 1
OUT 2

REF IN

75 OHM

1394

ANALOG

OUT 1
OUT 2

IN 1

IN 2

 托架

托架

X.linkLE 接口盒
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第 5 章
连接 X.linkLE 音 / 视频及 SDI 电缆和 Axio LE 卡
1 使用X.linkLE音/视频电缆从X.linkLE接口盒的后部连接到Axio LE板卡

的 X.linkLE 音 / 视频电缆插头 (标签 B) 上。拧紧螺钉。

2 将X.linkLE SDI电缆从X.linkLE接口盒连接到Axio LE相应SDI插头上(
标明 OUT A、 OUT B 和 IN)。

注意：在接插时一定要格外小心 ( 如果针脚弯折的话有可能会导致
Matrox Axio LE 系统无法正常工作 )。另外，不要用力变折电缆，强
的外力有可能损坏电缆内部的屏蔽线。

OUT B

OUT A

IN

B

SDI OUT A

SDI OUT B

SDI IN

X.linkLE 音 /视频电缆

Axio LE音/视频电缆插
头 (B)

X.linkLE SDI 电缆

Axio LE卡托架

X.linkLE 接口盒后部

Axio LE 
SDI 插头
，连接 Matrox Axio LE 和外部设备
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连接 X.linkLE 平衡模拟音频电缆和音频电缆托架
1 将X.linkLE平衡模拟音频电缆的一端接到X.linkLE接口盒后面的模拟

音频电缆插头上。拧紧螺丝。 

2 将X.linkLE平衡音频电缆电缆的另一端与Axio LE音频电缆托架的平衡
模拟音频电缆插头 ( 标志 A) 连接。拧紧螺丝。

注意：在接插时一定要格外小心 (如果针脚弯折的话有可能会导致
Matrox Axio LE 系统无法正常工作 )。另外，不要用力变折电缆，强
的外力有可能损坏电缆内部的屏蔽线。

Analog Audio

A
X.linkLE 平衡模拟音频电缆

X.linkLE 接

口盒后部

Axio LE音频电缆托架

Axio LE 平衡模拟

音频电缆插头 (A)
连接 X.linkLE 平衡模拟音频电缆和音频电缆托架
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第 5 章
连接 X.linkLE 1394 电缆和计算机
1 将 X.linkLE 1394电缆的一端接到 X.linkLE 接口盒的后部的? 394插头

上。

2 将 X.linkLE 1394 电缆的另一端连接到计算机上。

使用 X.linkLE S-Video 转接电缆
要支持 X.linkLE 接口盒上的 S-Video (Y/C) 插头， Axio LE 包括了两条 S-
Video 转接电缆 ( 一条用于 S-Video 输入，另一条用于 S-Video 输出 )。

注：如果您选择将一台 S-Video 设备连接到 X.linkLE 接口盒上，您将
无法再连接模拟分量设备。

1 对于S-Video输入，将S-Video转接电缆上标着Y的一端插入X.linkLE接
口盒前部的 Pb/Y IN 插头，将 S-Video 转接电缆标着 C 的一端插入 Pr/
C IN 插头。

2 将另一端接到外部设备的 S-Video OUT 上。

1394

Analog Audio

1394

X.linkLE 接

口盒后部

X.linkLE 1394 电缆

计算机上的 1394
电缆插头托架
，连接 Matrox Axio LE 和外部设备
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3 对于S-Video输出，将S-Video转接电缆上标着Y的一端插入X.linkLE接
口盒前部的 Pb/Y OUT 插头，将 S-Video 转接电缆标着 C 的一端插入
Pr/C OUT 插头。

4 将另一端接到录制设备的 S-Video IN 上。

C

Y

DIGITAL AUDIO

AES/EBU

ANALOG

VIDEO
SDI

IN 1/2 Y/CVBS IN

Y/CVBS OUT Pb/Y OUT Pr/C OUTOUT 1/2 OUT 3/4OUT 5/6

Pb/Y IN Pr/C IN

CVBS OUT

IN

OUT 1 OUT 2

REF IN

75 OHM1394

To S-Video OUT connector
on source device

X.linkLE S-Video 转接电缆

X.linkLE 接口盒

DIGITAL AUDIO

AES/EBU

ANALOG

VIDEO
SDI

IN 1/2 Y/CVBS IN

Y/CVBS OUT Pb/Y OUT Pr/C OUTOUT 1/2 OUT 3/4OUT 5/6

Pb/Y IN Pr/C IN

CVBS OUT

IN

OUT 1 OUT 2

REF IN

75 OHM1394

C

Y

To S-Video IN connector
on record device

X.linkLE 接口电缆

X.linkLE S-Video 转接电缆
使用 X.linkLE S-Video 转接电缆
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第 5 章
典型 Matrox Axio LE 连接
以下章节介绍一些典型的视频连接方法。在这些图中，我们连接了一些
Program 监示器 （NTSC、PAL 或数字监示器）以观看将被录制的信号，还
连接了独立的视频信号源和录像机。您可以将输入和输出信号都连到同一
台设备上，使用同一录像机作为信号源和录制设备。

X.linkLE 模拟分量连接

Program
monitor

input

VIDEO
IN

External
sync

source

SYNC
OUT

Source
(Deck 1)

Recorder
(Deck 2)

AUDIO

IN

OUT

COMPONENT
VIDEO

IN

OUT

R-YB-YY SYNC75

ON

OFF

Ω

AUDIO

IN

OUT

COMPONENT
VIDEO

IN

OUT

R-YB-YY SYNC75

ON

OFF

Ω

ANALOG AUDIO

DIGITAL AUDIO

AES/EBU

ANALOG

VIDEO
SDI

OUT 1 OUT 2 OUT 3 OUT 4 OUT 5 OUT 6

AUDIO

PREVIEW

IN 1 IN 2

IN 1/2 Y/CVBS IN

Y/CVBS OUT Pb/Y OUT Pr/C OUTOUT 1/2 OUT 3/4OUT 5/6

Pb/Y IN Pr/C IN

CVBS OUT

IN

OUT 1 OUT 2

REF IN

75 OHM1394
，连接 Matrox Axio LE 和外部设备
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X.linkLE S-Video 连接
X.linkLE接口盒没有标准的 S-Video插头，但您仍然可以使用两条X.linkLE 
S-Video转接电缆连接S-Video设备(见44页“使用X.linkLE S-Video转接电
缆”了解更多信息 )。

External
sync

source

SYNC
OUT

Source
(Deck 1)

Program
monitor

input

VIDEO
IN

Recorder
(Deck 2)

S-VIDEO

75

ON

OFF

Ω SYNC

AUDIO

IN

OUT

IN

OUT

ANALOG AUDIO

DIGITAL AUDIO

AES/EBU

ANALOG

VIDEO
SDI

OUT 1 OUT 2 OUT 3 OUT 4 OUT 5 OUT 6

AUDIO

PREVIEW

IN 1 IN 2
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第 5 章
X.linkLE 数字视频连接
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，连接 Matrox Axio LE 和外部设备



Chapte r 6
安装 Matrox Axio 软件

本章介绍如何安装 Matrox Axio 系
统所需软件。
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第 6 章
软件安装总介
正确安装完 Matrox Axio 硬件并连接所有设备后，您可以开始安装软件
了。软件安装包括 Adobe Premiere Pro 和 Matrox Axio.utils。Matrox 
Axio.utils 将安装 Matrox Axio 硬件所需的设备和用于 Adobe Premiere 
Pro 的 Matrox Axio 实时插件。

硬件检测
打开计算机。Windows 启动后，“添加新硬件向导”检测到 Matrox Axio
硬件。因为 Matrox Axio.utils 安装程序自动检测您的设备并安装相应驱
动程序，只要按 ESC 或点击 Cancel（取消）关掉 “添加新硬件向导”即
可。

重要：“添加新硬件向导”将在检测到每个 Axio 硬件部件的时候都会出现
一次，请确保每次 “添加新硬件向导”出现时，都把它关掉。要确保正常
安装 Matrox Axio 软件，不要让 “添加新硬件向导”来安装任何驱动程序
非常重要。

“添加新硬件向导”在您安装了 Axio 硬件后只会在第一次启动计算机时出
现。

安装 Adobe Premiere Pro
您必须先安装 Adobe Premiere Pro 再安装 Matrox Axio.utils。

要安装 Adobe Premiere Pro：

1 关闭所有 Windows 程序。

2 在 CD-ROM 或 DVD-ROM 中插入 Adobe Premiere Pro 安装 CD。

3 从 CD 菜单中，选择安装 Adobe Premiere Pro。安装程序启动后，按屏
幕指示进行。

注：在安装 Matrox Axio.utils 时，Matrox Axio 文件将加在硬盘上的
Adobe Premiere Pro 的 Plug-ins 文件夹中。因此，如果您后来再将 Adobe 
Premiere Pro 重新安装到一个不同目录下时，您也需要重新安装 Matrox 
Axio.utils。
，安装 Matrox Axio 软件
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安装 Matrox Axio.utils
1 在 DVD-ROM 驱动器中插入 Matrox Axio 安装 DVD，Windows 自动启动

Matrox Axio 菜单。 

2 从 Matrox Axio 菜单中选择 Install Matrox Axio.utils。

3 如果任何一个Matrox Axio硬件需要升级固件，这时会自动出现一个升
级程序。升级完成后，Axio.utils 将继续安装。

4 按照屏上指示继续，在计算机上安装 Matrox Axio.utils。程序将提示
您为某些视频格式安装 Matrox 特技模板 （GFX 文件）。比如，您可以
选择只安装 SD NTSC 和 HD 1080 模板。系统还将提示您为已安装的所
支持的程序安装 Matrox 所见即所得插件。

5 如果有必要，在安装结束时，Setup 程序将提示您重新启动计算机，点
击 OK，重新启动计算机。
安装 Matrox Axio.utils
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第 6 章
在 NewTek LightWave 3D 中添加 Matrox 所见即所得插件
在为 NewTek LightWave 3D 安装 Matrox 所见即所得插件时，插件被复制到
硬盘。您必须按如下步骤将插件安装到 NewTek LightWave 3D 中：

1 打开 NewTek LightWave 3D。

2 选择 Layout > Plug-ins > Add Plug-ins。

3 打开 Input-Output 文件夹，再双击 mvelwpreview.p文件。

4 在 Add Plug-ins 对话框中点击 OK。

安装其它 Matrox 特技模板或删除不需要的模板
当您安装 Matrox Axio.utils 时，系统要求您选择安装 Matrox 特技模板
（GFX 文件）所需的视频格式。如果在安装完 Matrox Axio.utils 后，您
发现您需要安装用于新的视频格式的模板，或是去掉原有的视频格式的模
板，您可以从 Matrox Axio 清单中选择 Install Matrox effect patterns，
运行 Matrox Effect Patterns Setup 程序。系统将提示您选择安装
Matrox 特技模板的视频格式，如果需要删除原有的特技模板，不选此项。

安装其它 Matrox 所见即所得插件或删除不需要的插件
当您安装 Matrox Axio.utils 时，系统提示您为系统上已安装的所支持的
程序安装 Matrox 所见即所得插件。如果在安装完 Matrox Axio.utils 后，
您还需要安装 Matrox 所见即所得插件、重新安装或是删除已安装的插件，
您可以从 Matrox Axio 菜单里选择 Install Matrox WYSIWYG Plug-ins，运
行 Matrox 所见即所得安装程序。系统会问您哪个插件需要安装、重新安
装或是删除。要了解关于所支持的程序和所需要的设置的更多信息，见
175 页 “使用 Matrox 所见即所得插件”。

注：要为一个程序安装 Matrox 所见即所得插件，您必须先安装这个程序。
，安装 Matrox Axio 软件
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在无 Axio 硬件的系统上安装 Matrox VFW 软件编解码器
Matrox VFW 软件编解码器可以在 Video for Windows 程序中生成和播放
Axio 兼容 .avi 文件，无需在计算机上安装 Matrox Axio 硬件。

备注

• 如果您已有 Matrox Axio 硬件，您无需安装 VFW 软件编解码器，因为
Matrox Axio.utils 已在系统上安装了所有需要的 Matrox 编解码器。

• 如果您已有一个由另外一种 Matrox 产品 (比如 Matrox DigiSuite 或
Matrox RT.X100) 提供的以前版本的 Matrox VFW 软件编解码器，您需
要使用 Windows 控制面板里的 Add or Remove Programs 从计算机里删
除这些编解码器，再安装由 Matrox Axio 提供的 VFW 软件编解码器。

要安装 Matrox VFW 软件编解码器：

1 在 Matrox Axio 菜单中，选择 Install Matrox VFW software codecs。

2 按屏幕指示继续，最后会有信息框指示安装完成。 

删除 Matrox Axio 软件
您可以按以下步骤删除多种 Matrox Axio 软件：

• 要删除 Matrox Axio.utils，选择 Start > Programs > Matrox 

Axio.utils > Uninstall Matrox Axio.utils。您还可以从 Matrox Axio
菜单中选择 Uninstall Matrox Axio.utils。

• 如果您想只删除 Matrox 特技，选择 Start > Programs > Matrox 

Axio.utils > Uninstall Matrox Effect Patterns。除非您打算重新安
装 Matrox Axio.utils，您不应该只删除 Matrox 特技模板。

• 要从未安装 Matrox Axio 硬件的计算机上删除 Matrox VFW 软件编解码
器，使用 Windows 控制面板中的 Add or Remove Programs 功能删除。
在无 Axio 硬件的系统上安装 Matrox VFW 软件编解码器



54

第 6 章
笔记
，安装 Matrox Axio 软件



Chapte r 7
定义 Adobe Premiere Pro 设置

本章介绍如何定义Adobe Premiere 
Pro 设置，以使用 Matrox Axio。包
括如何指定项目和输出设置。
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第 7 章
同时运行 Adobe Premiere Pro 和其它程序的注意事项
要达到最佳性能，运行 Adobe Premiere Pro 时请不要运行任何其它程序。
如果您确实需要这样做，请确保先打开 Adobe Premiere Pro 和 Matrox Axio
项目再打开其它程序。否则 Adobe Premiere Pro 有可能无法打开。如果出
现这种情况，先关闭所有程序再打开 Adobe Premiere Pro。

提示：在 Adobe Premiere Pro 运行时，您可以监控 Adobe Premiere Pro 的内
存用量。按在 Matrox X.info （ ） 图标上按住鼠标。要了解更多关于使
用 Matrox X.info 的情况，见第 11 章 “监控 Matrox Axio 系统”。

装载项目预设
Matrox 的 Adobe Premiere Pro 实时插件包括可装载的项目预设，以马上
应用到相应的 Matrox Axio 设置上。要了解如何设置 Matrox Axio 项目预
设，以用于不同类型的项目，见附录 B“Matrox Axio 工作流程”。

要装载 Matrox Axio 项目预设：

1 启动 Adobe Premiere Pro。出现 New Project 对话框。

2 从相应的 Matrox文件夹（Matrox - SD用于创建标清项目，或是 Matrox 

- HD 用于创建高清项目），选择与您想创作的项目类型匹配的预设。
比如，如果您想创建一个 NTSC 项目，素材将采集为 DV/DVCAM 格式，
宽高比为标准的 4:3，扩展 Matrox - SD 下的 NTSC 和 Standard 文件
夹，再选择 DV预设。

注：如果您要采集的是 HDV 素材，请为 HDV 素材选择相应的 Matrox 
HDV 预设。比如，如果您的素材是以 Sony 1080/60i 格式拍摄的，选择
Matrox- HD 1080i 29.97 fps HDV 预设。如果您的素材是使用 Sony 
1080/50i 格式拍摄的，选择 Matrox - HD 1080i 25 fps HDV 预设。

3 在 Location 下，指定您需要存储项目的 A/V 驱动器。

4 在 Name 下，输入您的项目的名字。

5 点击 OK 应用设置。 
，定义 Adobe Premiere Pro 设置
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设置临时磁盘
当在 Adobe Premiere Pro 中指定临时磁盘位置时，确保您是按照《Adobe 
Premiere Pro 用户手册》所推荐步骤完成。比如，将视频和音频文件存储
在一个专用的 A/V 驱动器上。

要指定临时磁盘：

1 选择 Edit > Preferences > Scratch Disks。

2 在 Scratch Disks 下，为每个临时磁盘类型选择一个相应的 A/V 驱动器
字母。

提示：要提高性能，请将媒体缓存文件与视频文件存储在不同的驱动
器上。

3 点击 OK 存储设置。

重要：请确保所有的项目都使用同样的临时磁盘设置。这样减少打开新项
目或是已有项目的时间。

在高清项目里使用标清素材
Matrox Axio 支持在 1080i @ 29.97 fps 项目中实时播放 NTSC 素材和在
1080i @ 25 fps 项目中实时播放 PAL 素材。但是，标清素材必须通过
Adobe Premiere Pro 转换为与编辑项目一样的帧尺寸。如果您需要将所有
的标清素材在输入项目之前都转换好，选择 Edit > Preferences > General

并选择 Default Scale to Frame Size。此选项不影响已经输入到项目中的
素材。如果只转换序列里的某个素材，在 Timeline 面板上右击此素材，选
择 Scale to Frame Size。

注：在按照以上方法转换 NTSC 或 PAL 素材时，素材将保持原来的宽高比。
如果您不转换，素材将出现在屏幕上中心而且需要生成。

在 Adobe Premiere Pro 的 Events 面板中显示报警
Matrox Axio使用Adobe Premiere Pro的Events面板来发出某些报警，比如在
系统不支持您的采集设置时。要显示这些报警信息，可以双击 Premiere 
Pro 状态条的报警图标，或是选择 Window > Events。要了解关于使用 Events

面板的信息，见 Adobe Premiere Pro 文件。
设置临时磁盘
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第 7 章
定义常规设置
Matrox Playback Settings 对话框有几个页面，在 Matrox Axio 上使用
Adobe Premiere Pro 编辑时，您可以用来进行多种设置。当您选择了一个
Matrox Axio 项目预设，如 DV Standard，系统将为您的项目自动设置一个
Matrox Axio 编辑方式，还有几项设置为将优化为使用 Matrox Axio 编辑
的设置。

要在 Matrox Axio 中调整常规设置：
1 选择 Project > Project Settings > General 并点击 Playback Settings

钮。

2 点击 General 项。 

3 在 Scrubbing Mode 下，选择 Frame、1st Field 或 2nd Field 选择在
Timeline 面板上拖拉序列预览时，您是想显示一帧画面还是只是一
场。比如，在您拖动时间线预览隔行扫描视频时，您有可能想只观看
第一场或是第二场，以消除在停顿时画面出现的闪烁。这种场显示在
电视电影转换时还可用于检查是否有丢帧。

注：如果您使用的是逐行扫描视频，一般情况下，您不会觉察出选择
第一场还是第二场的区别。

4 在 Video Luma Level下，选择在序列上生成和预览视频时您需要应用到
亮度电平上的处理方法：

- Broadcast 使用广播视频标准亮度范围处理视频。过黑和过白亮度
电平 （即低于标准黑电平或超过标准白电平的电平）都被箝位。

- Post Production 使用后期制作视频标准亮度范围处理视频。过黑
和过白亮度电平 （即低于标准黑或超过标准白电平）都被保留。

5 在Video Processing Format下，选择8-bit或10-bit以定义您需要用于
处理序列里的视频的比特深度。在某些情况下，比如高清项目需要下
，定义 Adobe Premiere Pro 设置
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转换为 NTSC 或 PAL 格式，视频处理格式将被设置为 8-bit。在
Matrox Axio LE 上，视频处理格式总是设置为 8-bit。

6 在 Preroll/Postroll Frames for Audio Scrubbing 下，使用滑动指针选
择在预览时间线时，在当前时间线指针之前 / 之后需要播放多少帧的
音频。这样您可以听到更多的伴音，进行更精确调整。比如，如果您
将预放的帧数设置为 3，您在拖拉序列预览时将听到之前的 3 帧音频。

注：要令滑动指针返回它的默认设置，点击 D 钮。这个钮在所有
Matrox 有滑动指针的对话框里都可用。

7 在 Error Reporting 下，如果您希望在从 Timeline 面板上播放视频时每
次出现丢帧时或是同步锁定丢失时都有警告，选择 Report dropped 

frames/lost genlock on playback，否则请不选此项。

注：序列播放停止时，序列出现丢帧的部分会出现一个红色条 （即使
您不选择报告丢帧）。

8 在 Realtime Indicator Threshold 下，拖动滑动指针设置 Matrox Axio
决定时间线面板是否实时的门限。向左拖动指针，设置一个较低 （安
全）的门限，向右拖动，设置一个较高的门限。比如，如果您觉得
Matrox Axio 未标出任何不实时的部分 （即，没有红色条），但将项
目输出到磁带时，出现丢帧，您可以修改此设置，令时间线更多部分
强制生成，以避免丢帧。相反，如果您发现时间线上很多部分显示是
不实时的，但播放时却没有丢帧，您可以将门限提高。

9 点击 OK 存储设置并回到 Project Settings 对话框。

以下章节介绍如何指定 Matrox Playback Settings 对话框的其它设置，用
于在 Matrox Axio 上编辑。
定义常规设置
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第 7 章
指定视频输出设置（X.linkHD）
您可以指定从 X.linkHD 接口盒输出的信号的多种设置，比如调节分量视
频增益、选择 NTSC 模拟视频的设置电平、调节 SDI 视频的行延时。

要指定视频输出设置：

1 选择 Project > Project Settings > General，再点击 Playback 

Settings 钮。

2 点击 Video Output。

3 在 Master Output Format 下，选择您需要 X.linkHD 接口盒所有视频输
出的视频格式。视您项目的视频格式而定，您不一定能够改变主输出
格式。

4 如果 Aspect Ratio Conversion 清单可用，比如当高清视频输出需要下
转换为 NTSC 或 PAL，选择以下视频输出中的一项：

- 16x9 Letterbox 输出为 16:9 的信箱格式，在 4:3 电视屏幕上显示
时，图像的上和下边缘都加了一条黑条。

- Anamorphic 将 16:9 的图像以水平方向压缩的 4:3 的格式输出，在
宽屏幕电视上播放时将保持图像的垂直分辨率。如果需要在 NTSC 或
是 PAL 监示器上保持正确的宽高比，将监示器设置为显示 16:9 画
面。

5 如果 Pulldown Method 清单可用，选择您需要应用的输出视频的下拉方
法 （Standard 2:3 或 Advanced 2:3:3:2）。您只在要录制到支持高级
2:3:3:2 下拉方法的 DV-1394 设备时才选择 Advanced 2:3:3:2。视频您
，定义 Adobe Premiere Pro 设置
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的项目帧率和当前的主输出格式不同，系统有可能自动选定一个下拉
方法。

6 在 Analog Setup (NTSC)，选择您需要的 NTSC 模拟视频的设置电平（此
选项同时影响 NTSC 模拟视频的输入和输出）：

- 0 IRE 0 IRE 设置电平。只在使用符合日本 NTSC 0 IRE 设置电平的
商用设备时才选择此项。比如，当在监示器上播放 DV 素材时如果图
像看上去太亮，您可以将输出素材设置为 0 IRE，校正图像亮度。

- 7.5 IRE 标准 NTSC 7.5 IRE 设置电平。

7 选择 Allow Super White，允许最高的亮度电平超过标准的最高白电
平。选择 Allow Super Black，允许最低的亮度电平低于标准的黑电
平。

注：在编辑项目最后输出为播出用时，不应该起用超黑和超白。

8 在 Component Gain 下，使用滑动指针增加或减少 Y（亮度值）、Cb 
（蓝色减去亮度）和 Cr （红色减去亮度）的增益。

9 在 Advanced Settings下，选择您的分量视频输出的格式，并调整SDI视
频输出的定时：

- Component Output Format 从清单中选择适合您的分量视频输出连
接的格式 （YUV 或 RGB）。比如，如果来自 X.linkHD 的分量视频输
出使用模拟分量 Y、R-Y 和 B-Y 连接到视频监示器上，选择 YUV。

- SDI Horizontal Delay 提前或拖后 SDI 视频输出的定时。

10 点击 OK 存储设置并回到 Project Settings 对话框。
定义常规设置
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第 7 章
指定视频输出设置（X.linkSD）
您可以指定从 X.linkSD 接口盒输出的信号的多种设置，比如调节模拟视
频增益、选择 NTSC 模拟视频的设置电平、调节 SDI 视频的行延时。

要指定视频输出设置：

1 选择 Project > Project Settings > General，再点击 Playback 

Settings 钮。

2 点击 Video Output。

3 在 Component Gain 下，使用滑动指针增加或减少视频分量输出的 Y（亮
度值）、Cb （蓝色减去亮度）和 Cr （红色减去亮度）的增益。

4 在 S-Video Gain 下，使用滑动指针增加或减少 S-Video 输出的 Y（亮度
值）、Cb （色度）的增益。

5 在 Composite Gain 下，使用滑动指针增加或减少复合视频输出的增益。

6 在Master Output Format下，选择您需要的X.linkSD接口盒所有视频输
出的视频格式。视您的项目视频格式不同而定，您不一定能够改变主
输出格式。

注：如果您编辑的是高清项目，主输出格式将视您的项目视频格式自
动被设置为 NTSC 或 PAL 制，视频输出也将被下转换为正确格式。

7 如果 Aspect Ratio Conversion 清单可用，比如当高清视频输出需要下
转换为 NTSC 或 PAL，选择以下视频输出中的一项：
，定义 Adobe Premiere Pro 设置
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- 16x9 Letterbox 输出为 16:9 的信箱格式，在 4:3 电视屏幕上显示
时，图像的上和下边缘都加了一条黑条。

- Anamorphic 将 16:9 的图像以水平方向压缩的 4:3 的格式输出，在
宽屏幕电视上播放时将保持图像的垂直分辨率。如果需要在 NTSC 或
是 PAL 监示器上保持正确的宽高比，将监示器设置为显示 16:9 画
面。

8 如果 Pulldown Method 清单可用，选择您需要应用的输出视频的下拉方
法 （Standard 2:3 或 Advanced 2:3:3:2）。您只在要录制到支持高级
2:3:3:2 下拉方法的 DV-1394 设备时才选择 Advanced 2:3:3:2。视频您
的项目帧率和当前的主输出格式不同，系统有可能自动选定一个下拉
方法。

9 选择 Allow Super White，允许视频输出的最高的亮度电平超过标准的
最高白电平。选择 Allow Super Black，允许视频输出的最低的亮度电
平低于标准的黑电平。

注：超白和超黑的电平在最后输出用于播出的视频时不应使用此选
项。

10 在 Analog Setup (NTSC) 下，选择您需要的 NTSC 模拟视频的设置电平
（此选项同时影响输入和输出）：

- 0 IRE 0 IRE 设置电平。只在使用符合日本 NTSC 0 IRE 设置电平的
商用设备时才选择此项。比如，当在 NTSC 监示器上播放 DV 素材时
如果图像看上去太亮，您可以将输出素材设置为 0 IRE，校正图像亮
度。

- 7.5 IRE 标准 NTSC 7.5 IRE 设置电平。

11 在 Advanced Settings 下，使用以下滑动指针调整视频输出的时间：

- SC/H Phase 以同步源的行同步为基准提前或拖后视频输出副载波的
相位 （仅用于复合视频）。

- SDI Horizontal Delay 提前或拖后 SDI 视频输出的时间。

12 点击 OK 存储设置并回到 Project Settings 对话框。
定义常规设置
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第 7 章
指定视频输出设置（X.linkLE）
您可以指定从 X.linkLE 接口盒输出的信号的多种设置，比如调节主和辅
SDI 输出格式、模拟输出格式及 NTSC 模拟视频的设置电平。高级设置，如
行延时和 SC/H 相位调整在另一个页面里设置。

要指定视频输出设置：

1 选择 Project > Project Settings > General，再点击 Playback 

Settings 钮。

2 点击 Video Output，再点击 General。

3 在 Main SDI Output Format 下，选择 X.linkLE 接口盒输出的 SDI（SDI 
OUT 1）视频的格式。视您的项目视频格式不同而定，您不一定能够
改变主 SDI 输出的格式。

注：X.linkLE 接口盒的辅 SDI 输出 （SDI OUT 2）只支持 SD-SDI 视
频。如果您编辑的是高清项目，辅输出格式将视您的项目视频格式被
设置为 NTSC 或 PAL 制，视频输出也将被下转换为正确格式。但对于
1080p @ 24 fps 项目来说，辅 SDI 输出不可用。

4 如果 Aspect Ratio Conversion 清单可用，比如当高清视频输出需要下
转换为 NTSC 或 PAL，选择以下视频输出中的一项：

- 16x9 Letterbox 输出为 16:9 的信箱格式，在 4:3 电视屏幕上显示
时，图像的上和下边缘都加了一条黑条。

- Anamorphic 将 16:9 的图像以水平方向压缩的 4:3 的格式输出，在
宽屏幕电视上播放时将保持图像的垂直分辨率。如果需要在 NTSC 或
，定义 Adobe Premiere Pro 设置
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是 PAL 监示器上保持正确的宽高比，将监示器设置为显示 16:9 画
面。

5 如果 Pulldown Method 清单可用，选择您需要应用的输出视频的下拉方
法 （Standard 2:3 或 Advanced 2:3:3:2）。您只在要录制到支持高级
2:3:3:2 下拉方法的 DV-1394 设备时才选择 Advanced 2:3:3:2。视频您
的项目帧率和当前的主输出格式不同，系统有可能自动选定一个下拉
方法。

6 在 Analog Output Format下，您可以指定X.linkLE的模拟视频输出是否
需要与主或辅 SDI 输出一样。但如果您编辑的是标清项目或是 1080p 
@ 24 fps 项目，模拟输出格式将被设置为与主 SDI Out 一样的格式。

7 在 Analog Setup (NTSC) 下，选择您需要的 NTSC 模拟视频设置电平：

- 0 IRE 0 IRE 设置电平。只在使用符合日本 NTSC 0 IRE 设置电平的
商用设备时才选择此项。比如，当在 NTSC 监示器上播放 DV 素材时
如果图像看上去太亮，您可以将输出素材设置为 0 IRE，校正图像亮
度。

- 7.5 IRE 标准 NTSC 7.5 IRE 设置电平。

8 在 Analog Output Type 下，选择您需要的模拟视频输出。如果您需要输
出标清模拟视频，您可以选择 Composite & Component，或是
Composite & S-Video。如果您输出高清模拟视频， 模拟输出类型将被
设置为 Component （复合输出将无效）。

9 点击 OK 存储设置并回到 Project Settings 对话框。

下一节介绍如何调整 X.linkLE 的高级视频输出设置。
定义常规设置
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第 7 章
指定高级视频输出设置 （X.linkLE）
您可以指定 X.linkLE 的高级视频输出，如行延时和 SC/H 相位调节。

要指定高级视频输出设置：
1 选择 Project > Project Settings > General，再点击 Playback 

Settings 钮。

2 点击 Video Output，再点击 Advanced。

3 使用Horizontal Delay滑动指针提前或推后SDI和模拟视频输出的行定
时。

4 选择 Allow Super White，允许视频输出的最高的亮度电平超过标准的
最高白电平。选择 Allow Super Black，允许视频输出的最低的亮度电
平低于标准的黑电平。

注：Allow Super Black 和 Allow Super White 选项将同时影响 SDI 和
模拟视频输出。超白和超黑的电平在最后输出用于播出的视频时不应
使用此选项。

5 使用 SC/H Phase 滑动指针提前或推后模拟视频输出的副载波相对于同
步源的行同步的相位 （只适用于复合视频）。

6 点击 OK 存储设置并回到 Project Settings 对话框。
，定义 Adobe Premiere Pro 设置
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指定音频输出设置（X.linkHD 和 X.linkSD）
Matrox Axio HD 和 SD 可以调整音频输出设置，如调节模拟音频输出的音
量、选择 SDI 音频输出格式并指定在播放单声道、立体声和 5.1 环绕声时
需要输出哪个声道。

要指定音频输出设置：

1 选择 Project > Project Settings > General并点击 Playback Settings 
钮。

2 点击 Audio Output 钮，再点击 General。

3 在 Analog Audio Volume 下，拖动滑动指针调节模拟音频输出的音量。
默认的设置是两个声道同时移动。要分别拖动每个滑动指针，点击锁
头钮 （ ）禁用它。

4 从SDI Audio Output Format清单，选择您需要的嵌入SDI音频输出的比
特深度 （20-bit 或 24-bit）。

5 从 XLR Output Impedance清单中，选择您需要的平衡 XLR 音频输出的电
阻，比如 Hi-Z （high impedance）。

6 点击 OK 存储设置并回到 Project Settings 对话框。 
定义常规设置
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第 7 章
指定单声道和立体声映射的设置 （X.linkHD 和 X.linkSD）
在播放序列里的单声道和立体声音频时，您可以选择关闭或是开启
X.linkHD 或 X.linkSD 接口盒的音频输出。

要指定单声道 /立体声映射设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 Audio Output，再点击 Mono/Stereo Mapping：

注：X.linkSD 上没有 AES/EBU 通道。

3 要关闭某个声道的输出，点击相应的喇叭钮。比如，要关闭模拟输
出，点击 Analog 下的喇叭钮。要再打开这个声道，再点击这个钮。

4 在 SDI 下，您最多可以打开 4对 SDI 音频（两组，每组两对）。要打开一
对当前不可用的音频，您必须关闭目前选定的组里的两对音频。一旦
一个 SDI 通道可用后，您可以点击它的钮启用这个声道 （喇叭图标将
出现在按钮上）。

5 点击 OK 存储设置并回到 Project Settings 对话框。
，定义 Adobe Premiere Pro 设置
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指定 5.1 环绕声映射的设置 （X.linkHD 和 X.linkSD）
在播放序列里的 5.1 环绕声音频时，您可以选择哪个 5.1 环绕声道指配给
X.linkHD 或 X.linkSD 接口盒的音频输出。

要指定 5.1 环绕声映射设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 Audio Output，再点击 5.1 Surround Mapping。

注：X.linkSD 上没有 AES/EBU 通道。

3 在Surround Channels下，拖动代表5.1环绕声的每个声道的喇叭到所需
的输出通道。比如，将左和右前声道输出到模拟的左和右声道，将 

钮拖动到 Analog L/R。

4 要关闭某个声道的输出，点击相应的喇叭钮。要再打开这个声道，需
要为这个声道重新分配一个环绕声声道。

5 在 SDI 下，您最多可以将环绕声道分配给 4对 SDI 音频（两组，每组两
对）。要将一个环绕声道分配给一个当前不可用的组里的声道，您必
须关闭目前选定的组里的两对音频。

6 点击 OK 存储设置并回到 Project Settings 对话框。
定义常规设置
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第 7 章
指定音频输出设置（X.linkLE）
Matrox Axio LE 可以调整音频输出设置，如调节模拟音频输出的音量、选
择 SDI 音频输出格式并指定在播放单声道、立体声和 5.1 环绕声时需要输
出哪个声道。

要指定音频输出设置：

1 选择 Project > Project Settings > General并点击 Playback Settings 
钮。

2 点击 Audio Output 钮，再点击 General。

3 在 Analog Audio Volume 下，拖动滑动指针调节模拟音频输出的音量。
默认的设置是两个声道同时移动。要分别拖动每个滑动指针，点击锁
头钮 （ ）禁用它。Left 指针调节模拟 1、3、5路音频输出，Right 
指针调节模拟 2、4、6路音频输出。

4 从 XLR Output Impedance清单中，选择您需要的平衡 XLR 音频输出的电
阻，比如 Hi-Z （high impedance）。

注：在 Matrox Axio LE，嵌入 SDI 音频的比特深度设置为 24-bit
（如 SDI Audio Output Format 所示）。

5 点击 OK 存储设置并回到 Project Settings 对话框。 
，定义 Adobe Premiere Pro 设置
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指定单声道和立体声映射的设置 （X.linkLE）
在播放序列里的单声道和立体声音频时，您可以选择关闭或是开启
X.linkLE 接口盒的音频输出。

要指定单声道 /立体声映射设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 Audio Output，再点击 Mono/Stereo Mapping。

此页面显示，当播放单声道和立体声音频时，音频输出为主嵌入 SDI 音频
输出、主模拟音频及 AES/EBU 输出 （ANALOG AUDIO OUT 1 和 OUT 2
和 AES/EBU OUT 1/2）。
定义常规设置
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第 7 章
指定 5.1 环绕声映射的设置 （X.linkLE）
在播放序列里的 5.1 环绕声音频时，您可以选择哪个 5.1 环绕声道指配给
X.linkLE 接口盒的音频输出。

要指定 5.1 环绕声映射设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 Audio Output，再点击 5.1 Surround Mapping。

此页面显示在播放 5.1 环绕声时，音频是按以下方式输出的：

• 左前声道和右前声道输出为X.linkLE的主嵌入SDI音频输出、主模拟音
频和 AES/EBU 输出 （ANALOG AUDIO OUT 1、 OUT 2、 AES/EBU 
OUT 1/2）。

• 左后声道和右后声道输出为X.linkLE的辅嵌入SDI音频输出、辅模拟音
频和 AES/EBU 输出 （ANALOG AUDIO OUT 3、 OUT 4、 AES/EBU 
OUT 3/4）。

• 中间声道和超低音声道将输出为X.linkLE的第三路嵌入SDI音频、第三
路模拟音频和 AES/EBU 输出 （ANALOG AUDIO OUT 5、 OUT 6 和
AES/EBU OUT 5/6）。
，定义 Adobe Premiere Pro 设置
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指定同步锁定设置
您可以选择同步源，将所有连接到 Matrox Axio 系统的设备都锁定到这个
同步源上，还可调节所有来自 Matrox Axio 的输出的时间设置。

要指定同步锁定设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 Genlock。

3 从 Genlock Source 清单中，选择一下任意一项：

- Internal 锁定到 Matrox Axio 的内部参考信号。您只在没有外部同
步发生器或是可靠的外部视频同步源时才选择这个选项。

- Black Burst Broadcast Quality 锁定到连接到X.link 接口盒的REF 
IN 上的外部同步发生器。

- Black Burst VTR Quality 锁定到连接到 X.linkSD 接口盒的 REF IN
上的模拟录像机信号源 （此选项在 X.linkHD 或 X.linkLE 上不可
用）。

- SDI Video 锁定到 SDI 视频信号源上。仅在您的 SDI 视频信号源非
常稳定 （即，它有一个内置的时基校正器）时才选择此选项 （此选
项在 X.linkLE 上不可用）。
定义常规设置
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第 7 章
备注

- 在 Matrox Axio SD 系统上采集嵌入 SDI 音频时，您必须将同步锁定
源设置为 SDI Video 以避免采集音频时抖动。

- 在 Matrox Axio LE 上采集嵌入 SDI 音频时，您必须将同步锁定源设
置为 Black Burst VTR Quality。

- 同步锁定信号源的状态会表示为 Locked或 Not Locked以显示Matrox 
Axio 目前是否锁定在这个信号源上。当您改变同步源时，输出的视
频会变形失真，直到 Matrox Axio 再次锁定到新的同步源为止。

4 在 Genlock Video Format 下，选择您同步源的视频格式。如果您不能选
择一个视频格式，请确保您的同步源符合指定的视频格式。当同步源
设置为 Internal 时，在 Matrox Axio HD 或 SD 上，同步视频格式设置
为您的项目的主输出格式，在 Matrox Axio LE 上，设置为项目的主
SDI 输出格式。

重要：要达到良好的采集效果，确保同步源的视频格式与您采集的素
材的格式一样。

5 在Advanced Settings下，拖动Horizontal Delay和Vertical Delay滑动
指针，调节视频输出相对于同步源的行和场的时间。这令您可以补偿
系统的电缆延时。

6 如果您希望结束模拟同步信号，选择 Reference Termination （此选项
在 X.linkLE 上不可用）。

7 点击 OK 存储设置并回到 Project Settings对话框。
，定义 Adobe Premiere Pro 设置
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选择 DV-1394 输出设置
您可以从 Timeline 面板里选择通过 1394 接口输出序列，以输出到 DV 磁
带上，并选择 DV-1394 输出的格式。

要选择 DV-1394 输出设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 DV-1394 Output。

3 在输出到磁带 （即选择 File > Export > Export to Tape），如果您需
要通过 1394 接口输出序列，选择 Enable 1394 output for export to 

tape。您将可以将序列录制到连接到 Axio 系统的 DV-1394 设备上。

重要：因为此选项需要占用更多系统资源，您有可能发现选择了此选
项后，某些原来实时的特技出现丢帧，而且需要生成 （序列上方出现
红色条）。所以您仅在需要将序列输出到 DV 磁带时才选择此项。当您
输出到磁带时，Adobe Premiere Pro 将生成有红色条的部分。

4 从 Output Format 清单中，选择您需要的 DV-1394 输出格式。 比如，要
录制到标准 DV 设备，选择 Matrox DV/DVCAM。可用的输出格式视您的
项目的视频格式和 Matrox Axio 硬件而定。

5 点击 OK 存储设置并回到 Project Settings 对话框。

定义视频生成设置
选择您选择 Matrox Axio 项目预设时，您用于在 Matrox Axio 上编辑的视
频生成设置也将自动设置。您可以按 Adobe Premiere Pro 文件所示指定其
它视频生成设置。
定义视频生成设置
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第 7 章
定义采集设置
Matrox Capture Settings 有可以用于定义在 Matrox Axio 上的 Adobe 
Premiere Pro 中采集视频和音频所需要的设置的页面。

注：当您在 Matrox Axio 上设置采集设置时，将出现 VU 表，让您可以监
控音频输入电平。要了解更多信息，见 81 页 “监听采集音频电平”。

定义视频采集设置
视项目格式和 Matrox Axio 硬件不同，Matrox Axio 可以将视频采集为采
集为多种视频格式。比如，如果您的项目是一个标清项目 （如 NTSC），您
可以采集为 DV 格式，如 DVCPRO，以创建为 .avi 文件，用在标清
Premiere Pro 项目中。

要在 Matrox Axio 上的 Adobe Premiere Pro 中指定视频采集设置： 

1 选择 Project > Project Settings > Capture。

2 从 Capture Format 清单中，选择 Matrox Axio。

3 点击 Configure 钮，再点击 Video Capture Settings。

4 在 Input Device 下，选择以下一种设备（以下选项视您使用的 Matrox 
Axio 硬件不同而有所变化）：

- X.linkHD 采集连接到 X.linkHD 接口盒的 SDI 视频信号源。

- X.linkSD 或 X.linkLE 采集连接到 X.linkSD 或 X.linkLE 接口盒的模
拟或是 SDI 视频信号源。

- DV-1394 采集连接到 X.link 接口盒的 DV-1394 设备信号源。（这个
选项在您制作 23.98 fps 或 24 fps 帧率的高清项目时不可用）。

5 如果您选择了一个 X.link 作为输入设备，从 Input Source 清单里选择
您需要采集的输入格式。如果您使用 X.linkSD 或 X.linkLE 采集，选
择 SDI、Component、Composite 或 S-Video。如果您使用 X.linkHD 采
集，将 Input Source 设置为 SDI。
，定义 Adobe Premiere Pro 设置



77
备注

- 如果您选择了 DV-1394 作为输入设备，连接到 X.link 接口盒的
DV-1394 的设备名将显示在 Input Source 框中。

- 如果 Matrox Axio 在您开始采集时不能检测到您的源设备，您将收
到一个出错信息。在从 X.linkSD 采集时，如果没有效的输入信号，
采集结果就会是黑场。在从 X.linkHD 采集时，只有出现有效的输
入信号时，系统才开始采集。在两种情况下，您都需要确保您的设
备已开机，而且正确连接到 X.link 接口盒，以正确采集视频。

6 从 Input Format 清单中，选择符合您的视频信号源的视频格式。如果
此格式不符合您的项目的视频格式，Matrox Axio 会自动应用一个下
拉处理，将输入视频转换成您的项目视频格式。比如，如果您的项目
格式为 1080p @ 23.98 fps，而您将 Input Format 设置为
1080i@29.97fps，系统会给要采集的视频自动加一个反下拉 （2:3）处
理，以采集成 1080p @ 23.98 fps。如果您将采集设置定义为标清项
目，Input Format 将被设置为 NTSC 或 PAL。

7 从 Input Aspect Ratio 清单中，选择您的视频信号源的宽高比 （4:3
或 16:9）。比如，要采集使用标准电视屏幕格式录制的视频，选择
4:3。要采集使用 16:9 宽屏幕录制的视频，选择 16:9。如果您在定义
用于高清项目的采集设置，Input Aspect Ratio 将设置为 16:9。

8 在 Capture Format 下，从清单中选择您需要的采集格式。但如果您从
DV-1394 设备采集，视频就会被采集为原始 DV 或 HDV 格式 （Capture 

Format 将被设置为 Native DV/HDV）。要采集为 HDV 格式，您的项目格
式必须是 1080i @ 25 fps 或 1080i @ 29.97 fps。
注：Capture Format 清单中可用的采集格式视您的项目的视频格式和
Matrox Axio 硬件而定。比如，如果您定义用于高清项目的采集设置，
Matrox Axio HD 或 LE 上就只有高清采集格式可用。

- Matrox DV/DVCAM 将视频采集为 DV 或 DVCAM 格式。

- Matrox DVCPRO 将视频采集为 DVCPRO 格式。 

- Matrox DVCPRO50 将视频采集为 DVCPRO50 或 D-9 格式。

- Matrox DVCPRO HD 将视频采集为 DVCPRO HD 格式。（只在 1080i 
@ 25 fps、1080i @ 29.97 fps 或 720p @ 59.94 fps 格式的高清项目中可
用。）

- Matrox 8-bit Uncompressed 将视频采集为 8-bit 无压缩格式。

- Matrox 10-bit Uncompressed 将视频采集为 10-bit 无压缩格式。
（在从 X.linkLE 中采集时不可用。）
定义采集设置
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- Matrox MPEG-2 I-frame 将视频以选定数据率采集为 4：2：2 
Profile @ Main Level 的 MPEG-2 I- 帧格式 （仅用于标准清晰
度）。

- Matrox MPEG-2 I-frameHD 将视频以选定数据率采集为 4：2：2 
Profile @ High Level 的 MPEG-2 I- 帧格式 （仅用于高清晰度）。

- Matrox Offline HD 将视频采集为代理高清视频格式，用于脱机编
辑。

9 如果您选择了Matrox MPEG-2 I-frame或Matrox MPEG-2 I-frame HD， 点
击 Configure 钮调整 MPEG-2 I- 帧设置。要了解可用设置的详情，见
57 页 “选择 MPEG-2 I 帧设置”。调整好您的设置后，点击 OK 回到
Matrox Capture Settings 对话框。

10 如果您需要自动调整模拟输入信号以补偿过亮或过暗的画面，选择Use 

Automatic Gain Control （AGC）。这将改善您的图像的总体亮度和对
比度 （只用于从 X.linkSD 或 X.linkLE 采集）。

11 如果信号源设备是一台广播级设备，如带内置时基校正器 （TBC）的
设备，选择 Broadcast-quality Source。Matrox Axio 直接将输入信号
数字化。如果您的信号源设备没有时基校正器或是不是广播及设备，
请不要选择此项。在这种情况下，Matrox Axio 将过滤输入信号，以
增加同步脉冲不稳定性容差 （仅适用于从 X.linkSD 采集）。

12 点击 OK 存储设置并回到 Project Settings 对话框。
，定义 Adobe Premiere Pro 设置
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定义音频采集设置
您可以指定多种音频采集设置，如指定在 Matrox Axio 上采集音频时的输
入源和需要创建的音频文件类型 （.wav 或单声道 .wav）。在 Matrox Axio
上采集一个素材时，素材的视频和音频文件都存储在一个 .avi 文件里，
素材的音频文件还存储为一个或多个独立的 .wav 文件。您可以使用如
Adobe Audition 这样的音频后期制作软件来编辑独立的 .wav 文件。

要在 Matrox Axio 上的 Adobe Premiere Pro 中指定音频采集设置： 

1 选择 Project > Project Settings > Capture。

2 从 Capture Format 清单中，选择 Matrox Axio。

3 点击 Configure 钮，再选择 Audio Capture Settings。

4 如果您选择 X.link 接口盒作为视频输入设备（见 76 页“定义视频采集
设”），您必须还要选择要采集音频的源信号。从 Input Source 清单
中，选择您需要的音频源。比如，如果您需要从 SDI 信号源中采集嵌
入音频，选择 SDI （embedded audio）。

5 在 Capture Format 下，选择您采集的音频文件的比特深度。如果您从
DV-1394 设备采集，Capture Format 将被设置为 16-bit。
定义采集设置
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6 如果您希望每次调整 Matrox Axio 采集设置或是打开 Capture 面板开始
采集时，都出现 VU 表，选择 Show VU meters。此选项为默认设置。
要了解更多关于 VU 表的详情，见 81 页 “监听采集音频电平”。

7 在 Capture Files 下，指示您是想采集成立体声或是单声道音频文件，
再选择您希望将哪个声道存储成为一个独立的 .wav 文件。

- 从 File Type 清单中，选择 Stereo 将采集到的音频存储为立体声
.wav 文件，或是选择 Mono 存储为单声道 .wav 文件。

- 从 Filename 清单中，选择您需要将哪个立体声道和单声道存储为
.wav 文件 （视 Matrox Axio 硬件不同，最多 4个立体声文件或是 8
个单声道文件）。如果有哪个 .wav 文件您不想创建，选择 None，或
者如果您只采集 1 和 2声道，点击 Filename 清单里的 D 

（default）钮。当 Axio 存储每个 .wav 文件时，它会按您的视频文
件的名字在相关音频文件名字后面加一个 .Stereo.wav 或
.Mono.wav 后缀。比如，如果您的视频文件叫 MyFile.avi，相关立
体声音频文件就叫 MyFile.Stereo1.wav、MyFile.Stereo2.wav，等
等。 

备注

- 您选择用来存储第一对立体声 .wav 文件或是前两个单声道 .wav 文
件的声道将被嵌入到相关的 .avi 文件里。当输入 .avi 文件到
Project 窗口时，素材的独立的 .wav 文件也将被输入，.avi 文件的
嵌入音频将被忽略。但素材的 .avi 文件和第一个相关 .wav 文件将
在项目中显示为同一个 Movie 素材。只有 .avi 文件没有相关的
.wav 文件时，才会使用 .avi 文件的嵌入音频。

- 在只采集音频时，Matrox Axio 支持采集仅一路立体声。第一路立
体声或是前两路单声道将被存储为一个单独的 .wav 文件 （任何其
它声道都会被忽略）。当 Axio 将纯音频采集文件存储为一个 .wav
文件时，它不会给文件名后面加一个 .Stereo.wav 后缀。

8 点击 OK 存储设置并回到 Project Settings 对话框。
，定义 Adobe Premiere Pro 设置
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监听采集音频电平
如果您在 Audio Capture Settings页面下选择了 Show VU meters ，每次您调
整 Matrox Axio 采集设置或是打开 Capture 面板开始在 Adobe Premiere Pro
中采集， VU 表都会显示，让您监控当前选定的音频输入源的电平。

在您播放音频源时，输入电平在低于 –12 dBSF 时是绿色的，在 –12 到 –6 
dBFS 之间时黄色的，超过 –6 dBFS 时是红色的。一旦出现音频箝位，箝位
检测器就会亮起来 （变红）。峰值电平指示是一条红线，显示曾经达到的
最高电平。如果没有新的峰值电平，这些指示器将显示两秒钟。

如果需要的话，调节源设备上的音频电平，将平均输入电平控制在 –30 和
–10 dBSF 之间。

箝位检测

峰值电平指示
定义采集设置
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定义监听设置 （X.linkHD 和 X.linkSD）
Matrox Axio HD 和 SD 可以在采集过程中修改监听设置，如选择在采集嵌
入 SDI 音频时，监听哪一个声道的输出。只有要采集成 .wav 文件的声道
才可以监听。 

要在采集过程中定义监听设置： 

1 选择 Project > Project Settings > Capture。

2 从 Capture Format 清单中，选择 Matrox Axio。

3 点击 Configure 钮，再点击 Audio Monitoring。

注：AES/EBU 声道在 X.linkSD 接口盒上不可用。

4 在 Input Channels下，按 Audio Capture Settings中设置（见 79页“定
义音频采集设置”），每个喇叭钮代表一对立体声或是两路单声道。比
如，如果您需要在左和右模拟音频输出上监听最先采集的立体声或单
声道，将  钮拖动到 Analog L/R。

5 要关闭某个声道的输出，点击相应的喇叭钮。要再打开这个声道，您
需要再为这个喇叭指定一路输入音频。

6 在 SDI 下，您最多可以将输入音频分配给 4对 SDI 音频（两组，每组两
对）。要将输入音频分配给一对当前不可用的音频，您必须关闭目前
选定的组里的其中一组音频里的两对音频。

7 点击 OK 存储设置并回到 Project Settings 对话框。 
，定义 Adobe Premiere Pro 设置
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Premiere Pro 输出到磁盘
Adobe Premiere Pro 有几种软件编解码器，可以以不同格式输出视频。
Matrox Axio 系统在 Premiere Pro 的基础上再添加几种 Matrox 编解码器。
因为 Matrox 编解码器使用 Axio 硬件加速生成，所以速度比使用软件编解
码器更快。

Matrox 编解码器有标清和高清格式。 输出为 Matrox .avi 文件所支持的格式
视您的项目的视频格式而定，如下表所示：

比如，如果您的项目是 NTSC 格式的，您必须选择 NTSC 编解码器。如果
您的项目是 1080i @ 29.97 fps 格式，您可以选择使用 1080i @ 29.97 fps 编
解码器输出为高清格式，或是您可以选择 NTSC 编解码器将高清视频下转
换为 NTSC 格式。但只有使用 8-bit 视频处理格式的项目才可以将高清项
目下转换为 NTSC 或 PAL。

要将序列输出为 Matrox .avi 文件：

1 选择 File > Export > Movie。点击 Settings 钮。从 File Type 清单中，
选择 Matrox AVI。

2 从 Range 清单中，选择一个输出范围，再选择其它输出选项。

3 从对话框左边的菜单中选择 Video。

项目视频格式 所支持的输出格式

NTSC NTSC
PAL PAL

486p @ 23.98 fps 486p @ 23.98 fps 或 NTSC
1080i @ 25 fps 1080i @ 25 fps 或 PAL

1080i @ 29.97 fps 1080i @ 29.97 fps 或 NTSC
1080p @ 23.98 fps 1080p @ 23.98 fps、 1080i @ 29.97 fps 或 NTSC

1080p @ 24 fps 1080p @ 24 fps
1080p @ 25 fps 1080p @ 25 fps or PAL

720p @ 59.94 fps 720p @ 59.94 fps or NTSC
Premiere Pro 输出到磁盘
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4 从 Compressor 清单中，选择您需要的输出文件格式。

重要：清单里有 Matrox 编解码器支持的所有标清和高清格式。格式显
示在编解码器名称旁边的括号里，如 (NTSC）。确保您选择的 Matrox
编解码器在上表中您的项目支持的格式清单中。 

- Matrox DV/DVCAM 将视频生成为 DV 或 DVCAM 格式。

- Matrox DVCPRO 将视频生成为 DVCPRO 格式。 

- Matrox DVCPRO50 将视频采集为 DVCPRO50 或 D-9 格式。

- Matrox DVCPRO HD 将视频生成为 DVCPRO HD 格式。（只在 1080i 
@ 25 fps、1080i @ 29.97 fps 或 720p @ 59.94 fps 格式的高清项目中可
用。）

- Matrox 8-bit Uncompressed 将视频生成为 8-bit 无压缩格式。

- Matrox 10-bit Uncompressed 将视频生成为 10-bit 无压缩格式。
（在从 Matrox Axio LE 输出时不可用。）

- Matrox MPEG-2 I-frame 将视频以选定数据率生成为 4：2：2 
Profile @ Main Level 的 MPEG-2 I- 帧格式 （仅用于标准清晰
度）。

- Matrox MPEG-2 I-frameHD 将视频以选定数据率生成为 4：2：2 
Profile @ High Level 的 MPEG-2 I- 帧格式 （仅用于高清晰度）。

- Matrox Offline HD 将视频生成为代理高清视频，用于脱机编辑。

5 如果您选择了Matrox MPEG-2 I-frame或Matrox MPEG-2 I-frame HD， 点
击 Configure 钮选择 MPEG-2 I- 帧设置。要了解可用设置的详情，见
86 页 “选择 MPEG-2 I 帧设置”。调整好您的设置后，点击 OK 回到
Matrox Capture Settings 对话框。

6 从 Pixel Aspect Ratio 清单中，选择符合您的素材的宽高比：

- D1/DV NTSC （0.9） 用于使用标准电视屏幕格式的 NTSC 或 486p @ 
23.98 fps 素材。如果您将高清视频下转换为 NTSC 格式，输出的视
频将为信箱格式。

- D1/DV Widescreen 16:9 （1.2） 用于使用 16:9 宽屏幕格式的
NTSC 或 486p @ 23.98 fps 素材。如果您将高清视频下转换为 NTSC
格式，输出的视频将变形 （水平方向压缩为 4:3）。

- D1/DV PAL （1.067） 用于使用标准电视屏幕格式的 PAL 素材。如
果您将高清视频下转换为 PAL 格式，视频将以信箱格式输出。

- D1/DV PAL Widescreen 16:9 （1.422） 用于使用 16:9 宽屏幕格式
的 PAL 素材。如果您将高清视频下转换为 PAL 格式，输出的视频将
变形 （水平方向压缩为 4:3）。
，定义 Adobe Premiere Pro 设置
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- Square pixels （1.0） 用于所有未被下转换的高清素材。 

7 我们建议您不选择 Recompress。这将最大限度保持视频质量。还将优
化输出速度，因为如果您的素材的压缩和视频格式与您要输出的压缩
格式一样，不含特技的实时部分将直接复制到磁盘上，无需再压缩。

8 点击 OK 存储输出设置。

注：输出的音频将嵌入到相关的 .avi 文件中，还将被存储为一个或
多个独立的 .wav 文件，放在与 .avi 相同的文件夹中。Matrox Axio
不支持纯音频输出。
Premiere Pro 输出到磁盘
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选择 MPEG-2 I- 帧设置
当选择使用 Adobe Premiere Pro 以 Matrox MPEG-2 I- 帧或 Matrox 
MPEG-2 I- 帧高清格式采集或输出视频时，可指定多种 MPEG-2 I- 帧压缩
设置。

要选择 MPEG-2 I- 帧设置： 

1 点击 Configure 钮，出现与下图相似的对话框：

2 拖动 Data Rate 滑动指针，直到出现您需要的数据率。您选择的数据率
越高，画面质量越好。可用数据率的范围视您在使用 Matrox MPEG-2 
I 帧高清或是标清格式而定。

重要：视您的系统能力而定，如果您选择的数据率高于 125 Mb/sec，
有可能出现丢帧。

3 要在 MPEG-2 I- 帧文件上应用高级设置，点击 Advanced 钮。

注：默认的高级设置可以为大多数应用提供良好效果。我们建议您只
在有特殊目的时才修改这项设置。 

4 在 Rounding Type 下，选择以下一个选项：

- MPEG-2 在计算量化系数时，将 AC 系数四舍五入到最近的整数。 

- Matrox Custom 在计算量化系数时，将 AC 系数截取最低的整数。在
这种情况下，这个设置在出现图文时有可能失真较小。

5 在 DC Precision 下，选择 DC 帧内编码块的比特深度。

注：您用于采集或生成视频的 DC 精度值越高，在编码的数据流里，DC
内容就会越多，AC 内容则越少。这有可能导致某个数据率下的压缩 
数据流的整体质量降低。

6 在 Zig Zag Type 下，选择以下其中一项：
，定义 Adobe Premiere Pro 设置
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- Regular 按 ISO/IEC 13818-2 （图 7-2） 规格文件设置标准 （默
认）之字形扫描模式 DCT 块的 AC 系数。

- Alternate 按 ISO/IEC 13818-2（图 7-3）规格文件设置 DCT 块的 
AC 系数的反之字形扫描模板。在以高数据率（比如，数据率为 100 
Mb/sec 或更高）采集或是生成视频时使用此设置。

7 选择 Force Frame-based DCT 设置将宏块生成帧而不是场。在某些情况 
下，选择此选项在显示图文时失真较小。

8 点击 OK 存储设置。
选择 MPEG-2 I- 帧设置
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在序列上加配音
Matrox Axio 支持配音，可以在 Timeline面板上直接录制一个 .wav文件，在
画面上加一些评论，如我们在新闻和纪录片中常看到的。

备注：

• 要使用 Matrox Axio 配音功能，您必须有一个用于配音的音频输入和有
效的视频输入。视频输入只用于同步锁定。我们建议您将所有连接到
Matrox Axio 系统上的外部设备都锁定到同一个可靠的外部同步源上。
要了解如何选择同步源，见 73 页 “指定同步锁定设置”。

• Matrox 配音功能不支持下拉。因此，如果输入格式设置为 1080i @ 
29.97 fps，对于 486p @ 23.98 fps 或 1080p @ 23.98 fps 项目，不支持此功
能。

• Matrox 配音功能只支持录制为立体声或是单声道。

• 因为 Matrox 配音功能使用 Matrox Playback Settings 对话框里的
Matrox Axio 音频输入映射设置，您一定不能使用 Adobe Premiere Pro 的
Preferences 对话框里的 Audio Output Mapping 设置来修改 Matrox 
ASIO 驱动程序里的音频输出映射设置。

连接和安装
1 将话筒连接到您的源设备的音频输入上，将来自源设备的音频输出接

到 X.link 接口盒相应的音频输入上。

2 选择 Edit > Preferences > Audio Hardware。

3 从 Default Device 清单中，选择 Matrox ASIO Driver，再点击 OK。

4 选择 Project > Project Settings > Capture。

5 确保 Capture Format 设置为 Matrox Axio。

6 点击 Configure 钮，再点击 Video Capture Settings。

7 从 Input Device 清单中，选择您的 X.link 接口盒，如 X.linkHD。

注：Matrox 配音功能不支持 DV-1394 设备。

8 从 Input Source 清单中，选择您的同步锁定源的视频输入。比如，如
果视频输入连接到 X.linkSD 接口盒的复合视频输入上，选择
Composite。

9 点击 Audio Capture Settings。

10 从 Input Source 清单上，选择与连接了麦克风的设备的音频源相应的
类型。比如，如果麦克风连接到 X.linkSD 的 XLR 插头上，选择 XLR 

(balanced analog）。

11 对麦克风说话，以测试麦克风的音频输入电平，并使用 Audio Input 

Levels 窗口的 VU 表检测音频输入电平。在对麦克风说话时，观察输入
电平，如果需要的话，调节设备的音频电平。
，定义 Adobe Premiere Pro 设置
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注：在使用 Matrox ASIO 驱动程序为默认设备时，Adobe Premiere 
Pro 的混音器不支持 Meter Input(s) Only 选项。

12 点击 OK 存储设置并回到 Project Settings 对话框。

录音
使用 Adobe Premiere Pro 的混音器录音。要了解更多使用混音器的信息，见
Adobe Premiere Pro 文件。

1 选择 Window > Audio Mixer， 再选择需要录音的序列（比如，Window > 

Audio Mixer > Sequence 01）。

2 将时间线放在 Timeline 面板上需要开始录音的位置。
在序列上加配音
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第 7 章
注：（如果您需要录音的这个轨上已有音频，原来的声音将被新录的配音
抹掉。

3 在Audio Mixer面板上，点击需要录音的每条轨的Record Enable钮 。
您可以同时在多条声轨上录音。如果您要录到一单声道上去，选择
Matrox Left 或 Matrox Right 指定想录制到哪个轨上。

4 点击 Record 钮 准备录音。 
5 点击 Play 钮 ，对着麦克风开始录音。

注：在录制过程中，您监听到的声音和录制的声音之间有一点轻微的
延时。如果不想监听，点击 Mute Track 钮 或拖动 Volume 滑动指针
降低音量。

6 点击 Stop 钮 停止录音。您的配音将作为 .wav文件被加到选定的声钮
上 。

录音

启用

录音

播放 /停止

静音轨

音量
，定义 Adobe Premiere Pro 设置
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使用 Matrox Media Encoder 输出素材
您可以使用 Matrox Media Encoder 从 Timeline面板中的序列里将素材输出
为多种格式，用于特定的媒体传输，比如 Windows Media 或 RealMedia 数
据流媒体或 MPEG-2 格式，用于 DVD 刻录。比如，您可以使用 Matrox 
Media Encoder 将序列中的视频输出为 MPEG-2 Elementary （.m2v），用于
Adobe Encore DVD。

Matrox Media Encoder 提供与 Adobe Media Encoder 一样的输出格式。但是
Matrox Media Encoder使用Axio硬件加速生成，因此视频输出的速度和质量
都比 Adobe Media Encoder 要高。

要使用 Matrox Media Encoder 输出素材：

1 打开 Adobe Premiere Pro。

2 打开您需要输出的项目。

3 如果只需要输出序列的一部分，拖动工作区条，让它超过需要输出的
部分。

4 选择 File > Export > Matrox Media Encoder。

5 从Format清单中选择您需要的输出格式。如果需要输出素材用于DVD刻
录，选择 MPEG2-DVD。

6 从 Preset清单中选择符合您要求的输出类型 Export Settings对话框中
对每种设置有简短的介绍。

7 点击 OK。

8 指定文件名、存储位置和输出范围，再点击 Save。

Export Settings 对话框中的所有设置都和 Adobe Media Encoder 一样。要
了解如何使用这些设置的详情，见 Adobe Premiere Pro 文件。
使用 Matrox Media Encoder 输出素材
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第 7 章
设置 Matrox DV/HDV 设备控制
在 Adobe Premiere Pro 中从磁带采集素材或将素材输出到磁带时，您可以
使用 Matrox DV/HDV 设备控制来操作 DV-1394 设备。

要设置 Matrox DV/HDV设备控制：
1 选择 Edit > Preferences > Device Control。

2 从 Devices 清单中，选择 Matrox DV/HDV Device Control。

3 点击 Options 并确保您的设备按照 Adobe Premiere Pro 文件所述正确设
置 （这些选项与 Adobe Premiere Pro 的 DV/HDV 设备控制一样）。

4 点击 OK 存储设置。

现在您可以使用 1394 接口采集或输出素材了 （请确保您的设备设置为
Remote或VTR模式）。要了解如何在Adobe Premiere Pro中采集，见Adobe 
Premiere Pro 文件。要了解如何使用设备控制输出素材，见下一节。

将序列输出到磁带
Matrox Axio 可以使用 DV-1394 或 RS-422 设备控制将素材从 Adobe 
Premiere Pro 序列输出到磁带上。您可以使用 Matrox DV/HDV 设备控制控
制 DV-1394 设备。对于 RS-422 设备，您可以按 Adobe Premiere Pro 文件
所述使用串行设备控制。

准备磁带用于录制
要使用设备控制，用来录制素材的磁带必须有连续连贯的时间码。您可以
通过在整个磁带上录制黑电平将整个磁带全部写上时间码。

注：DV 磁带的格式必须与录制格式相配。比如，如果您将 DV-1394 设备的
录制格式设置为 DV/DVCAM，所有时间码必须以 DV/DVCAM 格式写入，不支
持混合格式。

输出到 DV 磁带时避免丢帧
在某些 DV-1394 设备上输出到磁带时，有可能在设备开始录制和 Adobe 
Premiere Pro 开始播放之间出现一个延时。这有可能导致项目的第一个视
频帧没录上。要确保您不丢帧，您需要推迟要输出的项目的播放。

要做到这一点，您需要使用 DV-1394 设备进行一个输出测试，以了解开头
有多少帧没录在 DV 磁带上。在 Adobe Premiere Pro 的 Export To Tape 对
话框中，选择 Delay Movie Start，输入您丢失的帧数的 4 倍 （因为单位
是 1/4 帧）。如果需要的话，调整这个数值，直到您可以进行精确到帧或
是接近精确到帧的输出为止。

注：如果您输出的视频是精确到帧的，但您的音频在 DV 磁带开头处丢帧，
只要在时间线开始处加几帧黑场或是静帧就可以了。如果您这样做，您有
可能不需要使用 Delay Movie start。
，定义 Adobe Premiere Pro 设置
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使用 DV-1394 设备控制输出到 DV 磁带
将 Adobe Premiere Pro 序列输出到 DV-1394 设备时，您可以使用 Matrox 
DV/HDV 设备控制。

要使用 DV-1394 设备控制输出到 DV 磁带： 

1 打开项目并选中需要输出到磁带的序列。

2 确保您的 DV-1394 设备正确连接，开机，而且启用了 DV-1394 输出端
口，用于输出到磁带，并按 75 页 “选择 DV-1394 输出设置”所述选
择了 DV-1394 输出格式。

3 如果您使用的是摄录一体机，切换到录像机模式。

4 在 DV-1394 设备中放入一盘写满时间码的磁带。

5 请确保您已按 92 页 “设置 Matrox DV/HDV 设备控制”所述设置好了
Matrox DV/HDV 设备控制。

6 选择 File > Export > Export to Tape。

要了解如何使用 Adobe Premiere Pro 将序列输出到磁带，见您的 Adobe 
Premiere Pro 文件。
将序列输出到磁带
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创建标准清晰度的 16:9 格式项目
Matrox Axio 可处理以标准清晰度的 4:3 电视宽高比格式或以 16:9 宽高比
录制的素材。

要使用 Matrox Axio 创建一个标准清晰度的 16:9 格式项目，步骤如下：

1 使用摄像机将视频录制到磁带上，将宽高比设为 16:9 。素材会录制成
水平方向压缩的 4:3 视频。

2 启动 Adobe Premiere Pro，选择合适的 Matrox Axio 宽屏幕设置 （如
DVCPRO Widescreen）。这样在 Matrox Axio 上创建的特技在使用 16:9 
格式观看时就可以按正确比例显示。

3 按正常操作采集视频信号。将 NTSC 或 PAL 视频监示器上的宽高比选择
为 16:9 以 “拉抻”视频，以宽屏幕格式播放时图像就不会变形。

4 如果使用一个可以设置像素宽高比的程序创建动画、字幕或图文，使
用适当的 16:9 设置以正确显示视频：

- 在 NTSC 或 486p @ 23.98 fps 视频系统上将像素宽高比设为 1.185。

- 在 PAL 系统上，将像素宽高比设为 1.422。

如果无法设置像素宽高比，以 864 x 486 （NTSC 或 486p @ 23.98 
fps） 或 1024 x 576 （PAL）创建图像。创建完图像后，只将宽度调
回为 720。当调整尺寸时，文字或图文在计算机上看上去都拉长了。

5 像编辑标准 4:3 素材一样编辑项目。 

注：请注意，如果您的视频监示器显示为 4:3 格式，某些特技会因为
水平方向拉长而看上去像是拉长了。将监示器设为 16:9 特技就会以正
确比例显示。

6 将完成作品录制在磁带上。请记住您需要一台可显示 16:9 素材的监示
器，以正确观看母带。
，定义 Adobe Premiere Pro 设置
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设置 Adobe Premiere Pro 实时特技

本章介绍如何使用用于 Adobe 
Premiere Pro 的 Matrox 实时插件
设置实时特技。
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第 8 章
可用特技
Adobe Premiere Pro 的 Matrox Axio 实时插件可以：

·设置鲜艳夺目的实时 Matrox 特技及过渡特技，使用最多 4 层标清视频
素材和 6层标清图文，或是 2层高清视频素材和 2层高清图文层。这
个插件包括色彩校正特技、色键特技、亮度键特技、3D DVE、卷页特
技、阴影特技其它更多特技。

注：在 Axio LE 上，某些特技只有在使用支持 Matrox 硬件加速特技的
显卡时才能显示。要了解更多信息，见 183 页 “ 在 Adobe Premiere 
Pro 里起用和禁用 Matrox 硬件加速特技”。

·改变多种特技设置，通过添加或调整关键帧改变特技。

·自定义和裁剪实时特技。

·使用带 alpha 键通道的单帧图文文件创建实时图文叠加层。

·实时制作部分 Adobe Premiere Pro 特技，包括叠化 （视频不透明特
技）、DVE （Motion）和黑白特技。

·给视频素材添加实时变速。

·在使用标清视频时，制作多个实时 Adobe Premiere Pro 过渡特技，在
使用高清视频时，制作多个加速 Adobe Premiere Pro 过渡特技。

实时意味着可以无需生成就可以播放特技和把特技录制到磁带上。您可以
试验不同特技，随时改变创意，马上就可以在视频监示器上看到改变的效
果。除以上提到特技之外的 Adobe Premiere Pro 特技均不是实时的，都需
要生成。要了解如何设置实时特技，见 162 页 “Matrox Axio 实时规
则”。

安装 Matrox Axio.utils 时，Matrox 实时插件时特技就加到 Adobe 
Premiere Pro 中，可以在作品中使用。Matrox 特技设置和其它 Adobe 
Premiere Pro 特技设置方法一样。比如，想在素材上加一个 Matrox 过渡
特技，就像其它过渡特技一样，只是出现的对话框让您创建 Matrox 过渡
特技，如本章所述。

要了解如何制作 Adobe Premiere Pro 特技，请参考 《Adobe Premiere 
Pro 用户手册》。

重要：要使用 Matrox 实时插件，必须先定义符合 Matrox Axio 的 Adobe 
Premiere Pro 设置，请参考第 7章 “定义 Adobe Premiere Pro 设置”。
，设置 Adobe Premiere Pro 实时特技
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如何在 Adobe Premiere Pro 中制作 Matrox 视频特技
Adobe Premiere Pro 的 Matrox 实时插件可制作很多实时视频特技。要为
素材添加一个 Matrox 视频特技，从 Effects窗口的 Video Effects文
件夹中将需要的特技拖拉到时间线的素材上。

Matrox 视频特技默认位置是 Matrox 文件夹。

提示

·您可以应用一些预先设置好的 Matrox 特技，这些特技在 Matrox Axio 
Effect Presets文件夹下的 Presets中。

·如果您看不到 Effects窗口，选择 Window > Effects。如果您看不
到 Effect Controls窗口，选择 Window > Effect Controls。

如何在 Adobe Premiere Pro 中制作 Matrox 视频过渡特技
在 Adobe Premiere Pro 中，所有 Matrox 划像过渡特技都在 Video 
Transitions文件夹中，在 Effects面板下的 Video Transitions中。

Premiere Pro 中有很多种创建过渡特技的方法。选择适合您的方法来制作
Matrox 划像特技。要了解如果制作过渡特技，见您的 Adobe Premiere Pro
文件。
如何在 Adobe Premiere Pro 中制作 Matrox 视频特技
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自定义素材
很多 Matrox 特技可以通过修改多种自定义设置调整尺寸、位置和旋转参
数。您可以通过两种方式调整自定义设置：

·使用 Effect Controls面板中的自定义钮调节您需要的设置。

·使用鼠标直接在 Adobe Premiere Pro 的 Monitor窗口里的 Program 观看
方式下调节自定义设置。比如，点击您需要的自定义钮 （Position、
Scale、Rotation或 Rotation Center Offset），再在 Program 的
Monitor窗口中点击并拖拉调节自定义设置。您需要在 Program 
Monitor 下启动自定义控制才可以使用这种方法调节自定义设置。要了
解更多信息，见 100 页 “使用 Program 观看方式自定义素材”。

注：如果您使用 Matrox 阴影特技、遮蔽特技、遮蔽模糊特技、遮蔽马
塞克特技或是闪光特技，自定义设置只会加到阴影或是遮蔽上去，而
不会影响整段素材。

使用自定义控制
要使用 Effect Controls面板中的自定义控制调节多项自定义设置，点
击 Transform属性旁边的三角，扩展它： 

您可以在文本框里输入需要的数值或是拖动相应的滑动指针。

·Position （X， Y， Z） 使用此控制调整定义素材在 x （水平）、y
（垂直）和 z （纵向）轴上的位置。 （0，0，0）像素即素材放在屏幕
中央，其它位置从此计算。可输入正或负像素值，左右 （x）、上下
（y）和前后 （z）移动素材。

·Scale （X，Y） 使用此钮调整素材大小。全屏是 100%，可以将素材
缩成 0% 或放大成 100%。注意，素材放大后，分辨率会降低。可独立调
，设置 Adobe Premiere Pro 实时特技
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整各尺寸控制，或如果选择了 Fixed Aspect Ratio，只需要调节一
个 x轴，其它轴自动按比例改变。调节 x 和 y轴的百分比，分别改变
素材宽度和高度。

注：Matrox 表面抛光特技包括了一个 Scale Z属性，您可以用来调节
板块的厚度。要了解更多信息，见 155 页 “制作表面抛光特技”。

·Rotation （X，Y，Z） 使用这些控制设置素材旋转圈数。每 360
度在选定轴上转一圈。 您可以设置反转或正转（从 -360°到 360°）。

·Rotation Center Offset （X，Y，Z） 使用 Rotation Center 
Offset控制设置素材在 x （水平）、y （垂直）和 z （深度）上的重
心或旋转中心。设置了 Rotation后，素材以此点为中心旋转，可使用
正或负像素值在每个轴上移动素材。

下图中，请注意不同 Offset值会如何影响立方体旋转。

图 1中，Offset值为 （0，0，0），所以立方体的旋转中心是坐标原点，
图 2中，Offset的 x 坐标为 100，所以重心向右移，立方体以此为中心
旋转，弧度比图 1大。

Y

X

Z

Y

X

Z

图 1： Offset 为 0，0，0 图 2： Offset 为 100，0，0
自定义素材
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第 8 章
使用 Program 监示器自定义素材
可以使用鼠标左键在 Program 监示器里直接调整素材的大小、位置和旋转
素材。支持在 Program 监示器中自定义素材的特技在 Effects Controls
面板里的特技名左边有一个自定义图标。 

注：在制作 Matrox 四角镜框贴图特技时，Transform 图标令您可以直接
在 Program Monitor 中控制特技，而不需要按此节所述调节特技设置。

要启动 Program 监示器下的自定义控制，在 Effect Controls面板里点
击 Matrox 特技。直接控制方式钮将出现在 Program 监示器的左上方：

先点击相应钮 （Position、Scale、Rotation或 Rotation Center 
Offset）选择要调节的自定义设置。Precision Mode只在 Program 监示
器里可用，令您可以精确调节当前的自定义设置。

下表显示使用 Program 监示器时，可用的鼠标控制。

比如，如果只想在 y 轴上调整素材位置，先点击 Position钮再按住 SHIFT

同时在 Program 监示器上下拖动鼠标。

操作 效果

鼠标左键 调节 x 和 y 轴

SHIFT+ 鼠标左键，左或右拖动 只调节 x 轴

SHIFT+ 鼠标左键，上或下拖动 只调节 y 轴

CTRL+ 鼠标左键，上或下拖动 只调节 z 轴

自定义图标

位置
尺寸

旋转
旋转中心

精确方式
 

，设置 Adobe Premiere Pro 实时特技
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裁剪素材
很多 Matrox 特技允许您对特技进行裁剪。要应用裁剪设置，点击 Crop旁
边的三角，扩展属性清单：

Crop下的控制钮可以裁剪素材的任意边缘。您可以输入您想要裁剪的数
值，或是拖拉相应的滑动指针 （Left、Right、Top、Bottom）裁剪素
材。

·Crop Left 裁剪素材的左边缘。

·Crop Right 裁剪素材的右边缘。

·Crop Top 裁剪素材的上边缘。

·Crop Bottom 裁剪素材的下边缘。

·Select Crop 显示一个对话框，您可以在里面调整裁剪设置。要了
解详情，见 102 页 “使用选择性裁剪”。

·Stretch to original size 选择此项，令裁剪后的素材拉伸成原
来素材的尺寸。

注：如果您使用的 Matrox 特技没有提供 Crop属性，您可以使用 Adobe 
Premiere Pro 的裁剪特技实时裁剪素材 （在 Transform文件夹下
Video Effects文件夹里）。除非您启用了 Zoom选项，Premiere Pro
的裁剪特技会一直保持实时。要了解使用 Premiere Pro 裁剪特技的详
情，见 Adobe Premiere Pro 文件。
裁剪素材
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使用选择性裁剪 
要使用 Select Crop修改素材的裁剪设置，点击 Select属性旁边的三
角，扩展它，再选择 Select Crop钮：

Select Crop对话框允许您以两种方式裁剪素材：

·在 Select Crop窗口里点击并拖拉鼠标以创建一个矩形的裁剪区域。

要改变矩形区域的尺寸，拖动矩形的任意边。比如，拖动右边缘调整
矩形的右边缘。要一次调整整个矩形，拖动矩形的一个角 （它的对角
将固定不动）。

·使用 Left、Right、Top和 Bottom控制，按指定的像素数裁剪任何边
缘。您可以在文本框里输入数值，或是拖动滑动指针调整裁剪区域。
比如，拖动 Left滑动指针裁剪素材的左边缘。
，设置 Adobe Premiere Pro 实时特技
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给特技添加一个遮蔽
很多 Matrox 特技允许您添加一下遮蔽，以定义一个要加特技的区域。比
如，您只想给画面上某个部分加上一个色彩校正特技，而其它部分保持原
状。 

在亮度或是色度键特技上加一个遮蔽并选择 Transparent Outside Mask
令您可以将特技只加在遮蔽的部分，只有下面一层的画面显示在键以外的
区域。比如，您可以定义一个您需要加键的部分，而且键以外的部分为下
面一层的画面。这个功能在您无法抠像前景画面边缘时很有用。

要调节遮蔽属性： 

点击 Mask旁边的三角，扩展属性清单。 

Mask下的属性令您可以控制需要加遮蔽的区域。您可以在文本框里输入
数值或是拖动相应的滑动指针 （Left、Right、Top和 Bottom）。

·Left 调节遮蔽的左边缘。

·Right 调节遮蔽的右边缘。

·Top 调节遮蔽的上边缘。

·Bottom 调节遮蔽的下边缘。

·Select Mask 显示一下对话框，您可以在里面调整遮蔽设置。要了
解详情，见 104 页 “使用选择性遮蔽”。

·Invert 反转遮蔽，将特技加在遮蔽以外的区域，而不是以内的区
域。
给特技添加一个遮蔽
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使用选择性遮蔽
要使用 Select Mask对话框给 Matrox 特技加一个遮蔽，点击 Select属
性旁边的三角，扩展它，再点击 Select Mask钮：

Select Mask对话框允许您以两种方式调整遮蔽：

·在 Select Mask 窗口里点击并拖拉鼠标以创建一个矩形的遮蔽区域。

在改变矩形区域的尺寸，拖动矩形的任意边。比如，拖动右边缘调整
矩形的右边缘。要一次调整整个矩形，拖动矩形的一个角 （它的对角
将固定不动）。

·使用 Left、Right、Top和 Bottom控制，按指定的像素数调节遮蔽的
任何边缘。您可以在文本框里输入数值，或是拖动滑动指针调整遮蔽
区域。比如，拖动 Left滑动指针调整遮蔽的左边缘。
，设置 Adobe Premiere Pro 实时特技



105
制作色彩校正特技
色彩校正对于所有制作来说都非常重要，无论是要令各镜头之间色调保持
一致、保证符合广播安全电平或是加强画面效果都要使用这个特技。
Matrox 色彩校正提供基本 proc amp 控制、包括总体亮度、阴影、中间亮
度或是高光控制的色彩校正、还有高光控制及输入输出电平控制。您可以
轻而易举地按照基准镜头匹配颜色。要了解更多关于颜色匹配的详情，见
108 页 “自动平衡和匹配素材颜色”。

提示：Adobe Premiere Pro 包括了一个操作空间设置，专为处理素材和特
技优化设计，令色彩校正更加方便快捷。要使用适合色彩校正特技的操作
空间，选择 Window > Workspace > Color Correction。

要设置 Matrox 色彩校正特技：

点击 Matrox Color Correction旁边的三角，扩展属性清单。

·Proc Amps 处理放大器 （proc amp）控制可以调节素材不同参数：

- Hue 调节图像的色调。

- Saturation 调节图像颜色饱和 （鲜艳）度。

- Contrast 调节图像中最亮与最暗部分之间的差别。

- Brightness 调节图像的黑电平。

·Color Balance 可以调节素材中各种颜色的混合。

- Graphical 允许您在调节颜色平衡时通过图形看到画面的变化。
您还可以在图中调节大多数颜色平衡设置。要了解更多详情，见
107 页 “使用颜色平衡图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节颜色平衡设置。您可以调节每种亮度范围的 Hue、
Saturation和 Luminance。
制作色彩校正特技
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• Master （Hue、Saturation和 Luminance） 影响素材从最亮
的白色到最暗的黑色的所有区域。

• Shadows （Hue、Saturation和 Luminance） 只影响素材最
暗的部分。

• Midtones （Hue、Saturation和 Luminance） 只影响素材最
暗与最亮之间的部分。

• Highlights （Hue、Saturation和 Luminance） 只影响素材
最亮的部分。

·Luma Mapping

- Graphical 允许您在调节亮度映射设置时通过图形看到画面的变
化。您还可以在图中直接调节素材亮度。要了解更多详情，见 111
页 “使用亮度映射图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节亮度映射设置。

• Input Levels （Black和 White）  通过改变对应黑、白或灰
的亮度值精确调节素材亮度和对比度。这样做同时扩展或压缩素
材的亮度电平，即增加或减少素材的颜色范围。

比如，增加黑电平值，素材的黑色部分就设置为一个更高的亮度
值，亮度范围按比例压缩了，画面变得更黑。

• Output Levels （Black 和 White） 可以将 Input Levels的
值映射到任何黑和白电平上。您可以降低素材的对比度，或是通
过将黑值设得比白值高反转素材亮度。

• Gamma 使用此控制调节素材的中间亮度部分，无需调节黑或白
电平。

·Mask  可以在特技上加一个遮蔽。要了解详情，见 103 页 “给素材
添加一个遮蔽”。
，设置 Adobe Premiere Pro 实时特技
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使用颜色平衡图
可在颜色图中直接修改每种亮度范围的 Color Balance设置。您还可以
使用颜色图旁边的颜色吸管和参考颜色进行自动平衡或是颜色平衡处理。
要了解详情，见 108 页 “自动平衡和匹配素材颜色”。视您使用的颜色不
同，您可以总体调节素材颜色，或是只调节阴影、中间亮度或高光范围内
的素材颜色。

您可以拖动在任何颜色图中心的点，调节某个特定亮度范围的颜色平衡
（Hue和 Saturation）。比如，要总体调节素材的颜色平衡，使用
Master颜色图，或是使用 Shadow颜色图只调节阴影部分的颜色平衡。
向您需要的颜色拖动十字叉丝，或是远离不需要的颜色。比如，如果您将
叉丝向红色移动，您同时减少同样的青色。如下图所示：

1 颜色图 2 参考颜色 3 匹配颜色 4 颜色平衡复位钮

1

2 3 4

MAGENTARED

YELLOW BLUE

CYANGREEN
制作色彩校正特技



108

第 8 章
如果您想将颜色平衡 （Hue和 Saturation）恢复为默认设置，点击您正
在使用的颜色图的恢复颜色平衡默认设置钮。

自动平衡和匹配素材颜色
您可以使用每个颜色图下面的参考颜色和匹配颜色钮进行自动平衡和颜色
匹配。 

1 参考颜色 2 匹配颜色

颜色平衡复位

1 2
，设置 Adobe Premiere Pro 实时特技
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点击颜色选择钮或是颜色吸管，选择您的参考颜色和匹配颜色。

吸管有两种使用方法：

- 点击颜色吸管，再在素材上点击需要的颜色。

- 点击颜色吸管，再在素材点击并拖拉鼠标，创建一个包含您需要的
颜色的矩形区域。选择的颜色值为这个区域所有像素的平均值。

自动平衡
在匹配颜色之前，您可以在目标素材上加一个自动平衡，令颜色自动向您
的素材偏移，以补偿不同灯光环境带来的区别。

要添加自动平衡：

1 确保您需要调整的颜色图 （Master、Shadows、Midtones或
Highlights）的参考颜色值设在默认设置上。要将参考颜色设置为默
认值，点击参考颜色复位钮。

2 使用在相应颜色图下的颜色匹配吸管选择您素材中需要修改颜色的部
分。 

比如，要调整素材的高光部分，点击 Highlights颜色图下的颜色匹
配吸管，再点击 （或点击拖拉）您素材最亮的部分。自动平衡马上完
成。

颜色吸管颜色吸管钮

参考颜色复位钮

颜色匹配吸管
制作色彩校正特技
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匹配两段素材
您可以加一个颜色匹配特技，匹配两段素材的颜色 （如肤色、天空等）。
颜色匹配功能令您可以从参考素材里选择一种颜色，令目标素材与这个颜
色匹配。您可以调整素材的总体颜色 （Master），或是只调整 Shadows、
Midtones或 Highlights。

要进行颜色匹配：

1 选择 Window > Workspace > Color Correction，为色彩校正准备
好工作空间。

2 在目标素材 （含有需要校正的颜色的素材）上制作 Matrox Color 
Correction特技。

3 使用参考监示器里的控制钮移动参考素材，找到包含您需要匹配的颜
色的帧中。

4 使用Program监示器里的控制钮移动目标素材，找到素材中需要匹配颜
色的帧。

5 在您需要调整的亮度图 （Master、Shadows、Midtones或
Highlights）下，使用参考颜色吸管从参考素材中选择一个颜色。 

比如，要令目标素材与参考素材中的一个非常暗的颜色匹配，点击
Shadows颜色图下的参考颜色吸管，再点击 （或是点击拖拉）参考素
材上需要的颜色。

6 在目标素材相应的颜色图 （Master、Shadows、Midtones或
Highlights）下，使用匹配颜色吸管从目标素材上选择一个匹配颜
色。

参考颜色吸管

匹配颜色吸管
，设置 Adobe Premiere Pro 实时特技
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使用亮度映射图
要在图中直接调整亮度映射值，点击 Luma Mapping Graphical属性旁
边的三角，扩展它：

·Map 这是您首次扩展 Graphical属性时默认出现的图。您可以在图
中拖动鼠标调节黑和白电平的 Input 和 Output电平，还可调节
Gamma。

1 输入 
黑电平

2 输入
白电平

3 输出
黑电平

4 输出
白电平

5 Gamma

1
2

3

4

5

制作色彩校正特技
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·Plot 点击此钮，以柱状图显示当前帧的亮度 （柱状图将显示您所做
的任何色彩校正变化）。每种亮度值表示为一条垂直线。长一点的线表
示此亮度值的像素多一些。您可以拖动图的边缘调节黑和白电平的
Input和 Output及 Gamma值。

·Auto Black 点击此钮将画面最暗的像素定义为黑。中间的亮度值
按比例分配。

·Auto White 点击此钮将画面最亮的像素定义为白。中间的亮度值按
比例分配。

注：任何时候如果您需要将亮度值恢复为默认设置，点击复位钮。

1 输入 
黑电平

2 输入
白电平

3 输出
黑电平

4 输出
白电平

5 Gamma

1 2

3

4

5

复位钮
，设置 Adobe Premiere Pro 实时特技
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制作局部色彩校正特技
局部色彩校正提供 Matrox 色彩校正特技的所有属性，它可以使用某些键
属性只将特技加在某个范围内的像素上。比如，局部色彩校正特技可以用
于如改变图像上一条裙子的颜色、加深背景天空的颜色或是画面上只有一
个物体或是人是彩色的，其它部分都是黑白的效果。要了解如果将一种颜
色分离出来，令画面的其它部分都是黑白的，见 122 页 “制作颜色分离特
技”。

提示：Adobe Premiere Pro 包括了一个操作空间设置，专为处理素材和特
技优化设计，令色彩校正更多方便快捷。要使用适合色彩校正的操作空
间，选择 Window > Workspace > Color Correction。

要设置 Matrox 局部色彩校正特技：

点击 Matrox Secondary Color Correction 旁边的三角，扩展属性清

单。

·Proc Amps 处理放大器 （proc amp）控制可以调节素材不同参数：

- Hue 调节图像的色调。

- Saturation 调节图像颜色饱和 （鲜艳）度。

- Contrast 调节图像中最亮与最暗部分之间的差别。

- Brightness 调节图像的黑电平。

·Color Balance 可以调节素材中各种颜色的混合。
制作局部色彩校正特技
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- Graphical 允许您在调节颜色平衡时通过图形看到画面的变化。
您还可以在图中调节大多数颜色平衡设置。要了解更多详情，见
107 页 “使用颜色平衡图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节颜色平衡设置。您可以调节每种亮度范围的 Hue、
Saturation和 Luminance。

• Master （Hue、Saturation和 Luminance） 影响素材从最亮
的白色到最暗的黑色的所有区域。

• Shadows （Hue、Saturation和 Luminance） 只影响素材最
暗的部分。

• Midtones （Hue、Saturation和 Luminance） 只影响素材最
暗与最亮之间的部分。

• Highlights （Hue、Saturation和 Luminance） 只影响素材
最亮的部分。

·Luma Mapping

- Graphical 允许您在调节亮度映射设置时通过图形看到画面的变
化。您还可以在图中直接调节素材调节亮度映射设置。要了解更多
详情，见 111 页 “使用亮度映射图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节颜色平衡设置。

• Input Levels （Black和 White）  通过改变对应黑、白或灰
的亮度值精确调节素材亮度和对比度。这样做同时扩展或压缩素
材的亮度电平范围。

比如，增加黑电平的值，素材的黑色部分就设置为一个更高的亮
度值，亮度范围被压缩了，图像按比例变暗。

• Output Levels （Black 和 White） 可以将 Input Levels的
值映射到任何黑和白电平上。您可以降低素材的对比度，或是通
过将黑值设得比白值高反转素材亮度的效果。

• Gamma 使用此控制调节素材的中间亮度部分，无需调节黑或白
电平。
，设置 Adobe Premiere Pro 实时特技
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·Mask  可以在素材上加一个遮蔽。要了解详情，见 103 页 “给素材
添加一个遮蔽”。

·Selective Key 选择键令您可以将色彩校正特技只加到某个范围内
的像素上。选择键跟色键或是亮度键相似，但使用选择键，您可以在
加键的部分制作色彩校正，而不是加在透明的部分上。比如，如果您
使用选择键属性选择红色为 Hue颜色，色彩校正就只加到画面上红色
的部分。您可以单独启用每个键 （Hue、Saturation和 Luma）或是
同时启用三种控制，以达到需要的效果。

- Graphical 允许您在调节选择键 Numerical 设置时通过图形看到
画面的变化。您还可以在图中直接调节素材设置，加一个自动键。
要了解更多详情，见 118 页 “使用选择键图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节键设置。

• Hue Key  此类型的键可以按色调选择需要加键（加色彩校正特
技）的区域。

- Enable 选择此键启用选择性键图中的 Hue Key 属性和色调键
指示器。

- Hue 用此键延颜色频谱图的边缘旋转指示器，以选择需要加键
的颜色。

- Aperture 使用此键加宽或是缩窄指示器的节距，以增加或是
减少您需要加键的颜色的范围。

- Softness 设置在节距区域里定义的颜色的柔度。

• Saturation Key 此类型的键可以按色饱和度选择需要加键
（加色彩校正特技）的区域。淡颜色色饱和度低，鲜艳的颜色色
饱和度高。

- Enable 选择此控制启用选择性键图中的 Saturation Key
属性和色调键指示器。

- Low Clip 使用此控制选择给低饱和度的部分加键。 

- Low Gain 使用此控制，按您在 Low Clip控制中设置的值决

定您需要部分影响的色饱和度值。增加 Low Gain设置，更多

像素将部分受到色彩校正特技影响。如果您降低 Low Gain控

制，较少像素部分受影响。

Low Gain设置为 100 提供最宽范围的色彩校正。相反，设置为

0表明画面的色饱和度要么完全受影响，要么完全不受影响。

您可以将 Low Gain控制理解为对画面淡颜色的区域 “从完全

受影响到完全不受影响”的受影响程度的指标。
制作局部色彩校正特技
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- High Gain 此控制与 Low Gain相似，区别只是在于您使用此
控制，按在 High Clip控制中设置的值决定您需要部分影响的
色饱和度值。增加 High Gain设置，更少像素将部分受到色彩
校正特技影响。如果您降低 High Gain控制，较多像素部分受
影响。您可以将 High Gain控制理解为对画面淡颜色的区域
“从完全不受影响到完全受影响”的受影响程度的指标。

- High Clip 此控制与 Low Clip相似，只是使用此控制选择给
较高饱和度的区域加键。

注：您使用 Low Clip 和 Low Gain控制设置的值视您的

High Clip 和 High Gain控制而定，反之亦然。这将防止高

和低控制都在同一样的值上加键。

• Luma Key 此类型的键可以按亮度选择需要加键 （加色彩校正特

技）的区域。

- Enable 选择此控制启用选择亮度键图中的 Luma Key 属性和
亮度键指示器。

- Low Clip 使用此控制选择较暗的像素加键。Low Clip设置
为 0时表示黑，255 表示白。中间的值代表不同程度的灰，从
很暗到很亮的灰。

- Low Gain 使用此控制，按您在 Low Clip控制中设置的值决
定您需要部分影响的亮度值。增加 Low Gain设置，更多亮度
值的像素将部分受到色彩校正特技影响。

- Low Gain设置为 100 提供最宽范围的色彩校正。相反，设置为
0表明画面的色饱和度要么完全受影响，要么完全不受影响。
您可以将 Low Gain控制理解为对画面的暗的部分 “从完全受
影响到完全不受影响”的受影响程度的指标。
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- High Gain 此控制与 Low Gain相似，区别只是在于您使用此
控制，按在 High Clip控制中设置的值决定您需要部分影响的
亮度值。您可以将 High Gain控制理解为对画面较亮的区域
“从完全不受影响到完全受影响”的受影响程度的指标。

- High Clip 此控制与 Low Clip相似，不同之处在于您使用此
键选择较明亮的像素加键。

注：您可以使用 Low Clip和 Low Gain控制选择的值视 High 
Clip 和 High Gain控制而定，反之亦然。 这可以防止低和高控
制钮都在同一亮度的像素上加键。

• Invert Key 选择此控制反转键选择，令您得到与原来选择完全
相反的效果 

• Show Key as Output 选择此控制显示用于定义您的选择键区域
的遮蔽。这可以进一步精确调整键。完全受到色彩校正特技影响
的部分是白色的，完全不受影响的部分为黑色，部分受影响的部
分是灰色。

• Expand Outside Mask 在遮蔽区域外的部分加色彩校正。这在
您需要加颜色保留特技，画面上有几处是同一种颜色，但您只想
保留其中一处的颜色的时候很有用。要了解更多详情，见 122 页
“制作颜色分离特技”。
制作局部色彩校正特技
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使用选择键图
选择键图允许您可以直接在图中修改您的选择键设置 （Hue Key、
Saturation Key和 Luma Key）。您还可以制作一个自动键。

·Map 这是您首次扩展图属性时出现的默认界面。您可以拖动控制，将
指针移动到图上的不同区域，以调节 Hue Key、Saturation Key和
Luma Key设置。

要看到指示器和控制，您需要启动您要使用的键设置。比如，如果您
需要调节 Hue Key属性，您需要点击选择键图中的 Hue钮，或是选择
Hue Key数字属性中的 Enable选项。在以下图中，Hue属性被启用
了。

·Plot 点击此钮观看您的素材的当前帧的亮度和色度分部图。您可以
拖动控制钮将指示器移动到图中的不同区域，以调节 Hue Key、
Saturation Key和 Luma Key属性。亮度柱状图以柱显示每种亮度值
下的像素数。长一点的线表示有更多的像素有此亮度值。
，设置 Adobe Premiere Pro 实时特技
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·Hue 点击此钮启用或是禁用 Hue Key属性 （Hue、Aperture和
Softness）。当启用此控制时，您将可以看到 Hue Key指示器和控制
钮，可以在选择键图里调整 Hue Key属性。

1 色调 2 节距 3 柔度

1

2

3

2

3

制作局部色彩校正特技
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·Sat 点击此钮启用或是禁用 Saturation Key属性 （Low Clip、
Low Gain、High Gain和 High Clip）。当启用此控制时，您将可以
看到 Sat Key指示器和控制钮，可以在选择键图里调整 Saturation 
Key属性。

·Lum 点击此钮启用或是禁用 Luma Key属性 （Low Clip、Low 
Gain、High Gain和 High Clip）。当启用此控制时，您将可以看到
Luma Key指示器和控制钮，可以在选择键图里调整属性。

提示：对于 Saturation Key和 Luma Key属性，您可以按住 SHIFT 的
同时拖动控制，在选择键同时锁定所有控制钮并一起移动它们。如果您

1 低亮度素材 2 低增益 3 高亮度素材 4 高增益

1 低亮度素材 2 低增益 3 高亮度素材 4 高增益

1 2 3 4

1

2 3

4

，设置 Adobe Premiere Pro 实时特技
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按 CTRL，您可以同时锁定 Low Clip和 Low Gain控制或 High Gain和
High Clip控制。 

注：任何时候您需要将色调、色饱和度和亮度键属性恢复为默认值，点
击相应的复位钮。

·Show Key 点击此钮显示用于定义您的选择键区域的遮蔽。这可以进
一步精确调整键。完全受到色彩校正特技影响的部分是白色的，完全
不受影响的部分为黑色，部分受影响的部分是灰色。

·Auto Key 点击此钮自动给当前帧最常用的颜色加键 （灰色除外）。选
择 Auto Key影响 Hue Key、Saturation Key和 Luma key的属性。
同样，您可以使用吸管选择您需要加键的颜色。吸管有两种使用方法：

- 点击吸管钮，再点击您需要加键的颜色。

- 点击吸管钮，再在素材上包含了需要加键的颜色的部分拖拉鼠标，
创建一个矩形区域。选定的颜色将是这个矩形区域里的像素的平均
颜色。

·Indicator 点击此钮显示或隐藏指示线。

·Handles 点击此钮显示或隐藏指示线控制。

色饱和度键

复位钮
制作局部色彩校正特技
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制作颜色分离特技
您可以使用 Matrox 局部色彩校正特技制作颜色分离特技，只保留画面里
的一个颜色，其它部分变成黑白的。这个特技在您想突出画面某一颜色时
非常有用。

以下加了颜色分离特技的例子中，小女孩的衣服的粉红色被保留下来，画
面其它部分转换成黑白的：

要制作颜色匹配特技：

1 在选择键图中点击 Auto Key 吸管，在素材中任意位置拖动鼠标，选中
一个包含想保留的颜色的矩形框。

2 在 Proc Amps下，将 Saturation设置为 0。

3 选择 Invert Key。

如果您画面上有几处有同样的颜色，但您只想保留一处的颜色，您可以使
用 Expand Outside Mask选项，在包含您需要保留的颜色的部分加一个
遮蔽。比如，如果您的画面上有两朵玫瑰花，都是一样的红色，而您只想
保留其中一朵的颜色，您可以这样做：

要使用 Expand Outside Mask 选项加一个颜色分离特技：

1 在选择键图中点击 auto key 吸管，在素材中任意位置拖动鼠标，选中
一个包含想保留的颜色的矩形框。

2 在 Proc Amps下，将 Saturation设置为 0。

3 选择 Invert Key。

4 在您需要保留颜色的部分加一个遮蔽 （见 103 页 “给素材添加一个
遮蔽”）。

5 选择 Expand Outside Mask。

衣服的粉红色被保留下
来了，其它部分变成黑
白的
，设置 Adobe Premiere Pro 实时特技
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制作 Matrox 3D DVE 特技
Matrox 3D DVE 令您可以将素材实时摆放在三维空间的任意位置，同时可
以加一个柔边和带颜色渐变的圆边。

要设置 Matrox 3D DVE 特技：

点击 Matrox 3D DVE旁边的三角，扩展属性清单。

·Transform 使用此控制添加多种自定义设置，如位置、尺寸和旋转。
要了解更多信息，见 98 页 “自定义素材”。

·Border Settings 可以给素材加一个边框或是柔边。

- Border Outside Softness 可以调整素材边缘的柔度或是外部的
边框。柔度越高，边缘越柔和。

- Border Type 选择您需要的边框类型 （None、Flat、Gradient
或 Alpha Edge）。点击右边的三角，扩展边框类型清单。

注：Alpha Edge边框类型仅用于有 alpha 键的图文。

- Border Width 设置边框的宽度，值越高边框越宽。

点击此处选择
边框类型
制作 Matrox 3D DVE 特技
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- Border Inside Softness 设置边框内边缘的柔度。柔度越高，边
缘越柔和。

- Border Outside Color 使用颜色选择器或是吸管选择您需要的边
框颜色，如果您选择了 Gradient作为边框类型，这个钮控制边框
的外边缘的颜色。

- Border Outside Transparency 设置边框的透明度，如果您选择
了 Gradient作为边框类型，这个钮控制边框的透明度。值的范围
为不透明 （0）到全透明 （100）。

注：以下两种属性 （Border Inside Color 和 Border Inside 
Transparency）只在您选择了 Gradient作为边框类型时才可用。

- Border Inside Color 使用颜色选择器或吸管设置内边框的颜
色，边框的颜色将从内到外渐变。

- Border Inside Transparency 设置边框内部的颜色的透明度。

- Round Corner Size 令边框的角成为圆角。

- Corner Point Offset 可以移动边框的顶点，这样您可以创建不
同形状的 3D DVE。负值令顶点向素材的中心移动，正值向远离中心
的方向移动。

·Crop 裁剪素材的边缘，要了解详情，见 101 页 “裁剪特技”。
，设置 Adobe Premiere Pro 实时特技
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制作四角镜框贴图特技
Matrox 四角镜框贴图特技可以将一个视频或是图文的几个点固定在下面
一层的素材上，即使下层的素材变形也没有关系。您可以使用这个特技将
一段素材放在另一个画面里的电视机屏幕上播放。

要设置 Matrox 四角镜框贴图特技：

点击 Matrox 4-corner Pin 旁边的三角，扩展属性清单。

·Top Left 和 Top Right Corner 使用些控制水平和垂直移动素材的
左上角和右上角的点。

·Bottom Left和 Bottom Right Corner 使用些控制水平和垂直移动
素材的左下角和右下角的点。

提示：您可以方便地将素材的每个顶点直接放在 Program 监示器中。
步骤如下：点击 Effect Controls面板里 Matrox 4-corner Pin 旁
边的 Transform钮 （ ） 。Program 监示器里素材的每个顶点上
的都出现一个光标。拖动这些光标调整素材的位置。

·Edge Softness 可以给素材加柔边。

·Crop 裁剪素材的边缘，要了解详情，见 101 页 “裁剪特技”。

·Preview Settings 有以下选项可以预览特技：

- Show Cursors 只在视频监示器上显示，素材的每个角显示为一个
钻石形状的光标。这些光标可以帮助您精确地确定每个顶点的位
置。每个顶点的颜色不同：

• 左上角：红色

• 右上角：绿色

• 左下角：蓝色

• 右下角：橙色

- Show Color Frame Only 显示一个半透明的形状，代表需要加四
角镜框贴图特技的素材。这在制作加了 alpha 键的图文时很有用，
您需要看到素材的边缘。

- Color 要更换显示颜色，使用颜色选择钮或是吸管。
制作四角镜框贴图特技
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提示：Show Color Frame Only选项是用来辅助制作四角镜框贴
图特技的。但是您可以用它制作一个独特的灯光特技，如制作聚光
灯效果。
，设置 Adobe Premiere Pro 实时特技
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制作模糊 / 软聚焦特技

制作模糊 /软聚焦特技
Matrox 模糊软聚焦特技让您创作独特的特技或模仿照相机散焦效果。

要设置 Matrox 模糊 /软聚焦特技：

点击 Matrox Blur/Soft Focus旁边的三角，扩展属性清单。 

·Blur Amount 使用此控制改变素材的模糊程度。

·Source Blend Factor 使用此控制将原图像叠加在加了模糊特技的
素材上。设为 0值是只显示加了模糊特技的效果，设置为 100 只显示
原图像效果。任何中间值显示两种效果的混合效果，即软聚焦效果。

·Lock Colors 选择此选项按比例增加或是减少红、绿和蓝色的增益。
比如，您在 Red Color Gain上做的任何调节都将用于绿色和蓝色的
增益。

·Red Color Gain 增加或减少图像中的红色。

·Green Color Gain 增加或减少图像中的绿色。

·Blue Color Gain 增加或减少图像中的蓝色。

·Crop 裁剪素材的边缘，要了解详情，见 101 页 “裁剪特技”。

注：如果您使用的是高清素材，视您的设置不同，模糊 /软聚焦特技
有可能需要生成。
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色键特技
您可以使用 Matrox 实时插件制作色键或色键阴影特技，令前景视频的某
些部分变得透明，可以看到背景素材。

在以下色键特技例子中，前景图片是一个女人坐在绿幕前的素材，背景是

一段沙丘素材：

使用色键抠掉前景图像的绿幕，绿幕部分变成透明，相应的背景部分就透
过来了，合成画面如下：

重要：色键阴影特技可以在特技里精确调整阴影。如果您给素材只加色键
特技，没有其它特技时，最好使用色键阴影特技。但如果您还要在加了色
键特技的素材上加其它特技，使用不含阴影控制的色键特技效果会比较
好。比如，如果您想给色键特技再加一个 DVE，您应该使用色键特技，而
不是色键阴影特技。

前景图像 背景图像

+

色键处理过的画面

=

，设置 Adobe Premiere Pro 实时特技
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制作色键或是色键阴影特技
要设置 Matrox 色键或色键阴影特技，点击 Matrox Chroma Key/Matrox 
Chroma Key Shadow旁边的三角扩展属性清单：

·Graphical 使用图来控制色键，还可制作自动键。

- Map 可选择包含颜色频谱的方块中的键颜色。

- Plot 显示素材中的颜色柱状图，选择您需要加键的颜色。

- Show Key 点击此钮显示用于创建键特技的遮片。此钮令您可以进
一步调节键。比如，当您显示遮片时，您的键颜色 （如绿色）显示
为黑色，不透明的部分显示为白色。如果您注意到一些您需要加键
的白色点，您可以调节键控制，直到白色点消失为止。

- Auto Key 点击此钮自动给当前帧最常用的颜色（除了灰色外）加
键。

要了解如何在图形中选择键颜色或是制作自动键，见 132 页 “使用
色键图修改键颜色并制作自动键”。
制作色键或是色键阴影特技
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注：您必须扩展 Graphical 属性，在调整色键控制时才可以看到指
示器。

·Hue 用此键沿颜色频谱图的边缘旋转指示器，以选择需要加键的颜

色。

·Aperture 使用此键加宽或是缩窄指示器的节距，以增加或是减少您

需要加键的颜色范围。

·Saturation 使用此控制选择有某个特定色饱和度值的颜色。淡颜色

的色饱和度较低，靠近频谱图的中心，鲜艳的颜色的色饱和度较高，

离频谱图中心较远。因为淡颜色的色饱和度低，比起鲜艳的颜色来说，

更难抠像一些。

·Saturation Threshold 使用此控制按比例增加或是减少饱和度范围

外的区域，控制与 Saturation值多接近的像素将被抠掉。

比如，给前景图像加了一个色键特技，而前景图像中有些暗的部分您
需要保留，这些区域在加了键以后有可能变成半透明的。通过调节
Saturation Threshold，您可以消除这些暗区域的键颜色，令它们变
成完全不透明。

·Softness 通过混合前景与背景的图像软化键的边缘。这令前景图像

部分透明，而不是完全透明或不透明。

·Spill Removal 使用此控制去掉前景抠像周围的残色。这些残色通

常是由于纯色背景通过灯光反射到前景人物上造成的。Spill 

Removal将有残色的部分的键颜色替换为频谱图相反的颜色，令此区

域的颜色恢复自然。

·Chroma Suppression 使用此控制去掉抠像颜色再在前景画面上的颜

色。比如，如果抠像的颜色是纯绿色，前景有一个人，人的皮肤有可

能被染成绿色。您可以调节 Chroma Suppression使用频谱里相反的

颜色来去掉绿色，令肤色达到自然颜色。

注：以下属性 （Luminance和 Shadow Suppression）只有色键阴影
特技里有。

·Luminance 使用此控制调节阴影的亮度。负值增加阴影的亮度，正值

减少阴影的亮度。

·Shadow Suppression 使用此控制令素材的阴影不明显。值越高，阴

影越不明显。

·Mask 可以在特技上加一个遮蔽。要了解详情，见 103 页 “给素材添

加一个遮蔽”。
，设置 Adobe Premiere Pro 实时特技
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·Transparent Outside Mask 选择此选项给遮蔽外的区域加一个透

明度。您可以定义一个遮蔽区域，在此区域加键，遮蔽区域外显示下

一层的图像。要了解详情，见 103 页 “给素材添加一个遮蔽”。

·Invert Key 选择此控制反转键选择，令您得到与原来的键相反的效

果。

·Show Key as Output 选择此控制显示用于创建键特技的遮片。令您

可以进一步精确调节您的键。比如，当您显示遮蔽时，您的键颜色

（如绿色）显示为黑色，不透明的部分显示为白色。如果您注意到一些

您需要加键的白色点，您可以调节键控制，直到白色点消失为止。
制作色键或是色键阴影特技
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使用色键图修改键颜色并制作自动键
要直接在色键图上修改您的键颜色或是制作一个自动键，点击 Graphical 
属性旁边的三角，扩展它：

·Map 当您首次扩展 Graphical属性时，这是默认显示。您可以拖动
颜色频谱图上的控制，将显示器拖动到方式块里的不同部分，调节
Hue、 Aperture、Saturation和 Saturation Threshold。

注：只在您创建色键阴影特技时，此图才会包括亮度频谱图。您可以拖动
亮度频谱图里的控制调节 Luminance。

·Plot 点击此钮，以图形显示当前帧的亮度和色度柱状图。您可以拖
动色度柱状图的控制，将指示器移动到不同区域，以调节 Hue、
Aperture、 Saturation和 Saturation Threshold。每种亮度值表
示为一条垂直线。长一点的线表示此亮度值的像素多一些。

3 2 1

4

4

5

1 色调 2 色饱和度 3 色饱和度
门限

4 节距 5 亮度
，设置 Adobe Premiere Pro 实时特技
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注：只有您在创建一个色键阴影特技时 Plot图才有亮度柱状图。您可
以在这个图中拖拉控制，调节 Luminance。

·Show Key 点击此钮显示用于创建键特技的遮片。此钮令您可以进一
步调节键。比如，当您显示遮片时，您的键颜色 （如绿色）显示为黑
色，不透明的部分显示为白色。如果您注意到一些您需要加键的白色
点，您可以调节键控制，直到白色点消失为止。

·Auto Key 点击此钮自动给当前帧最常用的颜色 （除了灰色外）加
键。选择 Auto Key影响 Hue、Aperture、Saturation和
Saturation Threshold。如果您的素材键的颜色很均匀，使用 Auto 
Key会得到效果很好的色键。反之，您可以使用吸管选择您需要的颜
色。

您有两种方法使用吸管：

- 点击吸管钮，并点击您需要加键的颜色。

- 点击吸管钮，在素材上包含您要选择的颜色的部分点击并拖拉鼠
标，创建一个矩形区域。

4

4

1

2

3

5

1 色调 2 色饱和度 3 色饱和度
门限

4 节距 5 亮度

吸管
制作色键或是色键阴影特技
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·Indicator 点击此钮显示或隐藏指示器。

·Handles 点击此钮显示或隐藏指示器控制。
，设置 Adobe Premiere Pro 实时特技
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亮度键特技
您可以使用 Matrox 实时插件制作亮度键，令前景视频按图像的亮度将某
个部分变得透明，可以看到背景素材。

在以下亮度键特技例子中，两段素材合成在一起，制作出两个牛仔穿过大

火的效果。我们的前景素材是一个火环，背景是黑色的，背景素材是两个
骑着马的牛仔：

使用亮度抠像去掉前景图像黑色部分的某一亮度，这部分变成透明，相应
的背景部分就透过来了，合成画面如下：

前景素材 背景素材

+

亮度键处理过的画面

=

亮度键特技
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制作亮度键特技
要设置 Matrox 亮度键特技，点击 Matrox Luma Key旁边的三角扩展属性
清单：

·Graphical 允许您在调节属性设置时通过图形看到画面的变化。您可
以直接在图上调整亮度键，选择您需要加键的亮度。要了解更多信息，
见 137 页 “使用亮度键图”。

·Transparency 使用此控制设置键特技的透明度。高一点的值表示透
明度高一些。比如，Transparency 为 100 表明前景加键的部分的完
全透明，下一层画面可见。

·Low Clip 使用此控制选择较低的亮度加键。Low Clip设置为 0表
示黑，设置为 255 表示白。中间的设置为不同程度的灰，从很暗到很
亮的灰。

·Low Gain 使用此控制，按您在 Low Clip控制中设置的值决定您需
要部分影响的亮度值。增加 Low Gain设置，更多亮度值的像素将变得
部分透明，以制作一个边缘柔和的键。

Low Gain设置为 100 为最宽的范围，柔度为最大。相反，设置为 0 则
创建一个边缘很硬的键，亮度值要么完全透明或完全不透明。您可以
将 Low Gain控制理解为前景图像较暗部分的“从透明到不透明”的范
围的控制。

·High Clip 此控制与 Low Clip相似，只是使用此控制选择给高亮度
的区域加键。

·High Gain 此控制与 Low Gain相似，区别只是在于您使用此控制，
按在 High Clip控制中设置的值决定您需要部分影响的亮度值范围。
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您可以将 High Gain控制理解为对画面较亮的区域 “从不透明到透
明”的受影响程度的指标。

注： 您使用 Low Clip和 Low Gain控制设置的值视您的 High Clip 
和 High Gain控制而定，反之亦然。这将防止高和低控制都在同一样
的值上加键。

·Mask 可以在特技上加一个遮蔽。要了解详情，见 103 页 “给素材添
加一个遮蔽”。

·Transparent Outside Mask 选择此选项给遮蔽外的区域加一个
透明度。您可以定义一个遮蔽区域，以在此区域加键，只显示遮
蔽外的背景图像。要了解详情，见 103 页 “给素材添加一个遮蔽”。

·Invert Key 选择此控制反转键选择，令您得到与原来的键相反的效
果。

·Show Key as Output 选择此控制显示用于创建键特技的遮片。令您
可以进一步精确调节您的键。比如，当您显示遮片时，完全透明的部
分显示为黑色，不透明的部分显示为白色。如果您注意到一些您需要
加键的白色点，您可以调节键控制，直到白色点消失为止。

使用亮度键图
亮度键图包含了亮度频谱图和亮度吸管。您可以在亮度频谱图里拖动控
制，以调节 Transparency、Low Clip、Low Gain和 High Gain属性。

您可以通过调节 Low Clip和控制选择需要加键的亮度值，或者您可以使
用亮度吸管自动选择需要加键的亮度值。您有两种方法使用吸管：

- 点击吸管钮，并点击您需要加键的亮度。

- 点击吸管钮，在素材上包含您要选择的亮度的部分点击并拖拉鼠
标，创建一个矩形区域。

吸管 
制作亮度键特技
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您还可以使用 Low Gain、High Gain和 Transparency控制调节键的柔
度。所有这些调节影响亮度选择器的形状和尺寸，如下图所示：

·Plot 点击此钮观看亮度频谱柱状图。图像中每个亮度值在柱状图中
表现为一条线，长一点的线表示有更多像素有此亮度值。您可以在亮
度频谱图中拖动控制调节 Transparency、Low Clip、Low Gain和
High Gain属性。您做的所有调节都将影响 Luma Plot中的亮度选择
器的形状和尺寸。

HIGH GAINLOW GAIN

TRANS

LOW CLIP HIGH CLIP
，设置 Adobe Premiere Pro 实时特技
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制作遮蔽特技
Matrox 遮蔽特技令您可以选择几十种柔边的切出的形状，可以将一个素材
叠加到另一个素材上。

要设置 Matrox 遮蔽特技：

点击 Matrox Mask旁边的三角，扩展属性清单。

·Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

·Shape Transparency 选择遮蔽及周围区域的透明度。默认设置为

（0），遮蔽为全不透明，周围区域为透明。将滑动指针向左拖增加遮

蔽的透明度。将滑动指针向右拖减少遮蔽周围的透明度。

·Outside Transparency 设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽后，

遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。当加了

Outside Transparency时，Shape Transparency设置整个素材的

透明度。

·Softness 给遮蔽加上柔边。

·Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择此

键。

·Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪了

的素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材的裁

剪程度被裁剪。

点击此处选
择新模板
制作遮蔽特技
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·Transform 使用此控制添加或是修改遮蔽的多项自定义设置。如位

置、尺寸和旋转。要了解更多信息，见 98 页 “自定义素材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 101 页 “裁剪特技”。
，设置 Adobe Premiere Pro 实时特技
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制作遮蔽模糊特技
使用 Matrox 遮蔽模糊特技可以在画面上感兴趣的部分加一个遮蔽和模糊
特技，达到突出这个部分的效果。有多个遮蔽模板供选择。

要设置 Matrox 模糊遮蔽特技：

点击 Matrox Mask Blur 旁边的三角，扩展属性清单。 

• Blur Settings 可调节素材的模糊程度。

- Red， Green、Blue和 Alpha Blur Amount 使用这些控制调节素
材里每种颜色和 alpha 的模糊程度。比如，您可以选择只在素材的
红色部分加模糊效果。Alpha Blur Amount只在素材有 alpha 通道
时才可用。

- Lock Channels 使用此控制给所有通道加同样的模糊。当您在调
节 Red Blur Amount，同样的设置会加在其它通道上。

• Color Gain Settings 调节素材里模糊区域中的颜色强度。

- Red、Green和 Blue Color Gain 使用这些控制单独精确调节素
材里某个特定颜色的强度。比如，您可以增加 Red值，只增加模糊
部分里红色的强度。

- Lock Channels 使用此控制给所有通道加同样的颜色增益。当您
在调节 Red Color Gain，同样的设置会加在其它通道上。

• Mask Settings 可以选择遮蔽模板并调节特技的透明度设置。

- Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

- Shape Transparency Shape Transparency 选择遮蔽及周围区
域的透明度。默认设置为 （0），遮蔽为全不透明，周围区域为透
明。将滑动指针向左拖增加遮蔽的透明度，模糊程度下降。将滑动
指针向右拖减少遮蔽周围的透明度，模糊程度增加。

- Outside Transparency 设置遮蔽外部区域的透明程度。 

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽，
遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。当加了

点击此处选
择新模板
制作遮蔽模糊特技
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Outside Transparency时，Shape Transparency设置整个素材的
透明度。

- Softness 令遮蔽的边缘模糊。

- Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择
此键。

- Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪
了的素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材
的裁剪程度被裁剪。

·Transform 使用此控制添加或是修改遮蔽的多项自定义设置。如位
置、尺寸和旋转。要了解更多信息，见 98 页 “自定义素材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 101 页 “裁剪特技”。

注：如果您制作的是高清项目，视您的项目的视频格式不同，模糊遮
蔽特技有可能需要生成。
，设置 Adobe Premiere Pro 实时特技
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制作遮蔽马赛克特技
使用 Matrox 遮蔽马赛克特技可以在画面上感兴趣的部分加一个遮蔽和马
赛克特技，达到突出这个部分的效果。有多个遮蔽模板供选择。

要设置 Matrox 遮蔽马赛克特技：

点击 Matrox Mask Mosaic 旁边的三角，扩展属性清单。 

• Mosaic Settings 调节马赛克块的大小和马赛克特技颜色的锐度。

- Block Width和 Block Height 使用这些控制设置特技的马赛克
块的宽度和高度。如果您选择了 Fixed Aspect Ratio，您只需要
调节宽高，高度会按比例变化。

- Color Sharpness 调节特技里每个马赛克的锐度。每个块会使用
该块下层图像里主要的颜色 （而不是平均颜色）。

• Mask Settings 可以选择遮蔽模板并调节特技的透明度设置。

- Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

- Shape Transparency 选择马赛克块及周围区域的透明度。默认设
置为 （0），马赛克块为全不透明，周围区域为透明。将滑动指针向
左拖增加马赛克块的透明度，马赛克特技明显程度下降。将滑动指
针向右拖减少马赛克块周围的透明度，马赛克特技明显程度上升。

- Outside Transparency 设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽，
遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。当加了
Outside Transparency时，Shape Transparency设置整个素材的
透明度。

- Softness 给马赛克遮蔽加上柔边。

- Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择
此键。

- Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪
了的素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材
的裁剪程度被裁剪。

点击此处选
择新模板
制作遮蔽马赛克特技



144

第 8 章
·Transform 使用此控制添加或是修改遮蔽的多项自定义设置。如位

置、尺寸和旋转。要了解更多信息，见 98 页 “自定义素材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 101 页 “裁剪特技”。
，设置 Adobe Premiere Pro 实时特技
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制作卷页特技
Matrox Axio 卷页特技为真正三维特技，卷页的两面都有高质量的视频画
面和逼真的光泽。您可以在三维空间中控制卷页位置、旋转程度、大小并
缩放卷页。还可以控制卷页的边缘柔度。您还可以在图文上制作卷页，加
强画面效果。

要设置 Matrox 卷页特技：

点击 Matrox Page Curl旁边的三角，扩展属性清单。 

·Page Curl

- Fold Type 您可以选择是 Page Peel（翻页）还是 Page Roll
（卷页）类型的卷页 （此设置影响整段特技）。

- Fold Angle 设置卷页的角度，单位为度。或者您可以设置卷页的
圈数。

- Curl Radius 决定卷页的松紧程度。比如，半径为 0 是最紧的卷
页，值越高越松。

- Progression 设置在任意帧卷页的进程。要看到卷页的进程，您
至少需要加两个关键帧。要创建一个标准的卷页特技，将第一帧的
Progression 设置为 0%，最后一帧的 Progression设置为 100%。
要了解更多关于关键帧的信息，见您的 Adobe Premiere Pro 文件。

- Edge Softness 给卷页加上柔边。

- Curl Softness 给正在卷的部分加一个柔边。

注：如果您在自定义控制中调整尺寸或是旋转设置，您将不会看到
Curl Softness的效果。
制作卷页特技
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·Highlight 有一条白色亮线，可以突出卷页。以下为调整这条亮线所
需的设置：

- Position 设置高亮显示部分在卷页上的位置。

- Intensity 设置高亮显示的明亮程度，单位为百分数。

·Shadow Intensity 设置卷页阴影的阴暗程度，单位为百分数。

·Transform 可修改多项自定义设置，如改变素材的尺寸、位置和旋转
素材。要了解详情，见 98 页 “自定义素材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 101 页 “裁剪特技”。
，设置 Adobe Premiere Pro 实时特技
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制作摇移特技
Matrox 实时摇移滤镜特技可以方便地将素材从一个宽高比转换成另一个宽
高比。截取画面也变得轻而易举，因为现在您可以看到整段素材和您需要
截取的部分，跟踪屏幕上需要截取的部分的移动，做出准确判断。

您可以使用 Matrox 摇移特技将素材转为不同宽高比。要做到这一点，您
需要给嵌套的序列加摇移特技：

1 选择 File > New > Sequence。

2 输入新序列的名字，再点击 OK。

3 将您原来的序列从 Project面板中拖动到新序列里。

4 在新序列里加 Matrox 摇移特技。

5 按您的需要调节摇移设置。

要了解如何创建嵌套序列的更多详情，见您的 Adobe Premiere Pro 文件。

要设置 Matrox 摇移特技：

点击 Matrox Pan & Scan旁的三角，扩展属性清单。

·Source Aspect Ratio 使用此控制选择源素材的宽高比。您可以点
击右边的三角，扩展清单，并选择预定义的宽高比或是使用 Source 
Aspect Ratio 滑动指针选择一个自定义的宽高比。

·Destination Aspect Ratio 使用此控制选择您需要转换成的宽高
比。您可以点击右边的三角，扩展清单，并选择预定义的宽高比或是
使用 Destination Aspect Ratio 滑动指针选择一个自定义的宽高
比。

注：如果您制作的是高清素材，宽高比会总为 16:9。因此，如果您选
择 4:3 作为 Destination Aspect Ratio，您的素材将会变形。

·Scale 使用此钮按比例改变 （增加或减少）画面尺寸。
制作摇移特技
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·Pan Position 令您可以移动画面中您感兴趣的部分。在使用
Global View 观看方式 （见下图）时，您会看到是在画面的哪一部
分。

·Enable Global View 选择此项在您使用 Pan Position选择的感兴
趣的部分加一个长方框。
，设置 Adobe Premiere Pro 实时特技
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制作阴影特技
Matrox 阴影特技可以从任何包含键信息的素材源 （如带 alpha 通道的 DVE
和字幕）上打一个逼真的阴影。您可以调整阴影的颜色、位置、大小并旋
转阴影，以与投下的灯光相配。给阴影加上模糊特技可以模仿散光灯的效
果。

注：如果您制作的是高清项目，Matrox 阴影特技在与其它特技一起使用时
有可能需要生成。

要设置 Matrox 阴影特技：

点击 Matrox Shadow旁的三角，扩展属性清单。

重要：您的源素材或是加在素材上的特技必须有一样包括了 alpha 键信
息，才能创建阴影特技。比如，如果您将阴影特技加到一个没有 alpha 键
通道信息的素材上，再使用 Adobe 的 Motion 特技缩小画面尺寸，您将看
不到阴影，因为 Motion 特技是后来加上去的，而且没有 alpha 键信息以
创建阴影特技。但是，如果您给同样的素材加上 Matrox 3D DVE 特技，再
加阴影特技，您将会看到阴影，因为 Matrox 3D DVE 特技包含 alpha 信
息。

·Lock Colors 选择此选项锁定阴影上方和下方的角上的颜色和透明
度值。比如，您选择用于右上角阴影的颜色和透明度值将用于阴影的
所有 4 个角。

·Top Right Corner Color 使用此控制设置右上角的颜色。
制作阴影特技
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·Top Right Corner Opacity 使用此控制设置右上角的不透明度。
值为全透明 （0）到全不透明 （100）。

·Top Left Corner Color 使用此控制设置左上角的颜色。

·Top Left Corner Opacity 使用此控制设置左上角的不透明度。值
为全透明 （0）到全不透明 （100）。

·Bottom Left Corner Color 使用此控制设置左下角的颜色。

·Bottom Left Corner Opacity 使用此控制设置左下角的不透明
度。值为全透明 （0）到全不透明 （100）。

·Bottom Right Corner Color 使用此控制设置右下角的颜色。

·Bottom Right Corner Opacity 使用此控制设置右下角的不透明
度。值为全透明 （0）到全不透明 （100）。

注：阴影角上的颜色是基于全屏加的。因此阴影角上的颜色有可能会
随着您的 DVE 的位置和尺寸变化。比如，如果您选择红色作为阴影右
上角的颜色，再将 DVE 缩小后放在屏幕的右上方，阴影的每个角都将
反射为红色，即使您有可能选择了其它颜色作为其它角的颜色。

·Shadow Softness 使用此控制设置阴影的柔度。值越高，阴影越柔
和。

注：Shadow Softness是从全屏的边缘上开始加的，因此 Shadow 
Softness 视您的 DVE 大小和位置不同有可能没那么明显。

·Blur 使用此控制给阴影加模糊效果。

·Camera Field of Vision 指定摄像机相对于阴影看到的视野。

·Camera Position X 绕 X 轴移动摄像机。

·Camera Position Y 绕 Y 轴移动摄像机。

·Camera Position Z 将摄像机拉近或是远离阴影。

·Transform 可以修改多项阴影的自定义设置，比如尺寸、位置和旋
转。要了解更多信息，见 98 页 “自定义素材”。
，设置 Adobe Premiere Pro 实时特技
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制作闪光特技
Matrox 闪光特技可以制作射过文字的光或是在画面物体上加上微光，使用
此特技可以令颊的文字看上去像是立体的效果。

要设置 Matrox 闪光特技：

点击 Matrox Shine 旁边的三角，扩展属性清单。

·Light Source

- Position X 水平方向移动光源位置。

- Position Y 垂直方向移动光源位置。

- Position Z 前后方向移动光源位置。

- Rotation 旋转光源。正值为逆时针旋转光源，负值为顺时针旋转
光源。

·Volume

- Length 设置光源发射的距离。正值光源向外射，负值光源向内
射。

- Mode 选择照射方式：Additive（叠加）或 Blend（混合）。点
击右边的三角，扩展清单。

• Additive 重复将一个闪光层加在另一个闪光层上，这样特技变
得更明亮。

• Blend 将闪光层混合在一起。这样制作平面文字的立体效果里
很有用。

- Precision 设置特技上在加多少个闪光层。值越高，特技效果越
干净清晰。

注：Precision 值越高，需要生成的时间越长。

- Start Opacity 设置离光源最近的射线的不透明度。值为从全透
明 （0） 到全不透明 （100）。

- End Opacity 设置离光源最远的射线的不透明度。值为从全透明
（0） 到全不透明 （100）。
制作闪光特技
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• Preprocessing 这些控制令您可以隔离一个通道，将它作为闪光特
技的输入。比如，如果您可只在 alpha 通道上加闪光特技，您可以选
择 Alpha Only方式。

- Enable Preprocessing 选择此选项启用预处理。

- Mode 选择需要使用特技的通道。点击右边的三角扩展清单。

• Red Only 使用红色通道。

• Green Only 使用绿色通道。

• Blue Only 使用蓝色通道。

• Alpha Only 使用 alpha 通道。

• Luma 使用亮度值。

• Oversaturated Luma 只使用过饱和的亮度值。

- Threshold 使用此控制按比例增加或减少 Mode范围外的区域。比
如，如果您选择 Red Only方式，增加 Threshold将令真正鲜红的
区域才加闪光特技。

• Color Remapping 这些控制将给特技加一个颜色渐变。比如，您有
可能想使用包含了橙色、红色和白色的渐变制作一团正在烧得噼噼啪
啪的火的效果。

- Enable Color Remapping 选择此项启用颜色重映射。

- Gradient 选择一个颜色渐变模板。点击右边的按钮，从清单中选
择一个模板。您可以选择 Gradient Lower Boundary和 Gradient 
Upper Boundary控制选择您需要变化的颜色范围。

- Use Gradient Built-in Alpha 在使用含 alpha 通道的颜色渐变
图时选择此控制。

- Gradient Lower Boundary 选择颜色渐变的开始颜色，特技将由
此颜色起逐步变换成 Gradient Upper Boundary颜色。拖动滑动
指针，从颜色图中选择需要的颜色。比如，如果您选择您想从黑过
渡到白，起始颜色为半灰色，将指针设置为 50%。

- Gradient Upper Boundary 选择颜色渐变的结束颜色，特技将由
Gradient Lower Boundary颜色起逐步变换成此颜色。拖动滑动指
针，从颜色图中选择需要的颜色。比如，如果您选择您想从黑过渡
到白，结束颜色为深灰色，将指针设置为 10%。

• Noise 选择这些控制给闪光特技加一些杂色模板。

- Noise Pattern 选择杂色模板。点击右边的钮观看可用的模板清
单。

点击此处选择可用
的杂色模板
，设置 Adobe Premiere Pro 实时特技
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- Amount 设置要加到特技上的噪声。值越高，噪声模板就越明显。

- Size 设置噪声模板里的失真部分的尺寸。将滑动指针向右拖增加
失真部分尺寸增加，反之则减少。

- Progression （X） 设置延水平方向的噪声模板的进程。

- Progression （Y） 设置延垂直方向的噪声模板的进程。

• Postprocessing 这些控制定义闪光颜色如何与源图像的颜色混合。
每种方式都要使用一种计算方法，同时用到闪光特技和源图像的像素
值。

- Mode 使用此控制选择需要的混合方式。点击右边的三角，扩展清
单。

• None 不混合，只显示闪光像素。

• Add 将源图像的像素值加到闪光像素值上。这会令特技更亮。

• Modulate 将闪光像素的值与源图像像素值相乘。这会令特技更
暗。

• Subtract 从闪光像素值里减去源图像像素值，创建一个新颜
色。

• Add Smooth 只在源图像低饱和度颜色像素上混合闪光像素值。
这会特技的效果更加精致。

• Add Signed 在源图像最亮的像素上加上闪光像素值。

• Blend 混合闪光像素值和源图像的 alpha 像素值。

• Blend Signed 混合闪光像素值和源图像最亮的像素值。

- Original Opacity 设置源图像的不透明度。

• Mask 使用此控制定义图像上需要加特技的部分。

- Enable Mask 选择此选项起用遮蔽

- Mask Pattern 选择一个遮蔽模板。点击右边的钮观看遮蔽清单。

- Invert Mask 如果您想反转遮蔽区域的透明和不透明的部分，选
择此控制。

- Outside Transparency设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽，
遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。

- Shape Transparency Shape Transparency 选择遮蔽及周围区
域的透明度。默认设置为 （0），遮蔽为全不透明，周围区域为透
明。将滑动指针向左拖增加遮蔽的透明度，令闪光特技明显程度下

点击此处观看遮
蔽模板
制作闪光特技



154

第 8 章
降。将滑动指针向右拖减少遮蔽周围的透明度，令闪光特技更加明
显。

- Transform 使用此控制添加多种自定义设置，如位置、尺寸和旋
转。要了解更多信息，见 98 页 “自定义素材”。

• Crop 设置板块前表面的裁剪区域。要了解更多信息，见 101 页 “裁
剪特技”。
，设置 Adobe Premiere Pro 实时特技
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制作表面抛光特技
表面抛光特技可以为表面加上金属、砖块、木纹或是花岗岩的质感，带彩
色聚光灯效果。您还可以调节自定义控制，创建一个前后不同的旋转的板
块。

要设置 Matrox 表面抛光特技：

点击 Matrox Surface Finish旁的三角，扩展属性清单。

·Surface Control

- Surface Texture 可选择表面的材质。点击右边的钮，观看可用
的材质清单。

- Front Face Control

• Blending Factor 将板块的前表面与表面材质混和。值越高，
素材混合的程度越高。值为 0时只显示表面材质。

• Invert Video Orientation 选择此控制反转板块前表面的素
材。

• Crop 设置板块前表面的裁剪区域。要了解更多信息，见 102 页
“裁剪特技”。

- Back Face Control

• Blending Factor 将板块的后表面与表面材质混和。值越高，
素材混合的程度越高。值为 0时只显示表面材质。

• Invert Video Orientation 选择此控制反转板块后表面的素
材。

• Crop 设置板块后表面的裁剪区域。要了解更多信息，见 101 页
“裁剪特技”。

·Light Control

- Ambient Light Color 使用颜色选择器钮或是吸管，为整段素材
选择一个环境灯光颜色。
制作表面抛光特技
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- Show Light Cursors 选择此选项，观看两个光源的参考点，以帮
助您设置灯光。设置完您的特技后，记得不选此选项。

- First Light 

• Enable 选择此控制启用第一个灯光。

• Color 使用颜色选择器钮或是吸管，选择第一个灯光的颜色。

• First Light Pattern 可以选择第一个灯光的模板。点击右边
的钮，观看可用的模板。

• Position X 设置第一个灯光在 X 轴的位置。

• Position Y 设置第一个灯光在 Y轴的位置。

• Position Z 设置第一个灯光的深度。

• Relative Position 选择此选项，设置第一个光源相对于素材
中心的位置。比如，如果您移动素材，第一个灯光也跟着移动。
默认设置是，第一个灯光与屏幕中心相对。

- Second Light 

• Enable 选择此控制启用第二个灯光。

• Color 使用颜色选择器钮或是吸管，选择第二个灯光的颜色。

• Second Light Pattern 可以选择第二个灯光的模板。点击右边
的钮，观看可用的模板。

• Position X 设置第二个灯光在 X 轴的位置。

• Position Y 设置第二个灯光在 Y轴的位置。

• Position Z 设置第二个灯光的深度。

• Relative Position 选择此选项，设置第二个光源相对于素材
中心的位置。比如，如果您移动素材，第二个灯光也跟着移动。
默认设置是，第二个灯光与屏幕中心相对。

·Transform 可以修改多项阴影的自定义设置，比如修改尺寸、位置和
旋转素材以创建一个旋转的板块。

注：表面抛光特技的自定义属性里的 Scale Z属性定义板块的厚度。
要了解更多关于使用自定义属性的信息，见 98 页 “自定义素材”。

重要：如果您制作的是高清项目，在某些设置下，表面抛光特技有可
能需要生成。
，设置 Adobe Premiere Pro 实时特技
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制作跟踪遮片特技
Matrox 跟踪遮片特技可以使用一个遮片将一个素材叠加到另一个素材上
（也可以称为移动遮片）， 遮片决定两段素材的叠加方式。您可以使用以
下任意一种类型的素材作为遮片：

·一个灰度级视频或是图文视频。

·一个带 alpha 通道的图文素材或是图文序列。

·任何加了带 alpha 通道的特技的素材，如 Matrox 色度键特技或是 3D 
DVE。

在使用灰度级素材作为遮片时，遮片上黑色的部分创建前景素材透明的部
分，白色的部分挡住背景素材画面，灰色部分为前景素材半透明的部分。

要制作 Matrox 跟踪遮片特技：
1 将背景素材 （底下一层的画面）放在 Video 1 轨上。

2 将遮片素材直接放在背景素材上面的Video 2轨上，再加一个 Matrox 
Track Matte - Matte Identifier特技到这个素材上。这里面没有
任何设置，因为它只是用来标志这个素材是用于制作遮片特技的。

重要：在加了 Matrox Track Matte - Matte Identifier特技后，
再在此素材上加的特技都将被忽略。因此，如果您想在素材上加一个
特技，比如 Matrox 色度键或是使用 Matrox 3D DVE 或 Adobe Premiere 
Pro Motion 特技令遮片移动起来，您必须在加 Matrox Track Matte 
- Matte Identifier特技之前加这些特技。

3 将前景素材 （需要叠加到背景素材的素材）直接放到遮片上面的
Video 3 轨，再在此素材上加 Matrox Track Matte - Video 
Source特技。您的序列将与下图相似：

4 在 Effect Controls面板里，点击 Matrox Track Matte - Video 
Source旁边的三角扩展属性清单：

5 点击 Composite Type旁边的三角选择合成类型。

Matrox 跟踪遮片特技 - Video 
Source 特技加在前景素材上

Matrox Track Matte - Matte 
Identifier 特技加在遮片素材上

点击选择合成类型
制作跟踪遮片特技



158

第 8 章
您有以下选择：

- Alpha 使用遮片的 alpha 通道抠前景图像。这个选项只适用于含
alpha 通道的图文素材，或是已加了含 alpha 通道的特技的素材，
如 Matrox 色键特技。

- Luma 0-255 使用遮片里的全范围亮度电平抠前景图像。这个选项
只适用于遮片含超黑和超白亮度电平的情况。 

- Luma 16-235 使用遮片里的标准亮度电平范围抠前景图像。

6 要反转跟踪遮片特技的效果，选择 Reverse。键将反转，得到相反的
结果 （前景透明的部分变成不透明，不透明的部分变成透明）。
，设置 Adobe Premiere Pro 实时特技
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制作划像过渡特技

制作划像过渡特技
Matrox 划像过渡特技支持标准的叠化、SMPTE 划像和带柔边及彩色边框的
不规则划像。

要设置 Matrox 划像过渡特技： 

点击序列上的过渡特技图标，再点击 Effect Controls面板里的 Custom 
钮。出现 Customize Matrox Wipes对话框：

1 在 Wipe Pattern下，点击 Select Pattern钮并选择您的划像特技模
板。

2 如果您想给划像特技加一个边框，在 Border下选择 Enable。 

- Width 拖动滑动指针或是在文本框中输入一个百分数值调节边框
宽度。

- Color 点击此钮选择边框颜色。
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- Balance 可以选择在 A图像和 B图像的边框的突出程度。比如，
正值表示 B图像的边框更突出，负值表示 A图像的边框更突出。

- Reset 点击此钮恢复 Border的默认值。

3 使用 Softness下的为划像特技的边框加一个柔边。

- Nonlinear softness 此选项为默认选项。在使用某些划像特技
模板时，您有可能发现不选这个选项的效果更好。比如，非线性柔
度通常在创建 SMPTE 划像特技时效果较好，但在创建不规则划像
时，线性柔度效果较好。

- Amount 通过拖动滑动指针或是在文本框中输入一个百分数值调
节柔度值。值越高，边框的边缘越柔和。

- Reset 点击此钮随时可以恢复 Softness的默认值。

4 使用 Preview下的控制预览划像过渡特技：

- 拖动 Play钮旁边的滑动指针观看过渡特技。

- 点击 Play钮或是按空格键播放过渡特技。如果您想循环播放，按
Loop ，特技将循环播放，直到再按 Stop为止。

要了解更多关于设置过渡特技的信息，见您的 Adobe Premiere Pro 文件。
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制作 Matrox 色度箝位特技
当您在素材的一部分加了需要进行色彩空间转换的特技时，您可以使用
Matrox 色度箝位特技确保素材的颜色一直保持一至。某些特技，如
Matrox 硬件加速特技和 Adobe Premiere Pro 自带特技都需要色彩空间转
换 （YUV 到 RGB），需要对素材的 RGB 值进行箝位处理，以转换成可接受
的 0-255 颜色分量。但这种箝位处理一般只用在非常明亮或是饱和度很高
的颜色上。

比如，如果您把一段包含很明亮或是很高饱和度颜色的素材分成两段，一
段加了 Matrox 3D DVE 特技，在监视器上看时，您有可能觉察到两段素材
之间的颜色有所有不同。您可以在没加特技的素材上加上色度箝位特技，
令素材前后色调保持一致。
制作 Matrox 色度箝位特技
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选择速度控制方法
您可以选择最适合您的 Premiere Pro 项目的速度控制方式。默认设置是
Frame Blend，在视频场或帧之间插入，这个设置对于标准或是慢节奏的
视频比较合适。但如果您的项目包含较多快速变化的素材，不选此选项效
果会更好。

要改变 Timeline面板中的速度控制方法，右击素材，选择 Frame Blend 
以使用适用于标准或慢节奏的视频及摄像机的变速方式，对于快速节奏视
频，不选此项。

备注

·Frame Blend选项不支持超过 200% 的速度变化。

·如果您制作的是高清项目，不选 Frame Blend选项将需要生成。

关于 Adobe Premiere Pro 自带特技
在 Adobe Premiere Pro 中，Timeline面板上的每个素材都自动加一个特
技。选择序列上的素材后，它自带的特技出现在 Effect Controls窗口
中，所有自带特技都可以在 Effect Controls面板中调整。Adobe 
Premiere Pro 的自带特技包括 Motion 特技、透明度和音量特技。Matrox 
Axio 支持所有的 Premiere Pro 自带特技达到实时。

Matrox Axio 实时规则
在 Adobe Premiere Pro 项目中，您可以使用多种 Matrox Axio 基于 CPU 
的特技、硬件加速特技和 Adobe Premiere Pro 自带特技组合，所有特技
都有透明度控制。

实时意味着您无需生成就可以实时输出到磁盘或是输出到磁带 （即，时间
线上没有红色条）。

Matrox 基于 CPU 的特技有划像特技、色彩校正特技、色键特技、亮度键特
技、色度箝位特技和 Adobe Premiere Pro 的裁剪及变速特技。Matrox 硬
件加速特技为所有其它 Matrox 特技 （如卷页特技、3D DVE 特技、表面抛
光特技、Premiere Pro 自带特技和淡入淡出等）。

注：在 Axio LE 上，硬件加速的特技只在使用支持 Adobe Premiere Pro 的
Matrox 硬件加速特技的显卡时才可用。要了解更多信息，见 183 页 “在
Adobe Premiere Pro 里起用和禁用 Matrox 硬件加速特技”。

Matrox Axio 在您工作过程中不断分析序列，以识别需要生成的部分 （上
面有一个红色条）。比如说，播放完序列后，序列上有丢帧的部分会有一
个红色条。即使您的系统在空闲的时候，Matrox Axio 也在分析决定时间
线上哪些部分需要生成。某些复杂特技或是特技组合在预览时有可能造成
丢帧。Matrox Axio 通过分析时间线，并系统地丢帧，令播放达到最佳效
果。 
，设置 Adobe Premiere Pro 实时特技
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如果您发现在输出到磁带时有丢帧，但丢帧的部分在时间线上并没有红色
条显示出来，您可以降低 Realtime Indicator Threshold。要了解更
多信息，见 58 页 “定义常规设置”。

本节介绍一些规则，可以令特技保持实时，前提是您使用了第 4 页“Axio 
HD 和 SD 系统配置 “所推荐的系统配置。

支持图文格式
Matrox Axio 支持 Adobe Premiere Pro 支持的所有全屏单帧图文素材达到
实时。包括 Premiere Pro 支持的所有字幕格式，如 Adobe Title 
Designer .prtl 文件。要了解所支持的格式的详情，见 Adobe Premiere 
Pro 文件。

注：不支持图文横飞、竖滚和动画达到实时。

最多层数
在设置实时特技时，如何避免出现红色条的总规则视您使用的是高清系统
还是标清系统而定。

·在高清中，任何部分，您可以使用最多 2 层视频素材 （.avi 文件），
和最多 2层单帧图文素材。

·在标清中，任何部分，您可以使用最多 4 层视频素材 （.avi 文件），
和最多 6层单帧图文素材。

限制
如果您有以下操作，您将需要生成：

·在素材里加了任何 Field Options， 比如 Always Deinterlace 或
Flicker Removal。

·使用 Frame Hold命令给素材加了一个定格特技。
Matrox Axio 实时规则
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笔记
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Chapte r 9
使用 Matrox Axio 和 Video

for Windows 程序
本章介绍在 Matrox Axio 系统上如
何使用 Video for Windows 程序生
成素材。
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总介
在使用 Video for Windows 程序将素材生成为 .avi 文件时，比如完成的
视频作品或动画，可以使用 Matrox 编解码器创建 Matrox .avi 文件。比
如，您可能想将动画生成为 Matrox DV/DVCAM 格式，以录在 DV 磁带上。
还可使用 Video for Windows 程序将视频生成为 Matrox .avi 文件，这就
可以将这个文件作为实时素材输入到 Matrox Axio 的 Adobe Premiere Pro
项目中。 

以下章节介绍在 Matrox Axio 使用 Video for Windows 程序生成和采集素
材时所需的多种设置 .要了解如何将 Adobe Premiere Pro 视频输出为
Matrox .avi 文件，见 83 页 “Premiere Pro 输出到磁盘”。使用 Adobe 
Premiere Pro 输出 Matrox Axio 系统上的视频文件可突破 Video for 
Windows 程序的 2-GB .avi 文件限制。

注：虽然 Matrox 已测试过多种 Video for Windows 程序，在 Matrox Axio
上使用这些程序 （或未经测试的程序）时有可能有一些操作限制。

无需 Axio 硬件使用 VFW
如果您安装了 Matrox Video for Windows （VFW）软件编解码器 （见 53
页 “在无 Axio 硬件的系统上安装 Matrox VFW 软件编解码器”），您可使
用 Video for Windows 程序生成并播放 Axio 兼容的 .avi 文件，无需安装
Axio 硬件。比如，如果您使用 Adobe Premiere Pro 将素材采集为 Matrox
脱机高清格式，如果您的素材上安装了 Matrox VFW 软件编解码器，您可
以在没安装 Axio 硬件的系统上编辑并播放这些素材。 

注：Matrox MPEG-2 I- 帧 HD 和 DVCPRO HD 编解码器只被安装了 Matrox 
Axio 硬件的系统支持。
, 使用 Matrox Axio 和 Video for Windows 程序
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生成之前
将素材生成为 Matrox .avi 文件之前，需要进行以下 Video for Windows 
程序设置：

• 按要生成的视频格式正确设置帧率。比如，如果您要生成 PAL 制式，就
将帧率设置为 25 fps。

• 将生成素材的帧尺寸设置为全屏：

- 720 ×480 如果使用 DV/DVCAM、DVCPRO、DVCPRO50 或 MPEG-2 I- 帧编
解码器将素材生成 NTSC 格式。

- 720×576 如果使用 DV/DVCAM、DVCPRO、DVCPRO50 或 MPEG-2 I- 帧编
解码器将素材生成 PAL 格式。

- 720×486 或 720×576 如果需要生成 Matrox 无压缩的标清或是
Matrox M-JPEG 格式。

- 1920×1080 或 1280×720 如果需要生成无压缩高清、 MPEG-2 I- 帧 
HD 或 DVCPRO HD 格式。

- 480×270 或 320×180 如果需要生成脱机高清格式。如果需要生成文
件以用在 Matrox Axio 系统上的 Adobe Premiere Pro 项目中，将项
目生成为 480×270 （用于 1080i 或 1080p 项目）或是 320×180 （用
于 720p 项目）。要了解详情，见第 194 页 “使用 Matrox 脱机高清
晰度编解码器”。

• 要将视频生成与源素材一样压缩格式、帧尺寸和帧率，但画面质量
（数据率）、扫描方式 （隔行或逐行）或比特深度 （8-bit 或 10-bit）
不同，如将无压缩 1080i @ 29.97 fps 素材输出为无压缩 1080p @ 29.97 
fps 格式，必须选择 Recompress Always 选项，这样视频将在输出时被重
新压缩。

• 如果需要生成音频，将音频的取样率设置为 48 kHz 并将取样精度设置
为 16-bit （单声道或立体声）。

• 要达到最佳效果，请确保程序中生成素材的 Data rate limit 选项没
选。这一步确保 .avi 文件可以以选定质量生成。

• 如果使用 Adobe Premiere Pro，将 Fields 设置为生成 Lower Field 

First （NTSC），或 Upper Field First （PAL 和隔行扫描高清视频），
或是 No Fields (Progressive Scan) （逐行扫描视频）。

注：在生成大量素材前，请确认生成的动画和过渡特技，如划像和推移的
播放是否平滑。如果看上去跳跃，不稳定，请调整生成素材的场序。比
如，如果将场序设置为 Odd field 或 Field 1 时，过渡特技看上去跳跃，
试着将场序改成 Even field 或 Field 2。
生成之前
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第 9 章
选择色彩空间转换选项
当使用 Matrox VFW 编解码器将素材生成为 .avi 文件时，您可以决定在生
成过程中，亮度电平与色度信息在色彩空间转换中如何处理。

注：色彩空间转换默认设置已令大多数应用程序效果良好。我们建议只有
用于特殊目的时才改变这些设置。

要选择所需色彩空间转换选项：

1 右击 My Computer，选择 Manage，再双击 Device Manager。

2 在 Sound， video and game controllers 下，双击 Video Codecs。

3 点击 Properties，选择以下选项：

- Matrox VFW Software Codecs （包括所有 Matrox DV、M-JPEG、 
MPEG-2 I- 帧标清和脱机高清格式）。

- MMatrox VFW DVCPRO HD Codec

- Matrox MPEG-2 I-frame HD Codec

- Matrox VFW Uncompressed SD Codec

- Matrox VFW Uncompressed HD Codec

4 点击 Properties，选择 Settings。

5 在弹出的对话框中，在 Color Space Conversion 中选择所需选项。

注：如果您使用的编解码器不支持其中的一项选项，这项选项就会是
灰色的。但大部分选项对所有 Matrox Video for Windows 编解码器来
说都是通用的。如果设置了一种编解码器的某个选项，也就同样设置
了其它编解码器此选项。 

- Standard 使用标准广播亮度电平生成视频。过黑和过白电平都被
箝位。

- DV-compliant 使用适用于 DV 素材的亮度电平生成视频，可保留视
频中的过白亮度电平。 
, 使用 Matrox Axio 和 Video for Windows 程序
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- Expanded 使用全范围亮度电平生成。保留过黑和过白亮度电平，
在需要进行亮度抠像时，您可能需要使用这个设置。

重要：当生成 RGB 图文时，选择 Expanded 或 DV-compliant，生成的图
像中都会出现过黑或过白部分。比如，如果选择 Expanded，所有 RGB
图文中的黑色部分都变成过黑，白会变成过白。要用标准黑或白电平
生成 RGB 图文，将亮度范围设置为 Standard。

- Chroma filtering 和 Chroma interpolation 该选项调节 RGB 图文色
度带宽，改进图像颜色突变的部分，如黑或白背景上的蓝盒子。对
于大多数动画和合成作品 （计算机生成素材）应选择此项。对于大
多数视频编辑程序，最好动不要选此项。如果您觉得生成图像颜色
模糊，请去掉这些选项中的一项或两项。

- Chroma sampling for fast-motion video 该选项消除一些失真，如
快动作视频中出现锯齿边和不需要的线 （只适用于 PAL 制视频）。

重要：生成图文和字幕时，请确保没选 Chroma sampling for fast-

motion video，该选项会令生成的图像边缘出现锯齿边。

6 点击 OK 保存设置。选定亮度范围的任何设置改变（如从 Standard改为
Expanded）都将在下次启动 VFW 程序时生效。
生成之前
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第 9 章
将素材生成为 Matrox VFW .avi 文件
将素材生成为 .avi 文件时 （如生成完成的视频作品或是一个动画），必
须选择用来创建文件所需的压缩器 （编解码器）。压缩器决定生成视频的
质量。请参考应用程序资料，了解如何为 .avi 文件选择编解码器。

要创建一个 Matrox Video for Windows .avi 文件，从程序的可用编解码
器中选择需要的编解码器。

要创建 Matrox Video for Windows .avi 文件：

1 从程序的可用编解码器清单中选择一种编解码器：
- Matrox DV/DVCAM 将视频生成为 DV 或 DVCAM 格式。

- Matrox DVCPRO 将视频生成为 DVCPRO 格式。

- Matrox DVCPRO50 将视频生成为 DVCPRO50 或 D-9 格式。

- Matrox DVCPRO HD 将视频生成为 DVCPRO HD 格式
（只支持格式为 1080i @ 25 fps、 1080i @ 29.97 fps 或 720p @ 59.94 
fps 的高清视频）。此编解码器仅被安装了 Matrox Axio 硬件的系统支
持。

- Matrox MPEG-2 I-frame 将视频以选定的数据率 （仅用于标准清晰
度）生成为使用 4:2:2 Profile @ Main Level 的 MPEG-2 I- 帧格
式。

- Matrox MPEG-2 I-frame HD 将视频以选定的数据率生成为使用
4:2:2 Profile @ High Level 的 MPEG-2 I- 帧格式。这个编解码器
仅被安装了 Matrox Axio 硬件的系统支持。

- Matrox Uncompressed SD 将视频生成为 8-bit 或 10-bit 无压缩标
清格式。 

- Matrox Uncompressed HD 将视频生成为 8-bit 或 10-bit 无压缩高
清格式。

- Matrox Offline HD 将视频生成为代理高清视频格式，用于脱机编
辑。

注：Matrox M-JPEG 编解码器还可用于创建用在 Matrox DigiSuite 或
DigiSuite LE 上的素材。要了解如何设置 Matrox M-JPEG 编解码器，
请参考您的 Matrox DigiSuite 资料。 

2 如果您选择了一个需要设置的 Matrox 编解码器，如需要选择数据率
（视频质量），点击 Configure 钮。要了解详情，见下一节“设置
Matrox 无压缩高清无压缩标清编解码器”、171 页 “设置 Matrox 
MPEG-2 I 帧编解码器”或 172 页 “设置 Matrox MPEG-2 I 帧高清编解
码器”。
, 使用 Matrox Axio 和 Video for Windows 程序
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设置 Matrox 无压缩高清和无压缩标清编解码器
当您点击程序的 Configure 钮设置 Matrox 无压缩高清或 Matrox 无压缩标
清编解码器时，出现一个类似以下图的对话框：

1 在 Bit Depth 下，选择您的视频需要的比特深度。

2 在 Scan Mode 下，选择您的视频需要的扫描方式。

3 点击 OK 存储您的设置。您以后每次使用这个程序生成素材时都会使用
这个设置，直到您再次修改它为止。

设置 Matrox MPEG-2 I- 帧编解码器
当您点击程序的 Configure 钮设置 Matrox MPEG-2 I- 帧编解码器 （标准清
晰度）时，出现一个类似以下图的对话框：

1 拖动滑动指针，直到显示您需要的数据率 （视频质量）为止。数据率
越高，视频质量越好。但视您的系统功能不同，如果使用 Video for 
Windows 程序的视频质量设置过高，播放时有可能出现困难。 

2 点击 OK 存储您的设置。您以后每次使用这个程序生成素材时都会使用
这个设置，直到您再次修改它为止。
将素材生成为 Matrox VFW .avi 文件
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第 9 章
设置 Matrox MPEG-2 I- 帧高清编解码器
当您点击程序的 Configure 钮设置 Matrox MPEG-2 I- 帧高清编解码器时，
出现一个类似以下图的对话框：

1 拖动滑动指针，直到显示您需要的数据率 （视频质量）为止。数据率
越高，视频质量越好。但视您的系统功能不同，如果使用 Video for 
Windows 程序的视频质量设置过高，播放时有可能出现困难。 

2 在 Frame Rate 旁边，从清单中选择一个帧率。确保您选择的帧率符合
您要生成的高清格式。

3 要应用 MPEG-2 I- 帧高清文件的高级设置，点击 Advanced钮。

注：默认高级设置已令大多数应用程序效果良好。我们建议只有用于
特殊目的时才改变这些设置。

4 在 DC Precision 旁，选择 DC 帧内编码块的比特深度。

注：您用于生成视频的 DC 精度值越高，DC 内容就会增长得越高，代
价是降低编码数据流里的 AC 内容。这有可能导致某个数据率下的压缩
数据流的整体质量降低。

5 在 Zig Zag Order 下，选择以下其中一项：

- Regular 按 ISO/IEC 13818-2 （图 7-2） 规格文件设置标准 （默
认） 之字形扫描模式 DCT 块的 AC 系数。

- Alternate 按 ISO/IEC 13818-2 （图 7-3） 规格文件设置 DCT 块
的 AC 系数的反之字形扫描模板。在以高数据率采集或是生成视频时
使用此设置 （比如，数据率为 100 Mb/sec 或更高）。

6 在 Rounding Type 下，选择其中一项：

- MPEG-2 在计算量化系数时，将 AC 系数四舍五入到最近的整数。

- Matrox Custom 在计算量化系数时，将 AC 系数截取到最低的整
数。在某些情况下，这个设置在出现图文时有可能失真较小。
, 使用 Matrox Axio 和 Video for Windows 程序
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7 选择 Force Frame-based DCT 设置将宏块生成帧而不是场。在某些情况
下，选择此选项在显示图文时失真较小。

8 点击 OK 存储设置。您以后每次使用这个程序生成素材时都会使用这个
设置，直到您再次修改它为止。
将素材生成为 Matrox VFW .avi 文件
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第 9 章
笔记
, 使用 Matrox Axio 和 Video for Windows 程序



Chapte r 10
使用 Matrox 所见即所得插件

本章介绍如何使用 Matrox Axio 的
所见即所得插件在视频监示器上显
示项目内容。
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第 10
总介
Matrox 所见即所得插件配上Matrox Axio硬件，可以在视频监示器上显示您
正在制作的项目内容。您可以检查色温 # 字幕区域和隔行失真。支持以下
程序：

· Adobe After Effects （5.0 及更高版本）。

· Adobe Photoshop （7.0 及更高版本）。

· Autodesk 3ds Max （7.0 及更高版本）。

· Autodesk Combustion （4 及更高版本）。

· eyeon Fusion （4 及更高版本）。

· NewTek LightWave 3D （7.5 及更高版本）。

使用 Matrox 所见即所得控制面板
Matrox 所见即所得控制面板可以调整需要在视频监示器上显示的方法。要
使用 Matrox 所见即所得控制面板，右击 Windows 任务条上的  图标。

注：默认设置是起用 Matrox 所见即所得插件输出到视频监示器。要禁用
它，在控制面板里不选 Enable WYSIWYG Output 选项。

1 在 Project Format 菜单中，选择符合您正在制作的项目的格式，比如
NTSC 4:3。

2 在 Output Format 菜单中，选择您需要观看输出的格式。可用的输出格
式视您的项目格式而定。比如，如果您选择了 NTSC 项目格式，您就
只能选择 NTSC 输出格式。如果您选择了 1080i @ 29.97 fps 项目格
式，您可以选择 1080i @ 29.97 fps 输出格式，或者您可以选择一个
NTSC 输出格式将高清视频下转换为 NTSC。 
注：如果 Adobe Premiere Pro 正在运行，Project Format 和 Output 
Format 将由 Premiere Pro 项目的视频输出设置决定。

3 从 Preview Type 菜单中，选择以下一种预览选项：

- Video 选择此项观看整个画面。

- Alpha Channel 选择此项只观看灰色级 alpha 键 （遮片）信息。
章 , 使用 Matrox 所见即所得插件
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使用所见即所得插件的步骤

使用所见即所得插件的步骤
以下内容介绍在使用每种程序时，如何使用 Matrox 所见即所得插件在视频
监示器上观看效果。

注：以下步骤适用于近期版本的程序，这些程序出现新版本时，以下步骤
有可能改变。

Adobe After Effects
1 打开 Adobe After Effects 并输入您需要观看的素材。

2 将素材从 Project 窗口拖动到 Composition 窗口。

Adobe Photoshop
1 打开 Adobe Photoshop 并输入您需要观看的素材。

2 选择 File > Export > Matrox WYSIWYG Preview。

Autodesk 3ds Max 
1 打开 Autodesk 3ds Max 并输入您需要观看的素材。

2 选择 Rendering > Render，打开 Render Scene 对话框。

3 在 Render Output 中，点击 Devices。

4 在 Select Image Output Device 对话框中，选择 Matrox WYSIWYG 

Preview， 再点击 OK。

5 点击 Render。

Autodesk Combustion
1 打开 Autodesk Combustion 并输入您需要观看的素材。

2 选择 File > Preferences > Framebuffer。

3 在 Framebuffer Type 旁边的菜单里，选择 Matrox WYSIWYG Preview£¨ 再
点击 OK。

eyeon Fusion
1 打开 eyeon Fusion 并输入您需要观看的素材。

2 右击文件，选择 View On > Matrox WYSIWYG Preview。
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第 10
NewTek LightWave 3D
1 打开NewTek LightWave 3D选择File > Load > Load Scene装载需要观看

的文件。

2 选择 Select Rendering > Render Options。
3 从 Render Display 菜单中，选择 Matrox WYSIWYG Preview。

4 选择 Rendering > Render Current Frame。
章 , 使用 Matrox 所见即所得插件
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监控 Matrox Axio 系统

本章介绍如何使用 Matrox X.info 
程序显示 Matrox Axio 系统及所安
装的硬件的重要信息。
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第 11
使用 X.info显示 Axio信息
Matrox X.info 程序可以显示 Matrox Axio 系统及所安装硬件的信息，并在出
现某些问题时报警。比如，当其中一块 Axio 板卡的温度超过了最高操作
温度时。在 Matrox Axio LE 上，如果您有一块支持 Matrox 硬件加速特技
的显卡，您可以使用 X.info 程序在 Adobe Premiere Pro 中起用和禁用这些
(见 183 页特技 “在 Adobe Premiere Pro 里起用和禁用 Matrox 硬件加速
特技”)硬件加速特技。

您的计算机只要一开， Matrox X.info 就会启动。您可以双击 Windows 任
务条上的  图标，打开 Matrox X.info 以查看系统和硬件情况。

注：如果您没看到这个图标，右击任务条，选择 Properties （属性），再
不选 Hide inactive icons 选项，再点击 OK。

监控 Adobe Premiere Pro 内存用量
Adobe Premiere Pro 在运行时，您可以监控 Adobe Premiere Pro 的内存用量。
在 Matrox X.info( ) 图标上按住鼠标。会出现一个信息框，显示当前
Adobe Premiere Pro 内存用量。如果您的 Adobe Premiere Pro 内存用量很高，
X.info 将发出警告，提供更多信息。

显示系统信息
要显示 Matrox Axio 系统信息，从 Display Information About 清单中选择
System 。在这个页面中，您将会看到 Install Information，如安装路径和
Axio.utils 的版本。

您还可以创建一个系统信息的 HTML log 文件，这对排除故障很有用。要
创建这个 log 文件，使用 System Information Log 下的 Browse 钮选择 log
章，监控 Matrox Axio 系统
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文件的路径和文件名，再点击 Create。如果选择了 Open file after 

scan， HTML 系统 log 文件将在被创建后自动打开。
使用 X.info 显示 Axio 信息
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第 11 章，监控 Matrox Axio 系统

显示硬件信息
要显示关于 Matrox Axio 硬件的信息，选择从 Display Information About 
中清单中选择 Hardware。每块 Axio 板卡和接口盒 (X.linkHD 和 X.linkSD)
都显示在上面的选项中。

注：没有关于 X.linkLE 接口盒的硬件信息。

点击板卡或是接口盒显示硬件信息 （比如，序列号和生产日期）。您还可
以监控每个硬件部件当前的和最高的操作温度。

重要：无论您是否打开了 Matrox X.info，只要一个或多个 Matrox Axio 硬
件的温度超过了最高操作温度，您就将收到一个警告，并将指示如何处
理，如 184 页 “故障提示”所示。
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第 11
显示硬件信息
要显示关于 Matrox Axio 硬件的信息，选择从 Display Information About 
中清单中选择 Hardware。每块 Axio 板卡和接口盒 (X.linkHD 和 X.linkSD)
都显示在上面的选项中。

注：没有关于 X.linkLE 接口盒的硬件信息。

点击板卡或是接口盒显示硬件信息 （比如，序列号和生产日期）。您还可
以监控每个硬件部件当前的和最高的操作温度。

重要：无论您是否打开了 Matrox X.info，只要一个或多个 Matrox Axio 硬
件的温度超过了最高操作温度，您就将收到一个警告，并将指示如何处
理，如 184 页 “故障提示”所示。
章，监控 Matrox Axio 系统
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监控 Axio硬件操作温度
如 X.info Hardware 部分介绍，每页显示各种 Matrox Axio 硬件部件当前和最
高操作温度。要避免损坏 Axio 硬件和操作系统，请确保您的 Axio 硬件工
作在最高操作温度的时间不要过长。您应该尽量保证 Axio 硬件操作在低
于最高操作温度 10°C 的温度下。

您需要定期监控 Axio 硬件部件的操作温度，并采取措施降低室温或改进
Axio 系统的通风。要了解如何确保系统的正确通风，见第 10 页 “提供足
够的通风”(Matrox Axio HD 或 SD) 和 32 页“提供足够的通风”(Matrox 
Axio LE)。

在 Adobe Premiere Pro 里起用和禁用 Matrox 硬件加速特技
使用 Matrox Axio LE 时，在 X.info 程序有一个页面显示显卡的硬件信息。
在这个页面里，您可以选择在 Adobe Premiere Pro 中起用和禁用 Matrox 硬
件加速特技。如果您的显卡支持 Matrox 硬件加速特技，默认是选择
Enable Matrox hardware-accelerated effects in Adobe Premiere Pro。如
果您制作这些特技时系统出现问题，您可能需要不选此选项，禁用这些特
技。

要在 Adobe Premiere Pro 中使用 Matrox 硬件加速特技，您的 Axio LE 板卡
必须配置一块板上至少有 256 MB 内存而且支持 Microsoft DirectX 9 的显
卡。 如果 Matrox 测试了您的显卡并得出结论此显卡不支持这些特技，您
就无法使用 Matrox 硬件加速特技。您可以浏览我们的网站，了解更详细
信息： www.matrox.com/video/cs/support。

如果您选择 Automatically check for Matrox-validated display card，每
次您打开系统， X.info 都将连接到 Matrox 视频网站上，以检测当前安装
的显卡是否支持 Matrox 硬件加速特技，并提示您是否可以起用这些特技。

注：如果您不想 X.info 自动检测您的系统是否有一个经 Matrox 认证的显
卡，您可以手动升级此程序，选择 Start > All Progams > Matrox 

Axio.utils > Check for Matrox-validated Display Card。您需要能够上
网才能完成这个升级。

故障提示
如温度报警一样， X.info 也可以检测到某些硬件问题 （比如，如果您
X.effects 卡上的风扇不工作了）。一旦 X.info 检测到一个硬件故障，Matrox 

X.info Notification 对话框将会显示警告，并有进一步的指示，介绍如何
排除故障。如果故障不排除， 对话框将不会关闭。
使用 X.info 显示 Axio 信息

http://www.matrox.com/video/support
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Appendix A
标准和高级下拉

本附录介绍最常见的下拉方法，并
介绍 Matrox Axio 如何使用这些下
拉方法。
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附录 
总介
您在项目制作过程中有可能会用到下拉技术，将输入视频转换成您的项目
需要的格式。下拉还可以用于视频输出中，以满足某些要求。项目中需要
下拉时，Matrox Axio 要么执行标准的 2:3 下拉，或是高级 2:3:3:2 下
拉。

标准 2:3 下拉
标准 2:3 下拉经常被用于电视电影机，将 24 fps 的胶片转换为 29.97 fps 
隔行扫描视频。这种下拉方式还用于将任何 23.98 fps 逐行扫描视频转换
成 29.97 fps 隔行扫描视频，比如将 486p @ 23.98 fps 视频转换成 NTSC
制视频。 

要将 24 fps 胶片或是 23.98 逐行扫描视频转换成 29.97 fps 隔行扫描视
频，需要在视频序列中添加视频帧和场。比如，要将一个包含了 4 张胶片
的序列转换成逐行扫描的帧，需要 5帧视频，共是 10 场视频。因此需要
添加一帧视频或是 2 场视频。要做到这一点，4 张胶片的第一和第三张均
转换成两场视频，第二和第四张胶片分别转换成 3场视频，这种总共是 5
帧隔行扫描视频。

下图介绍转换过程： 

上面的图为胶片或是逐行扫描视频的帧，下面的图是对应的隔行扫描视频
场。标准 2:3 下拉是将胶片的第一张或是逐行扫描视频的第一帧 （A）转
换为两场视频 （a1 和 a2 场），第二帧 （B）转换为三场视频 （b1、b2 和
b3），第三帧 （C）再转换成两场视频 （c1 和 c2），第四帧 （D）再转换
成三场视频 （d1、d2 和 d3）。这个过程每秒重复 6次。

标准的反下拉与以上过程相反，将 29.97 fps 隔行视频转换成 23.98 fps
逐行视频。这个过程是去掉一个视频帧 （两场视频）。以上图中，典型的
反下拉会删除 b3 和 d1 场。这表示视频帧程序需要读 C和 D 帧，以去掉多

Film frames @ 24 fps or progressive frames @ 23.98 fps

A B C D

a1 a2 b1 b2 b3 c1 d2 d3c2 d1

Video frame A Video frame B Video frame C

Video fields @ 29.97 fps

Video frame D Video frame E
A， 标准和高级下拉
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余场。对于标准反下拉来说，处理的是压缩的视频，程序需要先解压缩
帧，以去掉多余的场，再重新压缩为原来的格式。

Matrox Axio 的标准反下拉
为了令 Matrox Axio 能够正确进行标准的反下拉，要从 29.97 fps 隔行扫
描转换成 23.98 fps 逐行扫描的素材必须开始就以 23.98 fps fps 采集。
当 Matrox Axio 进行标准反 2:3 下拉时，系统按帧的时间码是 0 还是 5 确
定一个序列的 A帧。比如， 时间码为 00:00:20:20 或 00:00:20:25 的帧将
被定为 A帧，将在下拉处理中被定为第一帧。

在批采集中，第一帧不一定是 A帧，Axio 会将下一个能作为 A 帧的帧作为
A帧 （如果需要的话）。为令 Axio 可以精确地进行反 2:3 下拉转换，素材
需要在时间码 0或 5 处有一个 A帧。这个素材还必须使用连续不丢帧的时
间码录制。

高级 2:3:3:2 下拉
高级 2:3:3:2 下拉是作为另一种用于 DV 视频的帧率转换的标准下拉方法
开发的。它用于将 486p @ 23.98 fps 视频转换为 NTSC （486i @ 29.97 
fps）视频。当使用 DV 摄像机以 23.98 fps 采集并使用高级下拉录制到 DV
磁带时，需要使用这种高级下拉转换 （在某些设备上称为 24PA 或 24P 
Advanced 方式）。高级 2:3:3:2 下拉与标准 2:3 下拉的不同之处在于视频
序列的两个中间的帧每个都被转换成了三个视频场。
高级 2:3:3:2 下拉
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附录 
下图显示处理过程：

高级 2:3:3:2 下拉处理是这样 :第 1 帧逐行扫描视频 （A）转换为两场视
频 （a1 和 a2），第 2 帧 （B）转换为 3 场视频 （b1、b2 和 b3），第 3帧
（C）转换为 3 场视频 （ c1、c2 和 c3），第 4 帧 （D）转换为两场视频
（d1 和 d2）。

高级反下拉（2:3:3:2 ）转换将 29.97 fps 的隔行扫描视频转换为 23.98 
fps 逐行扫描视频。需要从视频序列里去掉一个视频帧 （两场视频）。从
上图中，典型的高级反下拉将去掉 b3 和 c1 两场视频。这表明系统可以从
序列中去掉 C 帧而无需读其它帧。

与标准反下拉相比，高级反下拉可以更好地保持转换后的视频质量，因为
从序列中去掉完整的一帧，其余的帧都可以完好地保留。

Matrox Axio 的高级反下拉
由于上图中多余的 C 帧在 23.98 fps 逐行扫描视频录制到磁带时已被打上
了标记，所以高级反下拉处理比标准反下拉处理要简单一些。这个信息已
包含在 DV 数据流里，Matrox Axio 进行高级反下拉时，它读到此信息，找
到多余的帧，就可以将它从视频序列里去掉。Matrox Axio 可以在一盘录
制了连续丢帧或不丢帧时间码的 DV 磁带上进行高级反下拉处理。

Progressive frames @ 23.98 fps 

A B C D

a1 a2 b1 b2 b3 c1 d1 d2c2 c3

Video frame A Video frame B Video frame C

Video fields @ 29.97 fps

Video frame D Video frame E
A， 标准和高级下拉



App endix B
Matrox Axio 工作流程

本附录提供不同类型的项目在
Adobe Premiere Pro 中的工作流
程，及您可以使用的多种 Matrox 编
解码器及视频格式。
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附录
总介
本附录介绍关于在 Adobe Premiere Pro 中处理不同类型的项目时使用的多
种 Matrox Axio 项目设置。我们使用工作流程图以更好地解释在使用常用
的高清和标清格式时的工作流程。

使用标准清晰度 “24P”素材
Matrox Axio 允许您选择一个 Premiere Pro 预设，以处理以 23.98 fps 或
24 fps 采集的标清素材。当您选择 Matrox 486p @ 23.98 fps 项目预设
时，只要素材是以 23.98 fps 或 24 fps 格式采集的，您就可以以 23.98 
fps 逐行扫描格式编辑标清素材。这包括由以 486p @ 23.98 fps 格式摄像
机拍摄到磁带上的素材和以 24 fps 格式拍摄到胶片上并通过电视电影机
转录到磁带上的素材。您不可以使用 486p @ 23.98 fps 格式项目预设采集
或编辑以 NTSC 或 PAL 拍摄下来的视频。

无论原来是什么制式，以 23.98 fps （或以 24 fps 拍摄再转到视频磁带
上）格式采集的标清素材在录制到磁带上的时候都需要经过格式转换转成
NTSC （486i @ 29.97 fps）制式。这表明从您的源设备的输出和 Matrox 
Axio 的输入的格式总会是 NTSC。您的源设备在将素材录制到磁带上时加
一个下拉处理，将 23.98 fps 的素材转换为 NTSC 格式。

对于可以以 23.98 fps 逐行扫描格式拍摄的 DV 摄像机来说，有些摄像机
有添加标准或是高级下拉的选项，以录制到磁带。我们建议您将摄像机设
置为使用高级下拉 （某些摄像机叫做 24PA 或 24P Advanced 方式），以将
素材转换为 29.97 fps 隔行扫描视频，在 Matrox Axio 上编辑。当使用高
级下拉选项时，以 23.98 fps 格式采集的帧在录制到磁带上时被打了标
记，Matrox Axio 在采集时就可以检测到这些标记，可以加高级反下拉处
理，将输入的视频转换为 486p @ 23.98 fps 以在 Adobe Premiere Pro。
中编辑。

对于以 24 fps 拍摄的胶片，标准 2:3 下拉处理是添加视频场，以将 24 
fps 转换成 29.97 fps 格式的最常用的方法。在这种情况下，Matrox Axio
在采集过程中加一个 2:3 下拉处理。要做到这一点，Matrox Axio 通过检
测到以 0或 5 为编号的帧来确定视频序列的 A帧。
B， Matrox Axio 工作流程
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从 Matrox Axio 输出的 486p @ 23.98 fps 项目均为 NTSC 制。对于
DV-1394 输出， Axio 提供选择高级下拉还是标准下拉的选项。在大多数情
况下，您只在视频需要进一步处理或是需要存档的情况下才选择高级
2:3:3:2 下拉。否则，系统在将 486p @ 23.98 fps 项目输出到磁带上时将
使用标准 2:3 下拉。如果您使用其它输出，如 SDI，Axio 使用标准下拉。
要了解更多关于标准 2:3 下拉和高级 2:3:3:2 下拉的信息，见附录 A “标
准和高级下拉”。
使用标准清晰度“24P”素材
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附录
486p @ 23.98 fps 工作流程举例
以下工作流程图显示在 Matrox Axio 上的典型 486p @ 23.98 fps 工作流
程：

DV camera performs
either standard or
advanced pulldown
(depending on mode
selection) when the
acquired footage is
recorded to DV tape.

Exported to
DV tape as
NTSC video

Exported to
tape as

NTSC video
for broadcast

Exported to disk as
MPEG-2 IBP for

DVD authoring or
exported to disk to

streaming video
format for web

Matrox Axio
using a

486p @ 23.98 fps
project preset

SD video
footage

acquired at
23.98 fps

progressive
scan

Film footage
shot

at 24 fps

NTSC video
on tape

NTSC video
on tape

DV-1394 input
and output

Analog or SDI
input and output

Matrox Axio detects
original pulldown
method, then performs
either an advanced
reverse pulldown
(2:3:3:2 cadence) or
standard reverse
pulldown (2:3 cadence).

Depending on the
user’s selection
of pulldown
method, Matrox
Axio performs
either advanced
2:3:3:2 pulldown
or standard 2:3
pulldown.

DV camera performs
either standard or
advanced pulldown
(depending on mode
selection) when the
acquired footage is
recorded to DV tape.

Film footage
telecined and
transferred to an SD
video tape format.
Standard 2:3
pulldown is
performed with A
frames appearing at
time codes 0 and 5.

Matrox Axio
performs standard
reverse pulldown
(2:3 cadence).

Matrox Axio
performs
standard 2:3
pulldown.
B， Matrox Axio 工作流程
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使用高清晰度素材
Matrox Axio 提供多种常用高清视频格式用的 Premiere Pro 项目预设，包
括 720p @ 59.94 fps、1080p @ 23.98 fps、24 fps 或 25 fps 和 1080i @ 
25 fps 或 29.97 fps。 对于每种高清视频格式，Axio 有不同的高清视频编
解码器，可以以不同视频质量采集和输出视频。您可以使用适合源素材格
式的编解码器采集素材，并按需要将素材混合在一起。比如，您可以在时
间线上混合脱机高清格式、MPEG-2 I- 帧 HD、HDV、DVCPRO HD 和无压缩的
高清素材。要了解如何使用 Matrox 编解码器处理高清项目，见下一节
“关于 Matrox 高清晰度编解码器”。

在某些情况下，Matrox Axio 加一个下拉处理，这样您就可以采集与您的
项目设置不一样的高清格式。比如，要采集 1080i @ 29.97 fps 源视频素
材，以用于一个 1080p @ 23.98 格式的项目，Axio 会在采集过程中给视频
加一个标准反下拉处理。要了解更多关于如何在高清项目中加下拉处理的
信息，见 204 页 “在高清项目中应用下拉”。

关于 Matrox 高清晰度编解码器 
在创建高清视频项目时，需要做一些编辑决定，包括选择适合的高清视频
编解码器。Matrox Axio 系统提供不同的高清视频编解码器，可以完成脱
机编辑和完成质量的编辑。以下是一些 Matrox HD 高清视频编解码器和它
们的用途介绍： 

• Matrox 脱机高清编解码器 将视频采集和输出为代理高清格式，用于
脱机编辑，以使用少一些的磁盘空间。还有一个 Video for Windows 
（VFW）版本的脱机高清编解码器，用于使用 VFW 程序。当在一个无
Matrox Axio 硬件的系统 （如笔记本电脑）上安装此编解码器时， 系
统可用于在 Adobe Premiere Pro 上完成脱机编辑。要了解使用
Matrox 脱机高清编解码器的工作流程的例子，见 194 页 “使用
Matrox 脱机高清晰度编解码器”。

• Matrox MPEG-2 I-帧高清编解码器 将视频采集和输出为MPEG-2 I-帧
高清格式，提供高质量、低比特率视频，可以用于脱机编辑项目或是
联机编辑项目。Matrox VFW MPEG-2 I- 帧编解码器可以使用 VFW 程序
（如 Adobe After Effects）将素材生成为全高清质量的视频。这个编
解码器只能在安装了 Matrox Axio 硬件的系统上才能使用。 要了解使
用 Matrox MPEG-2 I- 帧高清编解码器的工作流程的例子，见 201 页
“使用 Matrox MPEG-2 I 帧高清编解码器”。

• Matrox 8-bit 和 10-bit 无压缩高清编解码器 将视频采集和输出为
MPEG-2 I- 帧高清格式，提供全分辨率、完成质量的高清视频，可以
用于联机编辑项目。Matrox VFW 无压缩高清编解码器可以使用 VFW 程
序 （如 Adobe After Effects）在 Matrox Axio 上生成全分辨率、完
成质量的高清视频。 要了解使用使用 Matrox 8-bit 和 10-bit 无压缩
度高清编解码器的工作流程的例子，见 203 页 “使用 Matrox 8-bit
和 10-bit 无压缩度高清编解码器”。
使用高清晰度素材
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附录
注：Axio LE 只支持播放 10-bit 无压缩高清视频。

• Matrox DVCPRO HD 编解码器 将视频采集和输出为全分辨率完成质量
的 DVCPRO HD 格式，用于联机编辑项目。此编解码器只支持 1080i 
@ 25 fps、 1080i @ 29.97 fps 或 720p @ 59.94 fps 格式的项目。 Matrox 
VFW DVCPRO HD 编解码器可以使用 VFW 程序，如 Adobe After Effects
将素材生成为 DVCPRO HD 格式。此编解码器只可以用于安装了
Matrox Axio 硬件的系统。

使用 Matrox 脱机高清晰度编解码器
Matrox 脱机高清编解码器可以以低分辨率和低数据率 （低于 7 Mb/sec）
采集脱机高清视频，在 Premiere Pro 项目中使用。当在 Matrox Axio 系统
上使用这些素材时，在高清监示器上观看或是输出到磁带时，它们会被放
大为全屏尺寸。在一套未安装 Matrox Axio 硬件的系统上，脱机高清素材
显示为低分辨率素材。Matrox 脱机高清素材和全分辨率高清素材可以放在
同一条时间线上。

您可以使用 Matrox 脱机高清编解码器采集即将用在远程编辑系统上的素
材，比如像笔记本电脑这样没有很大的存储器的设备。在这种情况下，您
使用 Matrox Axio 系统的 Matrox 脱机高清编解码器采集高清素材，再将
低分辨率的素材传输到远程的编辑站上。高清项目完成后，您可以将
Premiere Pro 项目复制到 Axio 系统上，再只将您用到的素材重新以全分
辨率采集一次。 

创建脱机编辑项目
要创建一个脱机编辑的高清项目，您必须使用 Matrox Axio 系统的 Matrox 
脱机高清编解码器将高清素材以低分辨率采集到计算机中。如果您计划使
用远程编辑工作站，如笔记本电脑，您还需要使用脱机高清编解码器将采
集到的素材转到远程编辑系统的硬盘上。

要创建新的脱机高清编辑项目：

1 选择 File > New，创建一个新的 Adobe Premiere Pro 项目，从
Available Presets 中扩展 Matrox - HD 文件夹，为您需要创建的项目
类型选择 Offline 预设。

2 按 76 页 “定义采集设置”所述选择采集设置。

3 使用 Matrox 脱机高清编解码器采集素材。

您可以在当前的项目中使用脱机高清素材，或是将素材转到一个远程的
Premiere Pro 编辑工作站上。如果您希望在远程的编辑工作站上完成脱机
高清项目，见下一节。如果您希望在 Matrox Axio 上完成脱机高清项目，
见 196 页 “使用高清分辨率再采集素材”。
B， Matrox Axio 工作流程
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在远程编辑工作站制作脱机高清项目
如前文所述，Matrox VFW 脱机高清编解码器可以在未安装 Matrox Axio 硬
件的系统上使用 Adobe Premiere Pro 脱机编辑低分辨率高清素材。但您必
须在这个素材上安装 Matrox VFW 软件编解码器 （见 53 页 “在无 Axio 硬
件的系统上安装 Matrox VFW 软件编解码器”）。

要创建可以让您使用在 Matrox Axio 上创建的脱机高清素材的 VFW 项目，
您必须使用以下项目设置：

要在一台远程编辑工作站上创建 VFW 脱机高清项目：

1 选择 File > New > Project，创建一个新的 Adobe Premiere Pro 项目，
从 New Project 中对话框中，选择 Custom Settings 。

2 在 Custom Settings页面下，确保选择了 General并按上表设置，为您需
要的项目类型选择合适的 Premiere Pro 总设置，如下图所示：

3 从左边的对话框中，选择 Video Rendering。

VFW 总项目设置

1080p @ 23.98 
fps、24 fps 或 25 

fps 
Axio 项目

1080i @ 25 fps 或
29.97 fps Axio 项

目

720p @ 59.94 fps 
Axio 项目

编辑方式 桌面 桌面 桌面

帧尺寸 480×270 480×270 320×180

时基
23.976 fps、24 fps

或 25 fps
25 fps 或 29.97 fps 59.94 fps

像素宽高比 方形像素 （1.0） 方形像素 （1.0） 方形像素 （1.0）

场 无场 第一场第一 无场
使用 Matrox 脱机高清晰度编解码器
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附录
4 在 Compressor 清单中选择 Matrox Offline HD 格式。

5 点击 OK 存储项目设置。要了解如何选择其它项目设置，见 Adobe 
Premiere Pro 文件。

当您完成编辑并调整好您的脱机高清项目时，您将需要将 Premiere Pro 
项目文件 （.prproj）复制到 Matrox Axio 系统上，这样您可以将它输入
到一个新的联机项目上，以高分辨率重新采集素材，如下节所述。

使用高清分辨率再采集素材
当您完成编辑并调整好您的脱机高清项目时，您将需要将 Premiere Pro 
项目文件 （.prproj）输入到一个联机项目中，这样您可以以高分辨率重
新采集素材。 

要以高清分辨率重新采集项目素材：

1 如果您未准备好这样做，使用 Adobe Premiere Pro 项目 Manager 再精
确调整素材，这样您就可以只采集您项目中使用过的素材了。要了解
如何这样做，见您的 Adobe Premiere Pro 文件。

2 选择 File > New > Project，在Matrox Axio系统上创建一个新的Adobe 
Premiere Pro 项目，从 Available Presets 清单中，扩展 Matrox - HD

文件夹，为您要创建的项目选择预设，如 MPEG-2 I- 帧。

重要：您的新联机项目的格式必须与您要输入的脱机项目格式一样。
比如，一个 480×270 @ 23.98 fps 格式的脱机项目必须要输入到一个
1080p @ 23.98 fps 项目中。

3 选择 File > Import，并找到您的脱机 Premiere Pro 项目 （.prproj）
文件，将脱机项目输入到新的联机项目中。

提示：要在 Import 对话框中看到 .prproj文件清单，您需要从 Files 

of type 清单中选择 Adobe Premiere Pro Project （.prproj）。

4 如果您要输入在未安装 Matrox Axio 硬件的远程编辑工作站上创建的
Adobe Title Designer 文件 （.prtl 文件），此文件的尺寸必须修
改。要做到这一点，在 ProjectProject 窗口中双击文件。Adobe 
Premiere Pro 将提示您转换视频设置。点击 Yes，存储字幕文件。

5 在 Project 窗口中，扩展项目文件夹，选择所有需要重新采集的素材，
再选择 Project > Make Offline。

6 在 Make Offline 对话框中，选择以下一选项，再点击 OK：

- Media Files Remain On Disk 如果您希望选择的文件脱机，但不想
从硬盘上删除源文件，选择此项。

- Media Files Are Deleted 如果您需要从硬盘上删除源文件，选择
此项。

7 确保 Project 窗口中的所有素材都被选择，再选择
Clip > 播放 Settings > Set 播放 Settings。
B， Matrox Axio 工作流程
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8 点击 Configure钮，在播放 Format下，选择您需要用来再采集脱机素材
的高清格式。

9 如果您选择了 MPEG-2 I-frame HD，点击 Configure钮调整 MPEG-2 I- 帧
设置，要了解可用的设置的详情，见 86 页 “选择 MPEG-2 I 帧设
置”。 

10 点击 OK 存储采集设置。

11 要开始再采集素材，选择 File > Batch Capture。

要了解批采集素材的信息，见您的 Adobe Premiere Pro 文件。
使用 Matrox 脱机高清晰度编解码器
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附录
脱机高清晰度编解码器工作流程举例

以下两个工作流程的例子介绍 Matrox 脱机高清编解码器的两种不同用法。
在第一个例子中，编解码器用于将素材采集为脱机高清格式，用于脱机编
辑项目。在第二个例子中，编解码器用于将素材输出为脱机高清格式，用
于脱机编辑项目。

采集脱机高清素材的工作流程举例
在这个工作流程例子中，Matrox 脱机高清编解码器被用于采集视频，用于
需要在一台远程编辑系统上完成的脱机编辑项目。因为远程系统安装了
Matrox VFW 软件编解码器，可使用 Adobe Premiere Pro 进行脱机编辑。
脱机编辑完成并且对项目精确调整 （使用 Adobe Premiere Pro 项目 
Manager）后，Premiere Pro 项目 （.prproj）文件被传输到 Matrox Axio
系统上，用于制作完整的项目联机版本。

在 Matrox Axio 上，使用联机质量的项目预设创建新的联机项目，比如无
压缩的高清项目预设。脱机项目文件再被输入到新的联机项目中。脱机素
材被去掉链接，再使用这个项目预设的编解码器以全分辨率重新采集。联
机编辑项目再输出到磁带用于播出。 
B， Matrox Axio 工作流程
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工作流程如下图所示：

A new Matrox Axio
online editing project is

created using any
finishing-quality HD
video project preset,

such as MPEG-2
I-frame HD, or an

Uncompressed HD
project preset.

The offline project is
imported into the new
project, and the offline
clips are unlinked and

recaptured at full
resolution.

Offline clips
transferred to
remote editing
system.

Matrox Axio offline
editing project using

any Offline HD
project preset

Matrox Offline HD
codec used to
capture clips

Exported to tape as
finishing-quality HD
video for broadcast

Video footage
shot as any

supported HD
format

Remote editing
system with Matrox

VFW codecs
installed. The offline

edit is completed and
trimmed on the

system using Adobe
Premiere Pro with

the appropriate
project setting
(for example,

480x270, 23.98 fps).

Offline edit
Premiere
Pro project
( ) file
transferred
to Matrox
Axio system.

.prproj
使用 Matrox 脱机高清晰度编解码器
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附录
输出脱机高清素材的工作流程举例
在这个工作流程例子中，Matrox 脱机高清编解码器被用于采集视频，用于
联机编辑项目。还可以使用 Matrox MPEG-2 I- 帧高清编解码器采集联机质
量的视频，用于此工作流程。使用 Matrox 脱机高清编解码器将素材从时
间线上输出到磁盘，再传输到一台远程编辑工作站上。脱机编辑完成后，
Premiere Pro 项目 （.prproj）文件被传输到 Matrox Axio 系统上，用于
制作完整的项目联机版本。 

在 Matrox Axio 上，脱机项目文件输入到原来的联机项目中，每个脱机素
材都使用 Premiere Pro 的 Link Media 命令与源文件相连，项目再输出到
磁带用于播出。

工作流程如下图所示：

Matrox 8-bit or 10-bit
Uncompressed HD codec is used to

capture clips

Video footage shot as any
HD format

The offline clips are linked to their
original source files (using

command).
The online project is then exported

to tape as finishing-quality HD video
for broadcast.

Link
Media

Matrox Axio online editing project
using any Uncompressed HD

project preset

Remote editing
system with Matrox

VFW codecs
installed. The offline

edit is completed and
trimmed on the

system using Adobe
Premiere Pro with

the appropriate
project setting
(for example,

480x270, 23.98 fps).
Offline edit
Premiere Pro
project ( )
file is imported
into the online
editing project
on Matrox Axio.

.prproj

Clips are
exported to
disk using the
Matrox Offline
HD codec and
transferred to a
remote editing
workstation.
B， Matrox Axio 工作流程
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使用 Matrox MPEG-2 I 帧高清编解码器
Matrox MPEG-2 I- 帧高清编解码器令您可以控制采集或输出的视频的数据
率。低数据率 （约 50 Mb/sec）时，编解码器可用于采集视频，用于脱机
编辑的项目。高数据率时 （100 Mb/sec 及以上），编解码器可用于采集高
质量视频，用于联机编辑项目，使用的磁盘空间比无压缩视频项目少。对
于不需要无压缩视频数据以合成的高清项目，MPEG-2 I- 帧高清编解码器
可用于输出完成质量的高清广播视频。VFW MPEG-2 I- 帧高清编解码器可
在 VFW 程序 （如 Adobe After Effects）中生成并播放 MPEG-2 I- 帧高清
素材。要使用 Matrox VFW MPEG-2 I- 帧高清编解码器，系统必须安装了
Matrox Axio 硬件。

MPEG-2 I- 帧高清编解码器脱机编辑工作流程举例
在以下的工作流程例子中，Matrox MPEG-2 I- 帧高清编解码器用于采集视
频素材，用于脱机编辑项目。素材通过 Matrox Axio 以 50 Mb/sec 数据率
采集，再用于完成脱机编辑项目。当脱机编辑完成时，项目精确调节完
毕，脱机素材的链接断开，再使用完成质量的高清编辑解码器 （如数据率
为 100 Mb/sec 及以上的 Matrox MPEG-2 I- 帧高清编解码器或是 Matrox 
无压缩高清编解码器）重新采集。联机编辑项目完成后，再输出用于播
出。
使用 Matrox MPEG-2 I 帧高清编解码器
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附录
工作流程如下图所示： 

MPEG-2 I 帧高清编解码器联机编辑工作流程举例
在以下的工作流程例子中，Matrox MPEG-2 I- 帧高清编解码器用于采集视
频素材，用于联机编辑项目。素材通过 Matrox Axio 以 100 Mb/sec 及以上
数据率采集，再用于完成联机编辑项目。 联机编辑项目完成后，再输出用
于播出。 

Video footage shot as any
supported HD format

Matrox MPEG-2 I-frame HD
codec set at 50 Mb/sec used

to capture clips

Matrox Axio offline editing
project using any Matrox

MPEG-2 I-frame HD project
preset

Offline project is trimmed,
offline clips are unlinked and
recaptured usng a finishing-
quality HD codec, such as

MPEG-2 I-frame HD at
100 Mb/sec or higher

Exported to tape as finishing-
quality HD video for broadcast
B， Matrox Axio 工作流程
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工作流程如下图所示：

使用 Matrox 8-bit 和 10-bit 无压缩高清编解码器
对于短视频项目或是磁盘空间足够时，可使用 Matrox 无压缩高清编解器
采集全分辨率完成质量的高清视频。Matrox VFW 无压缩高清编解码器可以
使用 VFW 程序 （如 Adobe After Effects）生成并播放无压缩高清视频，
用于 Matrox Axio 中。

注：Axio LE 只支持播放 10-bit 无压缩高清视频。

Matrox 无压缩编解码器工作流程举例
在以下的工作流程例子中，Matrox 无压缩高清编解码器用于采集视频素
材，用于联机编辑项目。某些素材被传输到安装了 Matrox VFW 无压缩编
解码器的合成工作站上。在使用 VFW 程序 （如 Adobe After Effects）合
成后，这些素材使用 Matrox VFW 无压缩高清编解码器生成，用于在
Matrox Axio 系统上编辑。联机编辑项目在 Axio 上完成后，再输出用于播
出。 

Exported to tape as finishing-quality
HD video for broadcast

Matrox MPEG-2 I-frame HD codec
set at 100 Mb/sec or higher used to

capture clips

Video footage shot as any
supported HD format

Matrox Axio online editing project
using any MPEG-2 I-frame HD

project preset

VFW application on the
Axio system, such as

Adobe After Effects, uses
the MPEG-2 I-frame HD
clips. The compositing

project is rendered using
the Matrox VFW MPEG-2

I-frame HD codec.

Clips rendered using
the Matrox VFW
MPEG-2 I-frame HD
codec are imported into
the online editing
project.

MPEG-2 I-frame HD
clips used in a VFW
application on the
Axio system.
使用 Matrox 8-bit 和 10-bit 无压缩高清编解码器
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工作流程如下图所示：  

在高清项目中应用下拉 
视您的高清项目设置不同，Matrox Axio 加了一个下拉处理，这样您可以
采集一个与您的项目不同的高清格式 （输入格式）。在处理 1080p @ 
23.98 fps 项目时，只要原素材是以 23.98 fps 或 24 fps 采集的，您就可
以采集 1080i @ 29.97 fps 素材并在 1080p @ 23.98 项目中使用。这包括
以 24 fps 拍摄到胶片上，再使用电视电影机以 1080i @ 29.97 fps 转到磁
带上素材。在这种情况下，Matrox Axio 在采集 1080i @ 29.97 素材用于
1080p @ 23.98 fps 项目时添加一个标准反下拉处理。

重要：使用高清摄像机以 1080i @ 29.97 fps （未经电视电影机处理）格
式处理的素材不适合用于 1080p @ 23.98 fps 项目。您应使用 1080i @ 
29.97 fps 格式项目用于处理这类素材。

您可以将完成的 1080p @ 23.98 fps 项目以 1080p @ 23.98 fps、1080i @ 
29.97 fps 或 NTSC 格式输出。要以 1080i @ 29.97 fps 或 NTSC 格式输出
项目，需要加标准的 2:3 下拉以将视频转换为适合的格式。

Exported to tape as finishing-quality
HD video for broadcast

Matrox 8-bit or 10-bit
Uncompressed HD codec used to

capture clips

Video footage shot as any
supported HD format

Matrox Axio online editing project
using any Uncompressed HD

project preset

Compositing workstation
with the Matrox VFW

codecs installed uses a
VFW application such as
Adobe After Effects. The
completed compositing

project is rendered using a
Matrox VFW

Uncompressed HD codec.

Clips rendered using
the Matrox VFW
Uncompressed HD
codec are imported
into the online
editing project.

Uncompressed
HD clips
transferred to
compositing
workstation.
B， Matrox Axio 工作流程
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1080p @ 23.98 fps 工作流程举例
以下图显示使用在 Matrox Axio 上编辑项目时使用 1080p @ 23.98 fps 预
设的工作流程：

Matrox Axio
performs standard
2:3 pulldown.

Exported to tape as
1080i @ 29.97 fps

finishing-quality video for
broadcast

Matrox Axio editing
project using any
finishing-quality

1080p @ 23.98 fps
project preset

Matrox finishing-quality
HD (MPEG-2 I-frame HD
or Uncompressed HD)
codec used to capture

clips

HD video footage shot as
1080p @ 23.98 fps

Film footage shot at
24 fps and transferred

by telecine to
1080p @ 23.98 fps

HD video

Exported to tape as
1080p @ 23.98 fps

finishing-quality video for
broadcast

Exported to tape as
NTSC finishing-quality

video for broadcast

Film footage shot at
24 fps and transferred

by telecine to
1080i @ 29.97 fps

HD video

Matrox Axio performs standard
reverse pulldown (2:3 cadence)
with A frames appearing at time
codes 0 and 5.
在高清项目中应用下拉
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其它 Matrox Axio HD 工作流程
本节将举例介绍在不加下拉处理时 Matrox Axio HD 的工作流程。 

1080i @ 29.97 fps 工作流程举例
在制作 1080i @ 29.97 fps 格式项目时，您必须使用 1080i @ 29.97 fps
格式的视频作为源素材。您可以将项目以 1080i @29.97 或 NTSC 格式输出
到磁带。以下图提供在 Matrox Axio 上使用 1080i @ 29.97 fps 预设的典
型工作流程：

Film footage telecined
and transferred to HD
tape. Standard 2:3
pulldown performed.

Matrox Axio editing
project using any
finishing-quality

1080i @ 29.97 fps
project preset

Matrox finishing-quality
HD (MPEG-2 I-frame HD
or Uncompressed HD)
codec used to capture

clips

1080i @ 29.97 fps
video

HD video footage
shot as

1080i @ 29.97 fps

Exported to tape as
1080i @ 29.97 fps

finishing-quality video for
broadcast

Exported to tape as
NTSC finishing-quality

video for broadcast

Film footage shot
at 24 fps
B， Matrox Axio 工作流程
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1080p 和 1080i @ 25 fps 工作流程举例
在制作 1080p @ 25 fps 或 1080i @ 25 fps 格式项目时，您可以使用
1080i @ 25 fps 或 1080p @ 25 fps 素材作为源视频素材。虽然输入格式
总是设置得与项目视频格式一样，1080p @ 25 fps 和 1080i @ 25 fps 源
视频都可以采集并用于 25 fps 高清项目中。使用 Matrox Axio 采集这些素
材后，它们以项目视频格式存储到磁盘中。

比如，如果您采集 1080i @ 25 fps 格式视频，用于 1080p @25 fps 格式项
目中，素材在存储到磁盘时被转换成 1080p @ 25 fps。因此，如果源素材
格式与项目格式不同，在加特技时，有可能出现一些意想不到的结果。我
们建议您使用同样的格式的素材源。下图显示使用 Matrox Axio 制作
1080p @ 25 fps 或 1080i @ 25 fps 项目时典型的工作流程： 

Matrox Axio editing
project using any
finishing-quality
1080p @ 25 fps

or
1080i @ 25 fps
project preset

Matrox finishing-quality
HD (MPEG-2 I-frame HD
or Uncompressed HD)
codec used to capture

clips

Exported to tape as
1080p @ 25 fps or

1080i @ 25 fps
finishing-quality video for
broadcast (output format
matches project's format)

Exported to tape as PAL
finishing-quality video

for broadcast

1080i @ 25 fps
video on tape

1080p @ 25 fps
video on tape

HD video footage
shot as

1080p @ 25 fps

HD video footage
shot as

1080i @ 25 fps
其它 Matrox Axio HD 工作流程
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720p @ 59.94 fps 工作流程举例
在制作 720p @ 59.94 fps 格式项目时，您的输入格式必须也是 720p @ 
59.94 fps 但您可以选择输出为 720p @ 59.94 fps 或 NTSC。

下图显示使用 Matrox Axio 制作 720p @ 59.94 fps 项目时典型的工作流
程： 

Film footage telecined
and transferred to HD
video tape.

Matrox Axio editing
project using any
finishing-quality

720p @ 59.94 fps
project preset

Matrox finishing-quality
HD (MPEG-2 I-frame HD
or Uncompressed HD)
codec used to capture

clips

720p @ 59.94 fps
video on tape

HD video footage
shot as

720p @ 59.94 fps

Exported to tape as
720p @ 59.94 fps

finishing-quality HD video
for broadcast

Exported to tape as
NTSC finishing-quality

video for broadcast

Film footage shot
at 24 fps
B， Matrox Axio 工作流程
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1080p @ 24 fps 工作流程举例
在制作 1080p @ 24 fps格式项目时，您的输入和输出格式必须也是 1080p @ 
24 fps。

注：1080p @ 24 fps 只能在 Matrox Axio HD 或 LE 系统上创建或编辑。

下图显示使用 Matrox Axio 制作 1080p @ 24 fps 项目时典型的工作流程：

Film footage telecined
and transferred to HD
video tape.

Matrox Axio editing
project using any
finishing-quality
1080p @ 24 fps
project preset

Matrox finishing-quality
HD (MPEG-2 I-frame HD
or Uncompressed HD)
codec used to capture

clips

1080p @ 24 fps
video on tape

HD video footage
shot as

1080p @ 24 fps

Exported to tape as
1080p @ 24 fps

finishing-quality HD video
for broadcast

Film footage shot
at 24 fps
其它 Matrox Axio HD 工作流程
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在 Matrox Axio SD 系统上制作高清项目
Matrox Axio SD 系统可以编辑高清项目，为您带来更多灵活性。换句话
说， Matrox Axio HD、 SD 和 LE 系统间可以无缝共享高清项目。您在
Matrox Axio SD 系统上打开或是编辑一个高清项目时，系统的视频输出会
视项目的视频格式自动下转换为 NTSC 或 PAL 制，视频处理格式设置为
8-bit。由于下转换的质量高，您可以使用标清视频监示器观看高清编辑项
目。

所有 Matrox Axio 系统均支持原始 HDV 和 DVCPRO HD 编辑。虽然您无
法使用 Matrox Axio SD 系统的模拟或 SDI 输入采集高清素材，您可以通过
1394 接口采集原始 HDV 和 DVCPRO HD 素材，在高清项目中编辑。在编
辑完，准备输出高清项目时，您可以使用 Matrox Axio SD 系统输出标清格
式 （将高清视频下转换为 NTSC 或 PAL 制），或通过 1394 接口输出为
HDV 或 DVCPRO HD 格式。

注：Matrox Axio SD 系统不能编辑 1080p @ 24 fps。

下图显示在 Matrox Axio SD 上编辑高清项目的典型工作流程：

Clips and project are
stored on a shared
storage device. The
project can then be
opened on Matrox
Axio HD, SD, or LE
for editing.

Deliver as SD, or deliver
as HD over the 1394

interface
Deliver as HD or SD

Matrox Axio editing
project using an HD

project preset
(except 1080p @ 24 fps)

HDV or DVCPRO HD
clips captured natively
over the 1394 interface

on Matrox Axio SD

Matrox Axio editing
project using an HD

project preset
(except 1080p @ 24 fps)

Matrox Axio HD or LE Matrox Axio SD

HDV or DVCPRO
HD clips captured
natively over the
1394 interface on
Matrox Axio HD

or LE

Clips captured from
SDI input on Matrox
Axio HD or LE using

any HD codec
B， Matrox Axio 工作流程
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支持的视频压缩格式

Matrox Axio HD

1 DVCPRO HD 只被 1080i @ 25fps、1080i @ 29.97 fps 或 720p @ 59.94 fps 格式的项

目支持。

2 HDV 只 1080i @ 25 fps 或 1080i @ 29.97 fps 格式的项目支持。

3 您可以实时播放某些高清项目的标清素材。要了解详情，见 57 页 “在高清项目

里使用标清素材”。

4 在将一个高清项目输出为 Matrox .avi文件时，您可以选择将高清视频下转换为任

何支持的标清视频格式。要了解详情，见 83 页 “Premiere Pro 输出到磁盘”。

SD 项目 HD 项目

采集

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧

DV-1394 和 SDI 输入：
DVCPRO HD1

只有 DV-1394 输入：
HDV2

只有 SDI 输入：
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式

播放

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧
Matrox DigiSuite 和 RT 系
列文件

DVCPRO HD1

HDV2

8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式
（可以播放某些项目中的标
清素材）3

输出到磁盘

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧

DVCPRO HD1

8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式
（可下转换为任何支持的标
清格式）4

生成预览

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧

DVCPRO HD1

脱机高清格式
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧 HD

DV-1394 输
出到磁带

DV/DVCAM
DVCPRO
DVCPRO50

DVCPRO HD1

HDV2
支持的视频压缩格式
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附录
Matrox Axio SD

1 DVCPRO HD 只被 1080i @ 25fps、1080i @ 29.97 fps 或 720p @ 59.94 fps 格式

的项目支持。

2 HDV 只 1080i @ 25 fps 或 1080i @ 29.97 fps 格式的项目支持。

3 您可以实时播放某些高清项目的标清素材。要了解详情，见 57 页 “在高清项目

里使用标清素材”。

4 在将一个高清项目输出为 Matrox .avi 文件时，您可以选择将高清视频下转换为

任何支持的标清视频格式。要了解详情，见 83 页 “Premiere Pro 输出到磁

盘”。

SD 项目
HD 项目
（视频处理精度设置为 
8-bit）

播放

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式 
MPEG-2 I- 帧

只有 DV-1394 输入：
DVCPRO HD1

HDV2

播放

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式 
MPEG-2 I- 帧
Matrox DigiSuite 和 RT 系
统文件

DVCPRO HD1

HDV2

8-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式
（可以播放某些项目中的标
清素材）3

输出到磁盘

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式 
MPEG-2 I- 帧

DVCPRO HD1

8-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式
（可下转换为任何支持的标
清格式）4

生成预览

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式 
MPEG-2 I- 帧

DVCPRO HD1

8-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式

DV-1394 输
出到磁带

DV/DVCAM
DVCPRO
DVCPRO50

DVCPRO HD1

HDV2
B， Matrox Axio 工作流程
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Matrox Axio LE

1 DVCPRO HD 只被 1080i @ 25fps、 1080i @ 29.97 fps 或 720p @ 59.94 fps 格式的

项目支持。

2 HDV 只 1080i @ 25 fps 或 1080i @ 29.97 fps 格式的项目支持。

3 您可以实时播放某些高清项目的标清素材。要了解详情，见 57 页 “在高清项目

里使用标清素材”。

4 在将一个高清项目输出为 Matrox .avi 文件时，您可以选择将高清视频下转换为

任何支持的标清视频格式。要了解详情，见 83 页 “Premiere Pro 输出到磁

盘”。

SD 项目
（视频处理精度设置为 
8-bit）

HD 项目
（视频处理精度设置为 
8-bit）

播放

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
MPEG-2 I- 帧

DV-1394 和 SDI 输入：
DVCPRO HD1

只有 DV-1394 输入：
HDV2

只有 SDI 输入：
8-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式

播放

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧
Matrox DigiSuite 和 RT
系列文件

DVCPRO HD1

HDV2

8-bit 无压缩格式
10-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式
（某些项目可以播放标清素
材）3

输出到磁盘

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
MPEG-2 I- 帧

DVCPRO HD1

8-bit 无压缩格式
MPEG-2 I- 帧 HD
脱机高清格式
（还可以下转换为任何支持
的标清格式）4

生成预览

DV/DVCAM
DVCPRO
DVCPRO50
8-bit 无压缩格式
MPEG-2 I- 帧

DVCPRO HD1

脱机高清格式
8-bit 无压缩格式
MPEG-2 I- 帧 HD

DV-1394 输
出到磁带

DV/DVCAM
DVCPRO
DVCPRO50

DVCPRO HD1

HDV2
支持的视频压缩格式
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附录
Matrox Axio HD 和 SD 支持的母版输出格式
下表显示在不同项目视频格式下支持的母版输出格式。

项目视频格式
Matrox Axio HD 支持
的母版输出格式

Matrox Axio SD 支持
的母版输出格式

NTSC NTSC NTSC

PAL PAL PAL

486p @ 23.98 fps NTSC NTSC

1080i @ 25 fps 1080i @ 25 fps 或 PAL PAL

1080i @ 29.97 fps
1080i @ 29.97 fps 或
NTSC NTSC

1080p @ 23.98 fps
1080p @ 23.98 fps， 
1080i @ 29.97 fps 或 
NTSC

NTSC

1080p @ 24 fps 1080p @ 24 fps 不支持

1080p @ 25 fps 1080p @ 25 fps 或 PAL PAL

720p @ 59.94 fps
720p @ 59.94 fps 或 
NTSC NTSC
B， Matrox Axio 工作流程
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Matrox Axio LE 支持的主要及辅助 SDI 输出格式
下表显示在不同项目视频格式下 Matrox Axio LE 支持的主及辅 SDI 输出格
式。

注：Matrox Axio LE 上的模拟输出可以设置为与主或辅 SDI 输出一样的格
式。但如果您在编辑标清项目或是 1080p @ 24 fps，模拟输出将被设置为
与主 SDI 输出一样的格式。

项目视频格式 支持的主 SDI 输出格式 支持的辅 SDI 输出格式

NTSC NTSC NTSC

PAL PAL PAL

486p @ 23.98 fps NTSC NTSC

1080i @ 25 fps 1080i @ 25 fps PAL

1080i @ 29.97 fps 1080i @ 29.97 fps NTSC

1080p @ 23.98 fps
1080p @ 23.98 fps or
1080i @ 29.97 fps NTSC

1080p @ 24 fps 1080p @ 24 fps 不支持

1080p @ 25 fps 1080p @ 25 fps PAL

720p @ 59.94 fps 720p @ 59.94 fps NTSC
Matrox Axio LE 支持的主要及辅助 SDI 输出格式
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附录
笔记
B， Matrox Axio 工作流程



Appendix C
Matrox Axio 技术规格

本附录提供 Matrox Axio 板卡、
X.linkHD 和 X.linkSD 接口盒的技
术规格。
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附录
X.io 板卡

总规格
PCI 接口 全 PCI-X 66/100 MHz 板卡

规格 FCC Class A， CE Mark Class A， ACA Class A

标称尺寸 板卡 12.2" x 4.2"
板卡包括托架 13.875"x 4.9
包括元件总厚度 0.75"

典型操作电压和电流

环境规格
· 板卡最低 /最高操作环境温度： 0 - 55º C
· 最低 / 最高存储温度：-40 - 75º C
· 最高工作高度：3,000 米

· 最高运输高度：12,000 米

· 工作湿度：相对湿度 20 - 80% （不凝露）

· 存储湿度：相对湿度 5 - 95% （不凝露）

重要： 要避免损坏 Matrox Axio 元件和计算机系统，确保您的 Axio 板
卡不是长时间工作在最高操作温度附近 ( 见 183 页 “监控 Axio 硬件
操作温度”了解更多信息 )。

 

 

 

 

 

 

 

 

 

电压 +3.3 V +5 V +12 V -12 V

电流 0.26 A 0.5 A 0.05 A 0 A

总功耗： 4.0 W
C，Matrox Axio 技术规格
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X.effects 板卡

总规格
PCI 接口 全 PCI-X 66/100 MHz 板卡

规格 FCC Class A， CE Mark Class A， ACA Class A

标称尺寸 板卡 12.2” × 4.2”
板卡包括托架 13.875” × 4.9”
包括元件总厚度 0.75

典型操作电压和电流

外部电源配置：

 总功耗： 50 W

内部电源配置：

 总功耗： 48 W

环境规格
· 板卡最低 /最高操作环境温度：0 - 55 º C
· 最低 / 最高存储温度：–40 - 75º C
· 最高工作高度：3,000 米

· 最高运输高度：12,000 米

· 工作湿度：相对湿度 20 - 80% （不凝露）

· 存储湿度：相对湿度 5 - 95% （不凝露）

重要： 要避免损坏 Matrox Axio 元件和计算机系统确保您的 Axio 板
卡不是长时间工作在最高操作温度附近 ( 见 183 页 “监控 Axio 硬件
操作温度”了解更多信息 )。

 

 

 

电压 +3.3 V +5 V +12 V –12 V

电流 0.62 A 0.48 A 3.8 A 0 A

电压 +3.3 V +5 V +12 V –12 V

电流 0.62 A 2.48 A 2.8 A 0 A
X.effects 板卡
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附录
X.linkSD 接口盒

总规格
视频制式 NTSC， PAL， NTSC-EIAJ

尺寸 12.875” × 3.5” × 2.975”

典型操作电压和电流

 总功耗： 19 W

视频输入信号

电压 +3.3 V +5 V +12 V –12 V

电流 0 A 1.2 A 0.9 A 0.18 A

信号类型 数目 电压 电阻

复合视频 1 1.0 Vp-p 75 Ω

Y/C 视频 1

亮度信号 
(Y)

色度信号 
(C)

1.0 Vp-p

PAL: 0.300 Vp-p burst

NTSC: 0.286 Vp-p burst

NTSC-EIAJ: 0.286 Vp-p burst

75 Ω

75 Ω

75 Ω

75 Ω

分量视频 1

亮度信号 
(Y)

色度信号 
(B-Y， R-Y)

1.0 Vp-p

PAL: 0.700 Vp-p ， 100% 彩条

NTSC: 0.700 Vp-p ，75% 彩条

NTSC-EIAJ: 0.757 Vp-p，75% 彩
条

75 Ω

75 Ω

75 Ω

75 Ω

SDI 视频 1 符合 SMPTE 259M 75 Ω

1394 1 200 mVp-p 110 Ω

参考输入 1 1.0 Vp-p 75 Ω
C，Matrox Axio 技术规格
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视频输出信号

音频输入 /输出信号

模拟平衡 （1 对立体声输入）

输入电阻 高阻

标称电平  +4 dBu， 18 dB 裕量

模拟平衡 （一对立体声输出）

输出电阻  50 Ω
标称电平  +4 dBu， 18 dB 裕量

可能增益  110 Ω

模拟不平衡 （1 对立体声输入）

输入电阻 高阻

标称电平 -10 dBV， 18 dB 裕量

信号类型 数目 电压 电阻

复合视频 1 1.0 Vp-p 75 Ω

Y/C 视频 1

亮度信号 
(Y)

色度信号 
(C)

1.0 Vp-p

PAL: 0.300 Vp-p burst

NTSC: 0.286 Vp-p burst

NTSC-EIAJ: 0.286 Vp-p burst

75 Ω

75 Ω

75 Ω

75 Ω

分量视频 1

亮度信号 
(Y)

色度信号 
(B-Y， R-Y)

1.0 Vp-p

PAL: 0.700 Vp-p ，100% 彩条

NTSC: 0.700 Vp-p ，75% 彩条

NTSC-EIAJ: 0.757 Vp-p，75% 彩
条

75 Ω

75 Ω

75 Ω

75 Ω

SDI 视频 1 符合 SMPTE 259M 75 Ω

1394 1 200 mVp-p 110 Ω
X.linkSD 接口盒
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附录
模拟不平衡 （1 对立体声输出）

输出电阻 100 Ω
标称电平 –10 dBV£¨ 18 dB 裕量

音频规格
取样频率 48 kHz ( 使用 64 倍过取样 )

量化 24 bits

环境规格
· X.linkSD 最低 / 最高操作温度 : 0 - 35º C
· 最低 / 最高存储温度：–40- 75º C
· 最高工作高度：3,000 米

· 最高运输高度：12,000 米

· 工作湿度：相对湿度 20 - 80% （不凝露）

· 存储湿度：相对湿度 5 - 95% （不凝露）

重要： 要避免损坏 Matrox Axio 元件和计算机系统确保您的 X.linkSD
卡不是长时间工作在最高操作温度附近 ( 见 183 页 “监控 Axio 硬件
操作温度”了解更多信息 )。

 

 

 

 

 

 

 

 

 

 

 

 

 

C，Matrox Axio 技术规格



223
X.linkHD 接口盒

总规格
视频制式 NTSC， PAL， NTSC-EIAJ， 1080i， 1080p/

PsF， 720p
尺寸 12.875"x 3.5" x 2.975"

典型操作电压和电流

 总功耗： 19 Watts

视频输入信号

 

 

 

 

 

 

 

 

 

 

 

 

 

电压 +3.3 V +5 V +12 V –12 V

电流 0 A 1.2 A 0.9 A 0.18 A

信号类型 数目 电压 电阻

SDI/HD-SDI 1 符合 
SMPTE 259M/SMPTE 292M

75 Ω

1394 1 200 mVp-p 110 Ω

参考输入 1 1.0 Vp-p 75 Ω
X.linkHD 接口盒
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附录
视频输出信号

音频输入 /输出信号

模拟平衡 （一对立体声输出）

输出电阻  50 Ω
标称电平  +4 dBu， 18 dB 裕量

可能增益  110 Ω

平衡 AES/EBU （2 对立体声输入）

输入电阻  110 Ω

最大输入电平  10 Vp-p 差分

平衡 AES/EBU （4 路立体声输出）

输出电阻  110 Ω 

标称输出电平  5 Vp-p 差分

 

 

信号类型 数目 电压 电阻

分量视频 1

亮度信号 
(Y)

1.0 Vp-p 75 Ω

色度信号 
(B-Y， R-Y)

PAL: 0.700 Vp-p，100% 彩条 75 Ω

NTSC: 0.700 Vp-p，75% 彩条 75 Ω

NTSC-EIAJ: 0.757 Vp-p，75% 彩
条

75 Ω

HD: 0.700 Vp-p，100% 彩条 75 Ω

或

色度信号 
(R，G，B)( 仅高清

)

(R， B): 0.700 Vp-p，100% 彩条
(G): 1Vp-p ( 带同步 )，100% 彩
条

75 Ω
75 Ω

SDI/HD-SDI
1 符合 

SMPTE 259M/SMPTE 292M
75 Ω

1394 1 200 mVp-p 110 Ω
C，Matrox Axio 技术规格
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音频规格
取样频率 48 kHz ( 使用 64 倍过取样 )

量化 24 bits

环境规格
 .linkHD 最高操作环境温度 : 0 - 35º C

· 最低 / 最高存储温度：–40 - 75º C
· 最高工作高度：3,000 米

· 最高运输高度：12,000 米

· 工作湿度：相对湿度 20 - 80% （不凝露）

· 存储湿度：相对湿度 5 - 95% （不凝露）

重要：要避免损坏 Matrox Axio 元件和计算机系统确保您的 X.linkHD
不是长时间工作在最高操作温度附近 (见 183 页 “监控 Axio 硬件操
作温度”了解更多信息 )。
X.linkHD 接口盒
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附录
Axio LE 板卡

总规格
PCI 接口 全 PCI-X 66/100 MHz 板卡

规格 FCC Class A， CE Mark Class A， ACA Class A
视频制式 NTSC£¨ PAL£¨ NTSC-EIAJ£¨ 1080i£¨ 1080p/PsF£¨ 

720p
标称尺寸 板卡 12.2" x 4.2"

板卡包括托架 13.875"x 4.9
包括元件总厚度 0.75"

典型操作电压和电流

 总功耗：18.0 watts

电压 +3.3 V +5 V +12 V –12 V

电流 2.0 A 0.5 A 0.5A 0.15 A
C，Matrox Axio 技术规格
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视频输入信号

 

信号类型
数
目

电压 电阻

复合视频 1 1.0 Vp-p 75 Ω

或

Y/C 视频 1

亮度信号 (Y) 1.0 Vp-p 75 Ω

色度信号 (C) PAL: 0.300 Vp-p burst 75 Ω

NTSC: 0.286 Vp-p burst 75 Ω

NTSC-EIAJ: 0.286 Vp-p burst 75 Ω

或

分量视频 1

亮度信号 (Y) 1.0 Vp-p 75 Ω

色度信号 (B-Y， R-
Y)

PAL: 0.700 Vp-p at 100% 彩条 75 Ω

NTSC: 0.700 Vp-p at 75% 彩条 75 Ω

NTSC-EIAJ: 0.757 Vp-p at 75% 彩条 75 Ω

HD: 0.700 Vp-p at 100% 彩条 75 Ω

SD-SDI/HD-SDI 视频 1 符合
SMPTE 259M/SMPTE 292M

75 Ω

参考输入 1 SD: 1.0 Vp-p 75 Ω

HD: 1.0 Vp-p (tri-sync) 75 Ω
Axio LE 板卡



228

附录
视频输出信号

 注：在使用模拟输出时，只有一路复合输出可用。在输出高清模拟分量
视频时，复合输出不可用。

 

 

 

 

 

 

 

信号类型
数
目

电压 电阻

复合视频
( 见注释 )

2 1.0 Vp-p 75 Ω

Y/C 视频 1

亮度信号 (Y) 1.0 Vp-p 75 Ω

色度信号 (C) PAL: 0.300 Vp-p burst 75 Ω

NTSC: 0.286 Vp-p burst 75 Ω

NTSC-EIAJ: 0.286 Vp-p burst 75 Ω

或

分量视频 1

亮度信号 (Y) 1.0 Vp-p 75 Ω

色度信号 (B-Y， R-
Y)

PAL: 0.700 Vp-p 100% 彩条 75 Ω

NTSC: 0.700 Vp-p at 75% 彩条 75 Ω

NTSC-EIAJ: 0.757 Vp-p at 75% 彩条 75 Ω

HD: 0.700 Vp-p at 100% 彩条 75 Ω

SD-SDI/HD-SDI 视频
( 辅助输出仅为标清格
式 )

2 符合
SMPTE 259M/SMPTE 292M

75 Ω
C，Matrox Axio 技术规格
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音频输入 /输出信号

模拟平衡 (1 对立体声输出 )

输入阻抗  高阻

标称电平  +4 dBu， 18 裕量

模拟平衡 (3 对立体声输出 )

输入阻抗  50 W

标称电平  +4 dBu， 18 dB 裕量 

可放大增益  110 W

模拟不平衡 (1 对立体声输出 )

输入阻抗 110 W

标称电平 –10 dBV， 18 dB 裕量

不平衡 AES/EBU (1 对立体声输出 )

输入阻抗  75 W 

最大输入电平  5 Vp-p 

不平衡 AES/EBU (3 对立体声输出 )

输入阻抗  75 W 

标称输出电平  1 Vp-p 

音频规格
取样率 48 kHz ( 使用 64 倍过取样 )

量化 24 bits

环境规格
· X.linkHD 最高操作环境温度 : 0 - 55º C
· 最低 / 最高存储温度：–40 - 75º C
· 最高工作高度：3,000 米

· 最高运输高度：12,000 米

· 工作湿度：相对湿度 20 - 80% （不凝露）

· 存储湿度：相对湿度 5 - 95% （不凝露）

重要：要避免损坏 Matrox Axio 元件和计算机系统确保您的 X.linkLE
不是长时间工作在最高操作温度附近 (见 183 页 “监控 Axio 硬件操
作温度”了解更多信息 )。
Axio LE 板卡
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附录
笔记
C，Matrox Axio 技术规格



Appendix D
Matrox Axio 客户支持

本附录介绍如何注册 Matrox Axio
并获得客户支持。
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附录 D，Matrox Axio 客户支持

大部分客户支持来源
如果您在使用 Matrox Axio 过程中出现问题，查询使用手册也无法解

决，请与您地区附近的 Matrox Axio 代理商或 Matrox 公司联系。

注册
您可以在 Matrox 网站的 Axio 技术支持部分 (http://www.matrox.com/
video/cs/support) 注册产品，以获得技术支持。要直接进入此网页，点
击 Start > All Programs > Matrox Axio.utils > Register Your Matrox 

Axio System。

重要：只有注册用户才会获得客户支持、软件升级、进入用户论坛并获得
促销优惠。

从网站上了解最新消息
除了注册 Matrox Axio 外，我们网站会为您提供最新 Matrox 产品信息、
免费软件升级并可使用我们的客户支持数据库。请将我们的网址
www.matrox.com/video/cs/support 放在您的收藏夹中。

与我们联系
Matrox 提供覆盖全球的优质客户支持，请按我们网站上提供的信息与您地
区的客户支持部门联系 www.matrox.com/video/cs/support。

www.matrox.com/video/support


www.matrox.com/video
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